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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 
 

В условиях современного общества неотъемлемым качеством 
квалифицированного специалиста становится высокий уровень владения 
компьютерными технологиями. Это предполагает знание и интегрированное 
использование всех типов программ двух- и трехмерной компьютерной 
графики, как растровой, так и векторной, умение их применять на всех этапах 
разработки продукта, а также знакомство с профессиональными 
графическими ресурсами сети Интернет в своей предметной области. 
Дисциплина «Компьютерная графика» предназначена для студентов 
направления специальности «Декоративно-прикладное искусство 
(реставрация изделий)». 

Цель преподавания учебной дисциплины «Компьютерная графика» – 
обеспечить студентов базовыми  знаниями в области обработки графической 
информации с учетом текущего состояния и мировых тенденций развития 
программных и технических средств двухмерной и трехмерной графики.  

Объектом изучения дисциплины являются цифровые графические 
изображения. Предметом – методы и технологии их обработки.  

Для достижения поставленной цели необходимо решение следующих 
задач учебной дисциплины: 

– формирование целостного представления о математических основах 
геометрического моделирования и компьютерной графики;  

–  обобщение знаний об использовании компьютерной графики (КГ) в 
культуре и искусстве; 

–  освоение эффективных методов и средств решения творческих задач в 
области культуры и искусства на основе использования компьютерной 
графики; 

В результате изучения дисциплины студент должен знать:  
– основные понятия и концепции геометрического моделирования и 

компьютерной графики, 
– особенности использования программных средств обработки 

графической информации в дизайне; 
– специфику работы с растровой, векторной и трехмерной графикой; 
– состав конфигурации персонального компьютера для обработки 

статической и динамической графики; 
– состав, функции и назначение программного обеспечения для 

обработки графической информации; 
– основные характеристики изображения; 
– характеристики цветовых пространств; 
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– принципы и этапы тоновой и цветовой коррекции; 
– особенности подготовки графических изображений для сети Интернет. 
Студент должен уметь: 
– анализировать графическое изображение; 
– обрабатывать цифровые фотографии; 
– использовать различные технологии работы в программах растровой, 

векторной и трехмерной графики и уметь применять их интегрировано для 
решения конкретных задач; 

– выполнять тоновую и цветовую коррекцию изображений; 
– работать с периферийным оборудованием; 
– выполнять предпечатную подготовку графических изображений; 
– работать с графическими ресурсами локальных и глобальных 

компьютерных сетей, использовать сетевые средства поиска и обмена 
графической информацией. 

Студент должен владеть: 
– техническими и программными средствами создания компьютерной 

графики; 
– методами и инструментами обработки цифровых изображений; 
– технологией ретуши изображений в зависимости от области 

применения. 
При изучении данной дисциплины предусматривается выполнение и 

реализация авторских проектов. 
Содержание учебной дисциплины направлено на формирование 

академических компетенций, включающих знания и умения по изученным 
учебным дисциплинам, умение учиться, а также социальных и 
профессиональных компетенций. 

В процессе изучения дисциплины, согласно требованиям 
образовательного стандарта, студенты должны: 

- АК-1. Уметь применять базовые научно-теоретические знания в области  
художественных, научно-технических, общественных, гуманитарных, 
экономических дисциплин и применять их для решения теоретических и 
практических задач профессиональной деятельности. 

- АК-2. Владеть системным и сравнительным анализом. 
- АК-11. Владеть методическими знаниями и исследовательскими 

умениями, обеспечисающими решение задачи инновационно-методической и 
научной деятельности 

- СЛК-7. Быть способным осмысленно воспринимать и бережно 
относиться к историческому, культурному наследию Беларуси и мира, 
культурным традициям и религиозным убеждениям.  
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- ПК-2. Адаптироваться к изменению вида профессиональной 
деятельности в пределах направления специальности. 

- ПК-17. Устанавливать причинно-следственные связи явлений, 
оказавших влияние на развитие декоративно-прикладного искусства. 

- ПК-38. Осуществлять реставрацию произведений декоративно-
прикладного искусства на основании историко-искусствоведческих и 
естественно-научных исследований. 

- ПК-40. Выбирать оптимальное художественно-реставрационное 
решение. 

Основными формами учебной работы являются лекционные и 
практические занятия и самостоятельное изучение отдельных вопросов. В 
соответствии с типовым учебным планом на изучение дисциплины 
«Компьютерная графика» всего предусмотрено 150 часов, в том числе 66  
часов аудиторных занятий. Примерное распределение аудиторных часов по 
видам занятий: лекций – 12, лабораторных занятий – 54 часа. Рекомендуемые 
формы контроля – зачет, экзамен. 
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2. ТЕОРЕТИЧЕСКИЙ РАЗДЕЛ 
КОНСПЕКТ ЛЕКЦИЙ 

 
Тема 1. Теоретические основы компьютерной графики и 

геометрического моделирования. Цифровое искусство. 
 

Краткое содержание 
Геометрическое моделирование как основа компьютерной графики. 

Геометрическая модель.  Математическая форма представления 
геометрических элементов: явное задание, неявное задание, параметрическое 
задание, геометрическое и матричное представление.  

Сплайны. Опорные точки сплайна. Типы вершин сплайна: с изломом, 
сглаженная, Безье, Безье с изломом. Виды сплайнов: линейный, 
квадратичный, кубический,  Безье, NURBS.   

Фрактальная графика. Бенуа Мандельброт. Самоподобие. Классификация 
фракталов: геометрические, алгебраические, стохастические фракталы. 
Фрактальная живопись. 

Графические редакторы. Сравнительный анализ подходов к 
редактированию векторной и растровой графики.  

Конфигурация компьютера для работы с компьютерной графикой. 
Видеокарты. Мониторы. Графические планшеты.  

Основные понятия 
Геометрическое моделирование - это графическое представление 

объектов и явлений с точки зрения их геометрических свойств. 
Геометрическая модель – модель объекта либо явления отражающая его 

его геометрические свойства. 
Для описания геометрических свойств реальных объектов строятся, как 

правило, твердые тела, которые описываются точками, линиями и 
поверхностями. Точки, линии, поверхности, тела называются 
геометрическими объектами. 

Геометрические объекты представимы в математической форме. Точки – 
координатами в заданной системе координат. Линии и поверхности – 
математическими формулами. Твердые тела в геометрическом 
моделировании отображаются совокупностью поверхностей. 

Непараметрическое задание кривой в трехмерном пространстве:  
x = x, y = f(x), z = g(x)  

В параметрическом виде каждая координата точки кривой представлена 
как функция одного параметра t. Значение параметра задает координатный 
вектор точки на кривой (0 ≤ t ≤ 1). Кривая задаётся системой уравнений 
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 x(t), y(t), z(t), 0 ≤ t ≤ 1 . 
В большинстве случаев необходимые кривые не могут являться 

функциями либо их представление в виде функций крайне затруднительно. 
К основным преобразованиям объектов относятся перенос, поворот и 

масштабирование. 
  

Представление преобразований 
геометрическое                            матричное  преобразование 

 

Переноc на Dx 
единиц вдоль оси Ox и 
Dy вдоль оси Oy 

 
Поворот на угол a. 
 

 
Масштабировать в 

Sx раз по оси Ox и в Sy  
по оси Oy 
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Сплайн – функция, которая вместе с несколькими производными 
непрерывна на заданном отрезке [a,b], а на каждом частичном отрезке [xi, 
xi+1] в отдельности является некоторым алгебраическим многочленом 
невысокой степени вида: 

Степенью сплайна называется максимальная из степеней ni составляющих 
его многочленов Pi

n(x).  
Виды сплайнов: линейный, квадратичный, кубический,  Безье, NURBS. 
Линейный сплайн: на каждом отрезке кривая приближается линейной 

функцией, то есть степени многочленов Pi
n(x) равны единице (ni = 1). 

 
Квадратичный сплайн: на каждом отрезке кривая приближается 

квадратичной функцией, то есть степени многочленов Pi
n(x) равны двум (ni = 

2). 
Кубический сплайн: на каждом отрезке кривая приближается  кубической 

функцией, то есть степени многочленов Pi
n(x) равны трем (ni = 3). 

Сплайн Безье представляет из себя кривую, задаваемую четырьмя 
точками: двумя конечными точками (p1 и p2) и двумя контрольными точками 
(c1 и c2). Кривая начинается в точке p1 и заканчивается в точке p2. Кривая не 
проходит через контрольные точки. Эти точки действуют на кривую как 
магниты, растягивая кривую в нужных направлениях и влияя на ее изгиб. 
Кривая начинается в точке p1 и дальше идет в направлении контрольной 
точки c1. Касательная к кривой в точке p1 проходит через точку c1. А 
касательная линия в конечной точке p2 проходит через точку c2. 
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Когда количество опорных точек велико сплайн Безье имеет высокую 
степень, что является неудобным. Эту проблему решает так называемый B-
сплайн. В 1972 г. Кокс и де Бур  предложили использовать функции Nik(u), 
определяемые рекурсивно. Кривая, которая строится таким образом, 
называется В-сплайном (B-spline) и записывается в следующем виде: 

Значения ti называются узловыми. 
NURBS – это частный случай кривых Безье. Расшифровка абривиатуры: 

Non-Uniform (НеОднородные), Rational (Рациональные), B–Splines ((Би-
Сплайны). 

 

Редактирование сплайна это изменение положения опорных точек, через 
которые проходит сплайновая кривая, редактирование контрольных точек 
каркаса сплайна, а также изменение направления касательных в граничных 
точках, определяющих форму сплайна. 
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Типы вершин сплайна: 
С изломом (Corner) – вершина, в которой сплайн претерпевает излом. 

Участки сегментов вблизи такой вершины не имеют кривизны. 
Сглаженная (Smooth) – вершина, через которую кривая сплайна 

проводится с плавным изгибом, без излома, имея одинаковую кривизну 
сегментов при входе в вершину и выходе из нее. 

Безье (Bezier) – вершина, подобная сглаженной, но позволяющая 
управлять кривизной сегментов сплайна при входе в вершину и при выходе 
из нее. Для этого вершина снабжается касательными векторами с маркерами 
в виде квадратиков зеленого цвета на концах. У вершин типа Bezier (Безье) 
касательные векторы всегда лежат на одной прямой, а удаление маркеров от 
вершины, которой принадлежат векторы, можно изменять. Перемещение 
одного из маркеров вершины Безье всегда вызывает центрально-
симметричное перемещение второго. Перемещая маркеры касательных 
векторов вокруг вершины, можно изменять направление, под которым 
сегменты сплайна входят в вершину и выходят из нее. 

Безье с изломом (Bezier Corner) – вершина, которая, как и вершина типа 
Bezier (Безье), снабжена касательными векторами. Однако у вершин Bezier 
Corner (Безье с изломом) касательные векторы не связаны друг с другом, и 
маркеры можно перемещать независимо. 

 
Фрактальная графика – вид компьютерной графики в математической 

основе которой лежит  фрактальная геометрия. 
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Фракта́л – геометрическая фигура, обладающая свойством самоподобия, 
то есть составленная из нескольких частей, каждая из которых подобна всей 
фигуре целиком  

Объект называют самоподобным, когда увеличенные части объекта 
походят на сам объект и друг на друга. В простейшем случае небольшая 
часть фрактала содержит информацию обо всем фрактале.  

Термин «фрактал» введён Бенуа Мандельбротом в 1975 году и получил 
широкую известность с выходом в 1977 году его книги «Фрактальная 
геометрия природы».  

Геометрические фракталы. Фракталы этого типа строятся поэтапно. 
Сначала изображается основа. Затем некоторые части основы заменяются на 
фрагмент. На каждом следующем этапе части уже построенной фигуры, 
аналогичные замененным частям основы, вновь заменяются на фрагмент, 
взятый в подходящем масштабе. Всякий раз масштаб уменьшается. Когда 
изменения становятся визуально незаметными, считают, что построенная 
фигура хорошо приближает фрактал и дает представление о его форме. Для 
получения самого фрактала нужно бесконечное число этапов. Меняя основу 
и фрагмент, можно получить много разных геометрических фракталов. К 
таким фракталам относятся Снежинка Коха, Дерево Пифагора, Треугольник 
Серпенского и другие. 

Динамические (алгебраические) фракталы. Фракталы этого типа 
возникают при исследовании нелинейных динамических систем. Поведение 
такой системы можно описать комплексной нелинейной функцией 
(многочленом) w = f(z), где z и w – комплексные числа: z = ai + b, w= ci + d, 
где a, b, c, d – действительные числа, i – мнимая единица, такая что i2=-1. 
Возьмем какую-нибудь начальную точку z0 на комплексной плоскости. 
Теперь рассмотрим бесконечную последовательность чисел на комплексной 
плоскости, каждое следующее из которых получается из предыдущего:  
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z0, z1 = f(z0), z2 = f(z1), ... zn+1 = f(zn).  
В зависимости от начальной точки z0  и функции такая 

последовательность может вести себя по-разному: стремиться к 
бесконечности при n → ∞; сходиться к какой-то конечной точке; циклически 
принимать ряд фиксированных значений; возможны и более сложные 
варианты. 

Множество Мандельброта.  Рассмотрим функцию fc(z) = z2 + с, где c – 
комплексное число. Построим последовательность этой функции с z0 = 0, в 
зависимости от параметра с она может расходиться к бесконечности или 
оставаться ограниченной. При этом все значения с, при которых эта 
последовательность ограничена, как раз и образуют множество 
Мандельброта. Оно было детально изучено самим Мандельбротом и другими 
математиками, которые открыли немало интересных свойств этого 

множества. 
Еще одним известным классом фракталов являются стохастические 

фракталы, которые получаются в том случае, если в итерационном процессе 
случайным образом менять какие-либо его параметры. При этом получаются 
объекты очень похожие на природные – несимметричные деревья, 
изрезанные береговые линии и т.д. Двумерные стохастические фракталы 
используются при моделировании рельефа местности и поверхности моря. 

Фрактальное искусство – это одно из направлений цифрового искусства, 
объекты которого строятся при помощи реализации алгоритмов фрактальной 
геометрии с помощью программного обеспечения 

Цифровое искусство. 
Краткое содержание 
Понятие цифрового искусства. История КГ. Направления КГ: 3D 

моделирование и визуализация, цифровой коллаж, цифровая живопись, 
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фрактальная графика, компьютерная анимация. Синергетичные направления 
цифрового искусства: демосцена, компьютерный перформанс, 3D мэпинг. 

КГ как инструментарий традиционных видов искусств (архитектуры и 
скульптуры, кино и мультипликации, музыки, театра и др.).  

Электронная фиксация произведений искусства: особенности и 
технологии. Изображения с высоким динамическим диапазоном (HDRI). 
Форматы HDRI.  

Цифровая иллюстрация. История и виды цифровой иллюстрации. Сферы 
применения и специфика цифровой иллюстрации.  

Основные понятия 
Компьютерное искусство (цифровое искусство, дигитальное искусство) – 

творческая деятельность, основанная на использовании информационных 
(компьютерных) технологий, результатом которой являются художественные 
произведения в цифровой форме.На данный момент понятие «компьютерное 
искусство» включает в себя как произведения традиционного искусства, 
перенесённые в новую среду, на цифровую основу, имитирующую 
первоначальный материальный носитель (когда, например, за основу берется 
отсканированная или цифровая фотография), или созданные изначально с 
применением компьютера, так и принципиально новые виды 
художественных произведений, основной средой существования которых 
является компьютерная среда. 

Цифрова́я жи́вопись  – создание электронных изображений, 
осуществляемое не путём рендеринга компьютерных моделей, а за счёт 
использования человеком компьютерных имитаций традиционных 
инструментов художника. 

Синергетичные направления цифрового искусства: демосцена, 
компьютерный перформанс, 3D мэпинг. 

Демосцена – это субкультура и направление компьютерного искусства, 
главной особенностью которого является выстраивание сюжетного 
видеоряда, создаваемого в реальном времени компьютером, по принципу 
работы компьютерных игр. Таким образом, демо является симбиозом 
программирования и искусства. Демосцена – киберкультура, существующая 
в Юзнете, Фидонете и Интернете. 

Маппинг – это способ нанесения виртуального изображения на реальный 
объект.  

Плоский маппинг 
Проекция плоской картинки на объекты при расстановке проекторов в 

специальные проекционные точки для обеспечения разных ракурсов и 
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создания иллюзии объема. Чтобы создать реалистичное объемное 
изображение используют медиасервер. 

Медиасервер необходим для компенсации геометрического искажения от 
каждого проектора. Он максимально точно накладывает проекции одна на 
другую. Таким образом, плоский маппинг – это наиболее простой способ 
изобразить псевдотрехмерную графику на объемных предметах. Основное 
отличие от одиночной проекции в том, что в плоском маппинге затенение 
объектов друг другом мы сводим к минимуму. Однако, наблюдатели 
остаются привязаны к центральной точке обзора. 

Плоский маппинг подходит для архитектурной проекции, в случае, если 
зрители находятся вдалеке от здания, и никто не смотрит сбоку. Плоский 
маппинг не подходит для демонстрации внутри помещения. 

3D мэпинг позволяет с каждым 3D объектом работать индивидуально. 
Для каждой части объекта (окна здания, двери здания, колоны здания и т.д.) 
моделируется отдельный сценарий. Качество изображения при этом не 
зависит от угла обзора. 

Перфоманнс (англ. performance – выступление, исполнение, игра, 
представление) – форма современного искусства, одна из разновидностей 
акционизма, входящего в концептуализм 1960-х годов. Перформанс – 
короткое представление, исполненное одним или несколькими участниками 
перед публикой художественной галереи или музея. Перморманс в отличие 
от живописи не требует специальной подготовки для адекватного 
восприятия, даже наоборот, он предполагает отказ от привычных ожиданий и 
подходов к нему как произведению искусства. Перформанс в наиболее 
обостренной форме демонстрирует ориентацию концептуализма на сознание, 
не замутненное идеологией и стереотипами. Как правило, концептуальный 
перформанс работает с чисто абстрактными категориями: временем, 
пространством, человеческим телом в пространстве, позицией созерцания, 
расстоянием, длительностью и т. д. Перформанс условно можно назвать 
театром визуальных искусств, поскольку в него включаются элементы 
пантомимы, танца, музыки, поэзии, видео, кино. 

Интерактивный компьютерный перфоманс – это вид искусства, который 
позволяет зрителю (пользователю) практически наравне с автором 
участвовать в создании художественного произведения. Это не замкнутое 
пространство, которое можно только наблюдать, а среда, допускающая 
активное вмешательство. Перфоманс представляет собой определенный 
набор образов, звуков, слов; это художественный мир в компью- терной сети, 
где пользователю можно участвовать в его создании, изменении. Вовлече- 
ние пользователя в общение с произведением уменьшает роль художника и 
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снимает с него часть ответственности; произведение становится до 
бесконечности подвижным, бывший зритель получает возможность 
«творить».  

Динамический диапазон – это мера спектра освещения на различных 
уровнях  от темных, черных оттенков до самых ярких, белых, которая  
определяет количество контраста, которое может быть зафиксировано или 
отображено без потери деталей. 

HDR (High Dynamic Range) – с английского переводится, как высокий 
динамический диапазон, позволяющий получать изображения с высоким 
динамическим диапазоном. При создании изображения используется 
информация из нескольких снимков, сделанных с разной экспозицией, на 
которых отчетливо видны детали и светлых, и темных частей снимка.  

Для создания HDR - изображения делается как минимум три кадра: на 
одном весь динамический диапазон отдается под свет, на другом – под тени и 
на третьем берется средний диапазон. HDR – это изображение, в котором все 
диапазоны объединены. При таком способе создания изображения для 
отображения теней будет 12 бит градаций яркости, по столько же на светлых 
участках и в середине. Итого, 36 разных уровней яркости. 

Цифровая иллюстрация – создание электронных изображений с помощью 
компьютерных имитаций традиционных инструментов художника. 
Компьютер предоставляет высокотехнологичные функции инструментов и 
возможностей, таких, как создание слоев и текстур; генерация шумов 
заданного типа; различные эффекты кистей; HDR картины; многообразие 
фильтров и возможностей коррекции; скорость работы и возможность 
вносить исправления на любом этапе, возможность остановить, сохранить и 
возобновить работу в любой момент, и многое другое. 

 
 
Тема 2. Растровая 2D графика. Композитные изображения. Создание 

композиций. 
Растровую графику применяют при разработке электронных 

(мультимедийных) и полиграфических изданий. Иллюстрации, выполненные 
средствами растровой графики, редко создают вручную с помощью 
компьютерных программ. Чаще для этой цели используют, сканируют 
иллюстрации, подготовленные художником на бумаге, или фотографии. В 
последнее время для ввода растровых изображений в компьютер нашли 
широкое применение цифровые фото- и видеокамеры. Соответственно, 
большинство графических редакторов, предназначенных для работы с 
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растровыми иллюстрациями, ориентированы не столько на создание 
изображений, сколько на их обработку.  

Основным элементом растрового изображения является точка.  
Если изображение экранное, то эта точка называется пикселом.  
Основными достоинствами пиксельной графики являются: 
• возможность отобразить на экране или напечатать фотореалистичное 

изображение. Поэтому такой тип компьютерной графики используют для 
печати фотографических изображений, а также для размещения фотографий 
в Интернете; 

• получение таких изображений возможно не только рисованием, но и 
сканированием; 

• для обработки пиксельных изображений в настоящее время создано 
много программ, которые поддерживают одни и те же форматы пиксельных 
файлов. Это позволяет выполнять импорт и экспорт изображений в 
различные программы, что расширяет возможность их обработки. Программа 
Adobe Photoshop наиболее известна и используемая в настоящее время для 
создания и обработки пиксельных изображений.  

Однако недостатки пиксельной графики также велики: 
• Основным недостатком пиксельной графики является большой размер 

файла. Обычная цветная фотография размером 9x12 см, отсканированная с 
разрешением 300 ppi, имеет объем порядка 6 Мбайт. 

• Такие изображения трансформируются с искажениями. Наибольшие 
проблемы возникают при добавлении пикселов, т. к. неизвестно, каким 
цветом закрасить эти пикселы. Аналогичные проблемы, может быть с 
меньшей остротой, проявляются и при попытке удалить пикселы. 

• Любая наклонная линия или фрагмент изображения, расположенный 
под углом, представляются на экране или при печати в виде "лестницы". 
Ничего другого и быть не может, т. к. любой фрагмент построен из 
квадратных пикселов. Правда, эти "кирпичики" могут быть настолько малы, 
что искажения не слишком заметны, однако все равно это создает проблемы 
при работе с пиксельными изображениями. 

 
Краткое содержание 
Теория композиции. Виды композиции: фронтальная, объемная и 

пространственная. Принципы построения композиции. Правила, приемы и 
средства композиции. Типы композиции: сюжетно-изобразительная, 
декоративно-тематическая, предметных форм и формальная. Области 
применения. Фотореалистичные композитные изображения. Создание 
композиции. Подготовка элементов изображения. Съемка элементов 
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композиции. Согласование перспективы. Гармонизация света и теней. 
Согласование цвета. Подчеркивание фокуса и атмосферы.   

Создание авторского проекта. Разработка целостной эстетической 
концепции, реализуемой инструментарием векторной, растровой графики и 
анимацией. Этапы разработки проекта.  

Специальные приемы создания и использования векторной 
компьютерной графики применительно к бизнес-проектам и рекламным 
роликам. Методы использования преимуществ векторной графики в 
наружной рекламе.  

 
Основные понятия 
Слово «композиция» в переводе с латинского означает сочинение, 

составление, соединение, связь, построение, структура. Различают три 
основных вида композиции: фронтальную, объемную и глубинно-
пространственную. Такое разделение в какой-то мере условно, так как на 
практике мы имеем дело с сочетанием различных видов композиции.  

Фронтальная композиция 
Простейшей разновидностью фронтальной композиции является 

плоскостная композиция. 
Характерным признаком плоскостной композиции является 

распределение в одной плоскости элементов формы в двух направлениях по 
отношению к зрителю: вертикальном и горизонтальном, например, стенды 
наглядной агитации, ткани, ковры, фасады зданий и т.д. 

Фронтальная композиция отличается небольшой глубиной и 
преимущественно фронтальным расположением элементов. Воспринимается 
спереди. Таким образом, она приближается по своему пластическому 
характеру к плоскостной композиции. Но в отличие от нее составляется не 
просто из фактурных или рельефных плоскостей, а из глубинных или 
разделенных в плане элементов. Эти элементы отделяются от задней 
фронтальной плоскости, выдвигаются вперед, располагаясь на расстоянии 
друг от друга. Они рассматриваются уже не как рельефные, а как 
пространственные формы. В архитектурной композиции этим формам 
придается значение объемов, обращенных своей главной фронтальной 
плоскостью к зрителю. При построении фронтально-пространственной 
композиции следует учитывать ряд важных условий. Первое - конфигурация 
форм. Она выражается в сопоставлении разных по геометрическому виду и 
расположению элементов. Чем четче это сопоставление, тем характер 
фронтально-пространственной композиции выразительнее. 

Второе важное условие – ритмическое построение композиции. 
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Специфичным здесь является использование в качестве композиционного 
средства порядка смещения пространственно-плоскостных элементов 
относительно друг друга и образование нескольких ритмических групп. Из 
них и складывается простая или сложная фронтально-пространственная 
композиция. 

Третье – графическо-пластическая моделировка элементов. Основывается 
это условие на выразительной игре силуэтов, фактур, рельефов и разной 
графики - надписей, знаков, цветных плоскостей и пр. Близкое расположение 
элементов друг к другу предопределяет целостность фронтально-
пространственной композиции. Однако оно же порой является причиной 
проявления в ней монотонности. В целях устранения последней требуется 
достижение в этой композиции пластического разнообразия форм. При 
чрезмерном же их разнообразии фронтально-пространственная композиция 
разрушается. Таким образом, главной задачей в ее построении становится 
установление различия между элементами при достижении их единства. 

Объемная композиция. 
Представляет собой форму, имеющую относительно замкнутую 

поверхность и воспринимаемую со всех сторон. Объемная композиция всегда 
взаимодействует с окружающей средой. Среда может увеличивать или 
уменьшать выразительность одной и той же композиции. 

Характеризуется развитием пространственных элементов в трех 
координатных направлениях при соблюдении их компактности. В 
архитектурных композициях развитие в глубину часто превалирует. 
Характер дизайнерских объемно-пространственных композиций чаще всего 
подчеркивается глубинным расположением разных по своим пластическим 
свойствам элементов – линейных, плоскостных и объемных (в подобных 
архитектурных композициях преобладают объемы). Объемно-
пространственная композиция воспринимается, как правило, с разных 
сторон, хотя часты случаи ее преимущественного восприятия с одной или 
двух сторон, например в условиях однонаправленного движения. Зритель 
находится, как правило, снаружи объемно-пространственной формы. 

В объемно-пространственной композиции имеет место более сложное, 
чем в объемной композиции, планировочное решение. Оно основывается на 
разном пространственном расположении элементов. Выбор вида часто 
обуславливается конкретной архитектурно-планировочной ситуацией, в 
которую включается объемно-пространственная композиция. 

Характер композиции рассматриваемого вида также раскрывается в 
пластической моделировке включаемых в нее элементов. Приемы такой 
моделировки во многом схожи с теми, которые имеют место при разработке 
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объемной формы. Но есть и своя специфика. В частности, в ней четко 
раскрываются доминирующие свойства разных пространственных элементов 
– их конфигурация, расположение, силуэт и членение. При этом решаются 
следующие композиционные задачи: 

выявляется общий вид геометрических пространственных форм 
(кубических, цилиндрических, пирамидальных и пр.), 

расположением подчеркивается статичный или динамичный характер 
композиции, 

остро сочетаются в пространстве разные пластические формы (объемные, 
плоскостные и линейные). 

При успешном решении этих и подобных им задач достигается 
предельная выразительность построения объемно-пространственной 
композиции. Большое значение в этом построении имеет широкое 
использование разных графическо-пластических средств, в частности цвета, 
фактуры и рельефа. В связи с таким использованием, однако, возникает 
трудность упорядочения в объемно-пространственной композиции 
значительного количества разных по свойствам элементов. Ее преодолению 
способствуют четкая планировочная организация пространства, а также 
единый характер включаемых в него пластических элементов. 

Глубинно-пространственная композиция 
Складывается из материальных элементов, объемов, поверхностей и 

пространства, а так же интервалов между ними. Данный вид композиции в 
архитектуре используется повсеместно: от решения интерьеров помещений 
до разработки улиц, площадей, микрорайонов и т.п. 

Характеризуется преимущественным развитием в глубину и восприятием 
изнутри. Последний признак предопределяет ее важное художественное 
значение в дизайнерском творчестве. Выражается оно в широком включении 
разных пластических форм в глубинное пространство. Его протяженность 
определяется отношением глубины пространства к ширине. При отношении 
менее чем 1:1 пространство характеризуется как относительно неглубокое 
(поперечное), при отношении более чем 1:1 – как глубокое (продольное). При 
отношении, равном 1:1, - средней   глубины. 

Важный композиционный признак или художественное свойство 
глубинного пространства – открытость. Степень открытости выражается 
отношением глубины пространства к высоте ограничивающих его 
плоскостей. Если отношение больше чем 2:1, то пространство считается 
открытым, если меньше – замкнутым. Вполне оправдано уточнение этих 
данных в связи с обращением к масштабной характеристике пространства и 
его подразделением на неограниченное (открытое) и ограниченное 
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(замкнутое). 
Сюжетно-изобразительная (повествовательная) композиция лежит в 

основе реалистических художественных произведений (живописных, 
скульптурных и т. д.). В ней участвуют "реальные" персонажи. Их 
отношения и действия взаимно обусловлены, у каждого своя роль. 
Противостояние объектов композиции служит выявлению их сущности, 
качественных характеристик. Эти отношения типичны, они выделены, 
выхвачены из более общего содержания, контекста. Произведение требует 
внимательного вдумчивого рассмотрения, и, как правило, вызывает 
обобщение от частного к общему. 

Пример сюжетно-изобразительной композиции – реалистичное 
произведение станковой живописи. Его цель – рассказать зрителям о каком-
либо явлении или событии и выразить отношение художника к этому 
событию (рис. CD-3.59). Такое произведение автономно, самодостаточно. 
Оно не должно зависеть от окружения, хотя интерьер, в котором висит 
картина, несомненно, влияет на восприятие. 

Декоративно-тематическая композиция. Как правило, дизайнерам 
приходится создавать декоративные композиции. В этом случае, в 
тематической композиции сюжетный рассказ подчиняется декоративным 
целям, и это подчеркивает и глубже раскрывает смысл произведения. Такая 
композиция вписывается обычно в какие-либо архитектурные формы или 
связывается с другими произведениями прикладного искусства, и, 
следовательно, само является частью другой, большей композиции. Часто 
декоративно-тематические композиции используются в плакатах, в народном 
искусстве, в оформлении книг (обложки, экслибрисы), в интерьерах 
общественных зданий, офисов. 

Для создания такого произведения нужно найти обобщенный образ. Он 
должен быть емким и лаконичным. Для этого, в первую очередь, нужно 
понять суть темы и выбрать главное, стержень композиции, отказаться от 
ненужных подробностей. Художник сам определяет, какие качества предмета 
нужно выделить для более полного раскрытия темы. Например, в 
композиции на тему "Дерево" можно передать контур, геометрию дерева, 
можно изобразить одну ветку с листьями, а можно дать увеличенное 
изображение фактуры коры дерева с капелькой смолы. Решений множество, 
главное, чтобы изображение подчинялось декоративным целям. 

Формальная композиция строится из линий и пятен, она выражает логику 
композиционного построения. Иногда такой тип композиции называют 
неизобразительной. Это пространство художественных образов, не 
существующих в реальности, не имеющих рационально-практической 
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значимости. В формальной композиции важен не сюжет, а исключительно 
законы и принципы ее собственного построения, пластические формы. Ее 
содержание формально. Эмоциональное воздействие на зрителя оказывает 
художественная форма, цветовой и пластический строй произведения. 

Элементы любого композиционного произведения – объект и 
пространство, но, в отличие от рассмотренных ранее типов, в формальной 
композиции используются не реально существующие предметы (предметные 
формы), а абстрактные объекты. Эти объекты могут возникнуть в результате 
предельного упрощения форм реальных предметов или быть созданы из 
геометрических фигур, знаков алфавита. 

Основы композиции в фотографии 
Мы познакомимся с базовыми понятиями композиции в фотографии, 

которые научат нас лучше понимать значение и уместность каждой детали на 
снимке. Мы ознакомимся с основными принципами композиции, а также 
поймём как все это применяется на практике, чтобы суметь рассказать свою 
историю и создать более качественное фото. Мы ознакомимся с разными 
примерами и разложим все их композиционные составляющие по полочкам. 

Хороший снимок это не только нажатие на кнопку и получение нового 
изображения, это также еще один способ рассказать историю, передать свои 
ощущения. Чтобы творить мы должны четко понимать, что мы видим. 

Прежде чем мы перейдем к детальному разбору композиции нам надо 
выяснить, что заставляет человека трепетать, чем он любит любоваться. Для 
тех кто не знал, подсознание подсказывает нам любить вещи, которые нам 
уже знакомы, то что мы уже знаем. Знание и понимание означает комфорт и 
умиротворение, это заставляет нас любить то что мы видим. Неизвестное 
порождает страх, риск и опасность, это приводит к  ощущению дискомфорта 
и оставляет негативное отношение к тому что мы видим. Очень важно понять 
эту идею, для дальнейшего продвижения. 

Красота – это визуальное, эстетическое представление  о чем либо, что 
нам нравится и от чего мы получаем удовольствие от созерцания этого. 
Красота берет свое начало в узнаваемостии, это то что мы уже знаем. 

КРАСОТА ЭТО СООТНОШЕНИЕ между левым и правым, низом и 
верхом, коротким и длинным, высоким и низким, узким и широким. Красота 
основывается на принципах ощущения знакомства чего то, что мы знаем и 
распознаем. Красота создается путем объединения всех элементов лица в 
одно изображение, которое приводит нас к тому самому опознаванию 
предмета. 

 В поиске композиции. 
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Композиция это объединение нескольких элементов в определенной 
последовательности исходя из определенных правил. Композиция 
начинается как минимум с двух элементов и между ними должна 
прослеживаться некая закономерность. 

A. Симметрия 
Симметрия – это самое распространенное и в то же время очень 

недооцененное  композиционное правило, один из самых важных 
компонентов красоты.  Симметрия определятся при помощи осей, видимых 
или нет, горизонтальных или вертикальных. 

 
Симметрия означает централизованность, порядок, силу и авторитет. Это 

направление, важность и влияние. Левая часть является отражением правой и 
центральная линия это линия, которая ведет нас к наиболее значимому 
элементу снимка. 

Симметрия определяется не только при помощи вертикальных осей, но 
также при помощи горизонтальных. На изображении сверху небо и океан 
встречаются точно по центру изображения, намекая нам, что они одинаково 
значимы на снимке. 

B. Ритм и повторение 
Повторение означает, что некий элемент присутствует большое 

количество раз в той же позиции и с той же последовательностью. Даже если 
мы не видим все последовательности, у нас есть чувство комфорта из-за того 
что они предсказуемы и именно поэтому повторы это хороший инструмент 
для создания красивых изображений. 

Повторы не обязаны быть линейными, они могут быть также разбросаны 
по плоскости 
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Будучи фотографом, всегда присматривайтесь к заборам, полюсам и 

всему, что предполагает равные промежутки между объектами. Это довольно 
простой способ создавать хорошие фотографии, на которые интересно 
смотреть. Повторы привлекательны, а следовательно красивы и если 
пользоваться ими правильно, глаза созерцателя будут направлены в нужном 
направлении 

 Эта композиционная техника также замечательно подходит для создания 
ощущения перспективы, чтобы притянуть наши глаза к определенной точке 
на изображении. 

Повторение и ритм – это также музыкальные понятия, которое очень 
похоже на все изобразительные искусства, и основано на тех же принципах. 
Музыкальные ритмы создают ощущение комфорта и удовольствия, за счет 
того что наш мозг ожидает и получает определенные последовательности. 

3. Золотое сечение – правило третей 
Скорее всего, большинство фотографов уже знакомы с правилом третей, 

согласно которому снимок делится на 3 области горизонтально или 
вертикально и мы помещаем основные элементы либо во внутренних 
областях, либо на пересечении линий. Некоторые камеры с самого начала 
выводят необходимые линии на LCS экранах, чтобы помочь нам построить 
наши кадры согласно правилу третей. 

 
Не все об этом знают, но правило третей это ни что иное как упрощенное 

золотое сечение 
Попытки измерить красоту предпринимались еще во времена древних 

греков. В те времена математики, художники и философы пытались дать 
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красоте определение и вывели следующую формулу (подробнее про историю 
появления формулы) 

 
Пытаясь измерить красоту, было выяснено, что формула, которую мы 

видим выше применима к человеческому телу относительно очень многих 
параметров. И это не только человеческое тело, но это правило также было 
найдено в природе, животных и цветах. Мы окружены этим волшебным 
сечением, золотым сечением. Мы видим его снова и снова, оно знакомо нам, 
а значит оно нам нравится и мы получаем удовольствие смотря на него. Оно 
позволяет красоте существовать. 

 
Применительно к человеческому лицу, вы будете сильно удивлены 

обнаружив, что все лица, которые мы относим к красивым имеют золотую 
пропорцию между разными частями лица, как это показано ниже. 

мы только что нашли формулу красоты 
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Правило третей – это всего-навсего упрощенное золотое сечение, 

созданное для более простого понимания. Гораздо легче сказать человеку 
поделить снимок на 3 разные части, нежели сказать ему начать чертить 
линии исходя из формулы. 

Запомните очень важную вещь: 
Золотое сечение – это измеритель красоты, упрощенный для понимания 

до правила третей. 
Применение правила третей бесконечно. Меня не перестает удивлять, как 

некоторые художники (фотографы, архитекторы и т.д.) не используют сие 
правило для оценки красоты их произведений искусства. Возможно они 
 попросту не знакомы с этим правилом и решают не знакомиться с ним, но 
это приводит к увеличению риска быть отвергнутым зрителем. 

Золотое сечение описывает самое КРАСИВОЕ отношение между 
длинным и коротким, широким и узким, большим и меньшим. Оно может 
быть применено при помощи четких линий или предположений, разницы 
цвета, насыщенности или времени как разное измерение. Оно может быть 
соотношением между громким и тихим, темным и светлым и другими 
еденицами измерения. 

Все принципы выше применимы также к музыке, еде и ко всему, что 
совмещает элементы. Красота четко обозначена для нас, людей, и применима 
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к нашей культуре до тех пор пока у нас есть те же натуральные пропорции. 
Если люди будут другими, возможно, что правило изменится. Мы не можем 
признавать красивыми не обычные тела, потому что это не следует тем же 
правилам и это создает отличие. 

 
Классическое изображение в мире фотографии отображающее 

действенность правила третей вертикально и горизонтально. Стандартный 
метод для построения композиции, который всегда работает. 

Особенности композиции 
A. Правило композиции 
Возвращаясь к определению композиции, несколько элементов 

объединенных по общему узнаваемому правилу являются композицией. 

 
На изображении выше легко заметить, что лица членов семьи 

симметричны и создают вертикальную линию. 
На изображении выше группа расположена по кругу. Не имеет никакого 

отношения к симметрии или правилу третей, однако до сих пор является 
композицией. Правило очевидно – круг и у нас нет никаких проблем его 
обнаружить. 

Другой вариант круга с матерью по центру. Эта фотография подчеркивает 
важность матери, как центрального элемента. Сюжет снимка посвящен 
матери окруженной семьей, а не только семье. Это доказывает важность 
помещения элементов композиции относительно передаваемого через 
изображения сообщения. 
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На этом изображении мы читаем лица подобно книге – слева направо, 

снизу вверх. Это также классический прием при фотографировании семей, 
расположить лица на разных уровнях на фотографии, чтобы позволить 
зрителю проследить последовательность. В данном изображении не хватает 
баланса из-за пустого места в левой части снимка, из-за чего правая часть 
изображения выглядит тяжелее. 

На изображении сверху легко увидеть зигзагобразную линию, которую 
создает улица, засчет чего создается композиционное правило, которое 
заставляет нас проследить взглядом за направлением линии. Это очень 
хороший пример того как не следуя правилу симметрии и правилу третей, 
можно создать новое композиционно правило. 

 
Сердце выложенное из камней – это отличный пример, который 

показывает большое количество камней объединенных вместе, для создания 
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формы сердца. Камни являются композиционными элементами и сердце это 
правило. 

Используя примеры выше мы можем создавать несчетное количество 
композиции основанных на геометрических фигурах, элементах, цветах или 
что бы то ни было, чтобы создать привлекательное изображение. Вы не 
обязаны использовать примеры описанные в справочниках, книгах или 
расказанных другими людьми, вам всего лишь нужно показать отчетливое 
композиционное правило 

 B. Баланс 
Чувство баланса в изображении как никакое другое диктует нам будет ли 

изображение спокойным, напряженным или создастся ощущение падения. 
Баланс важен для создания чувства умиротворения у зрителя. Я никоим 
образом не хочу сказать, что чувство напряжения это плохая вещь, это 
вполне может быть целью фотографа создать снимок, который ведет нас к 
дискомфорту, чтобы объяснить его смысл. 

 
Когда вещи выглядят неправильно и стремятся упасть, зритель будет 

чувствовать напряжение. Исходя из своего замысла, вы можете использовать 
баланс для того чтобы успокоить зрителя либо же дать ему еще один повод 
понервничать. 

Изображение сверху это типичный пример недостатка баланса. В то 
время как поза девушки не естественна, это создает интригующее ощущение 
движения и напряжения. Опять же, не существует готовых рецептов 
применительно к сбалансированности композиции, все зависит от того как 
творец желает передать сообщение. 

Свечи в изображении сверху добавлены специально для добавления 
баланса в композицию в то время как ребенок заставляет правую часть 
снимка выглядеть тяжелее чем левая 
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Изображение сверху использует 2 композиционных инструмента, баланс 
и диагональ, чтобы создать чувство напряженного падения. Я задаю себе 
вопрос: “Как эти камни не падают вниз?” 

 Никогда не забывайте про баланс, это мощный инструмент, который 
позволит вам лучше передать ваше послание. 

 C. Линии, диагонали, перспективы 

 
Фото от Bruce Campbell 
Линии являются мощным зрительным инсрументом, который позволяет 

приковать внимание зрителя к точке их сближения. Это также простой 
инструмент, который позволяет подчеркнуть необходимый элемент, создать 
чувство перспективы и добавить интересности снимку. Используйте 
диагональные линии, чтобы создать динамичные изображения и добавить 
движения, глубины и перспективы. 

Линии на потолке создают ощущение объемности и комната выглядит 
глубже чем она есть на самом деле. 

Линии могут быть использованы для придания глубины и объема. Будучи 
фотографом, мне нравится использовать глубину резкости на ограждения, 
чтобы акцентировать глубину еще сильнее для мощного и интересного 
результата. 

 D. Господство, объект, иерархия 
Несмотря на то что это последний пункт данной статьи, я верю, что 

любая композиция должна содержать доминирующий объект, который легко 
определить. Подобно еде, когда каждое блюдо имеет доминирующий вкус, 
любая визуальная композиция должна гармонично комбинировать элементы, 
плавно подчеркивая центральный объект. Обнаружение центрального 
объекта не является проблемой на большинстве фотографии, в то же время, я 
бы хотел заметить, что иногда стоит немалых трудов понять посыл 
фотографа. 

Заключение 
Хорошая композиция это всегда простая композиция, которая следует 

одному или более правилам. Будучи фотографом всегда думай, что ты 
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хочешь рассказать твоему зрителю и как сделать это наиболее четко и ясно. 
Это добавит ценности твоим работам и сделает твои снимки более простыми 
для понимания. 

 
Тема 3. Цифровая фотография. Ретушь и реставрация. Тоновая и 

цветовая коррекция изображений.  
 
Краткое содержание 
Природа цифрового изображения. Способы получения цифровых 

изображений. Цифровая фотография: студийная и экстерьерная съемка. 
Визуализация цифрового изображения. Входные и выходные характеристики 
изображения: линейный размер, входное и выходное разрешение 
изображения. 

Цветовые простанства Bitmap, Greyscale, Duotone, Index, RGB, CMYK, 
HSB, Lab. Их назначение. Преобразование цветовых пространств. Глубина 
цвета. Цветовоспроизводящие устройства: Adobe RGB, Apple RGB, sRGB, 
Euroscale, SWOP Color Managment Systems.  

Тоновая и цветовая коррекция изображений.  
Понятие ретуши. Приемы восстановления, реставрации и 

перекомпоновки изображений. Комплексность приемов инструментов 
ретуши. Портретная ретушь.  

 
Основные понятия 
Цветовая модель – математическая модель описания представления 

цветов в виде кортежей чисел (обычно из трёх, реже – четырёх значений), 
называемых цветовыми компонентами или цветовыми координатами. Все 
возможные значения цветов, задаваемые моделью, определяют цветовое 
пространство. Цветовая модель задаёт соответствие между 
воспринимаемыми человеком цветами, хранимыми в памяти, и цветами, 
формируемыми на устройствах вывода (возможно, при заданных условиях). 

Grayscale (Градации серого цвета) – цветовой режим в котором пиксели 
изображения окрашены в 256 оттенков серого цвета – от нуля (черный цвет) 
до 255 (белый цвет).После преобразования в режим Grayscale изображение 
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содержит оттенки черного цвета с яркостью от 0 (белый) до 100% (черный). 
Во время преобразования цветного рисунка в эту цветовую модель каждый 
цвет, в зависимости от его яркости, заменяется соответствующим оттенком 
серого. 

Bitmap – черно-белый цветовой режим, в котором все пиксели 
изображения окрашены только черный и белый цвета. Этот режим можно 
использовать для изображений с неявными и слабовыраженными цветовыми 
переходами.  

Модель Duotone или дуплекс (двуцвет или дуотон) - это 8-разрядный 
цветовой режим, использующий 256 оттенков из не более чем четырех 
цветовых тонов. Duotone расширяет тоновый диапазон, а также позволяет 
тонировать полутоновые изображения. В режиме Duotone изображение 
может быть одноцветным (monotone), двуцветным (duotone), трехцветным 
(tritone) и четырехцветным (quadtone). 

Модель Indexed Color - индексированная (фиксированная) цветовая 
палитра содержит не более 256 цветов. Используется для размещения 
изображений во Всемирной паутине или мультимедийных презентаций. В 
этой модели сильно ограничены возможности редактирования изображений. 

Модель RGB – это способ отображения подавляющего большинства 
цветов видимого спектра  благодаря смешиванию  трех цветов (в разных 
пропорциях и с разной яркостью) – красного, зеленого и синего (Red, Green, 
Blue – RGB). Цвет в модели RGB называется аддитивным. 

Аддитивные цвета в некоторых электронных устройствах формируется 
благодаря бомбардировке люминофора электронными пучками красного, 
зеленого и синего цветов. Яркость каждого из базовых цветов (красный, 
зеленый, синий) в модели RGB определяется значением в диапазоне от 0 до 
255, т.е. в цветовую модель входит по 256 оттенков красного, зеленого и 
синего цветов, а также любая комбинация этих оттенков. Если значения 
красного, зеленого и синего цветов равны нулю, то при смешивании этих 
трех цветов получим черный цвет; если же значения яркости равны 255 – 
получим белый цвет. 
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Модель HSB основана на восприятии цветов окружающего мира 

центральной нервной системой человека. У этой модели есть три 
фундаментальных параметра – оттенок (Hue), насыщенность оттенка 
(Saturation) и его яркость (Brightness). Цвет луча света, который отражается 
или проходит сквозь какой-либо объект, в данной модели называют 
оттенком. Оттенки цветов, которые измеряют в градусах (от 0° до 360° 
цветового круга), однозначно идентифицируют по названию цветов 
(например, красный или зеленый). Насыщенность – это уровень присутствия 
серого цвета в определенном оттенке. Измеряют насыщенность (или, как ее 
еще называют, чистоту оттенка) в процентном соотношении содержания 
серого цвета от 0% (серый цвет) до 100% (чистый оттенок). Яркостью 
называют уровень осветления или затенения оттенков, ее измеряют в 
процентах от 0% (черный цвет) до 100% (белый цвет). 

Хотя модель HSB декларирована как аппаратно-независимая, на самом 
деле в её основе лежит RGB. В любом случае HSB конвертируется в RGB для 
отображения на мониторе и в CMYK для печати,а любая конвертация не 
обходится без потерь. 

Модель CMYK (сокращение от Cyan-Magenta-Yellow-Black - голубой-
пурпурный-желтый-черный) - это цветовая модель, в которой все цвета 
описываются как смесь этих четырех обрабатываемых цветов. CMYK - 
стандартная цветовая модель, используемая в цветной печати. Т.к. здесь 
используются чернила четырех основных цветов, ее еще называют 
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четырехцветной печатью.   

Цветовая модель CMYK в отличие от RGB описывает поглощаемые 
цвета. Цвета, которые используют белый свет, вычитая из него определённые 
участки спектра, называются субтрактивными (вычитательными). Именно 
такие цвета и используются в модели CMYK. Они получаются путём 
вычитания из белого аддитивных цветов модели RGB. Основными цветами в 
CMYK являются голубой (Cyan), пурпурный (Magenta) и жёлтый (Yellow). 
Голубой цвет получается путём вычитания из белого красного цвета, 
пурпурный - зелёного, жёлтый – синего. При смешении всех трёх цветов 
получается чёрный цвет, т.е. сложение цветов в CMYK аддитивно. Цветовая 
модель CMYK является основной для печати. В цветных принтерах также 
применяется данная модель.  

Для того, чтобы распечатать чёрный цвет, необходимо большое 
количество краски. Смешение всех цветов модели CMYK даёт не чёрный, а 
грязно-коричневый цвет. Для усовершенствования модели CMYK, в неё был 
введён один дополнительный цвет - чёрный. Он является ключевым цветом 
при печати, поэтому последняя буква в названии модели - K (Key), а не B. 
Таким образом, модель CMYK является четырёхканальной. У CMYK 
цветовой охват более узкий, чем у RGB. Поэтому, при конвертации из RGB в 
CMYK часть цветов теряется. Это необходимо учитывать. 

Модель Lab. В цветовом пространстве Lab значение светлоты отделено от 
значения хроматической составляющей цвета (тон, насыщенность). Светлота 
задана координатой L (изменяется от 0 до 100, то есть от самого темного до 
самого светлого), хроматическая составляющая – двумя декартовыми 
координатами a и b. Первая обозначает положение цвета в диапазоне от 
зеленого до пурпурного, вторая – от синего до желтого.  
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В отличие от цветовых пространств RGB или CMYK, которые являются, 
по сути, набором аппаратных данных для воспроизведения цвета на бумаге 
или на экране монитора (цвет может зависеть от типа печатной машины, 
марки красок, влажности воздуха на производстве или производителя 
монитора и его настроек), Lab однозначно определяет цвет. Поэтому Lab 
нашел широкое применение в программном обеспечении для обработки 
изображений в качестве промежуточного цветового пространства, через 
которое происходит конвертирование данных между другими цветовыми 
пространствами (например, из RGB сканера в CMYK печатного процесса). 
При этом особые свойства Lab сделали редактирование в этом пространстве 
мощным инструментом цветокоррекции. Благодаря характеру определения 
цвета в Lab появляется возможность отдельно воздействовать на яркость, 
контраст изображения и на его цвет. Во многих случаях это позволяет 
ускорить обработку изображений, например, при допечатной подготовке. Lab 
предоставляет возможность избирательного воздействия на отдельные цвета 
в изображении, усилиения цветового контраста, незаменимыми являются и 
возможности, которые это цветовое пространство предоставляет для борьбы 
с шумом на цифровых фотографиях. 

Модель Multichannel. В мультиканальной (многоканальной) модели 
каждый из каналов изображения содержит 256 уровней серого. Может 
содержать любое количество цветовых каналов. Общее количество цветовых 
и альфа-каналов не может превышать 56-ти. Эта модель используется для 
специальных режимов печати, например, при использовании заказных 
(плашечных) цветов, а также при некоторых преобразованиях из одной 
цветовой модели в другую. 

Ретушь. Инструменты ретуши. 
 
Вначале необходимо пояснить, почему приходится ретушировать 

фотографии. В реальной сцене человек фокусирует свое внимание на важных 
в данный момент объектах, не замечая множество менее значимых деталей. 

34 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Репродукция статична и зритель может разглядывать ее долго, перенося 
фокус внимания с одних объектов на другие и замечая детали, которые не 
заметил бы в реальной жизни (характерным примером таких объектов 
являются провода на городском пейзаже и неровности кожи на портрете). 

Задача ретушера – уменьшить количество таких объектов (или полностью 
удалить их), чтобы ощущения зрителя при просмотре репродукции 
совпадали с ощущением зрителя при просмотре реальной сцены. Так же 
ретушь может потребоваться для удаления ошибок оцифровки и исправления 
несовершенства сцены или модели. Вся ретушь строится на замене 
дефектных участков изображения заплатками, взятыми с других областей 
этой же картинки. 

При любой ретуши используются одни и те же инструменты и приемы. 
Деление на типы условно и в большей степени указывает на трудоемкость и 
объем работ. 

Техническая ретушь – удаление огрехов сканирования (царапины, 
отпечатки пальцев и т.п.), съемки или мелких недостатков сцены 
(затоптанность фона, тросы для подвеса объектов, провода и т.п.). 

Художественная ретушь – серьезное изменение внешнего вида сцены или 
модели. 

Для операций ретуширования объектов используются следующие 
инструменты ретуши: Clone Stamp, Healing Brush, Spot Healing Brush, Patch и 
такие инструменты коррекции как: Blur, Sharpen, Smudge, Dodge, Burn, 
Sponge. 

1. Ретуширование с помощью инструмента «Штамп» («Clone Stamp») 
 

 Инструмент «Штамп»  предназначен для нанесения одной части 
изображения поверх другой части этого же изображения или любого другого 
открытого документа, имеющего тот же цветовой режим. Кроме того, можно 
переносить часть изображения из одного слоя в другой. Инструмент 
«Штамп» полезен для копирования объектов или удаления дефекта в 
изображении. 

Для использования инструмента «Штамп» нужно установить пробную 
точку в область, из которой нужно произвести копирование (клонирование) 
пикселов и рисовать в другой области. Для того, чтобы продолжить 
рисование с той точки, где была отпущена кнопка мыши, необходимо 
выбрать параметр «Выравнивание». При снятом флажке «Выравнивание» 
рисование всегда начинается с первоначально выбранной пробной точки. 

С инструментом «Штамп» можно использовать любой кончик кисти, что 
позволяет точно контролировать размер области клонирования. Так же для 
управления процессом переноса изображения можно изменять настройки 
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прозрачности и количества краски. 

 
2. Ретуширование с помощью инструмента «Восстанавливающая кисть» 

(«Healing Brush») 
Инструмент «Восстанавливающая кисть» позволяет исправлять дефекты 

изображения на основе соседних областей. Как и при использовании 
инструментов клонирования, рисование «Восстанавливающей кистью» 
происходит с помощью пикселов, выбранных из изображения или узора. 
Однако инструмент «Восстанавливающая кисть» также сопоставляет 
текстуру, освещенность, прозрачность и затененность пикселов образца с 
аналогичными параметрами пикселов восстанавливаемого изображения. В 
результате этого восстановленные пикселы незаметно смешиваются с 
изображением. 

3. Ретуширование с помощью инструмента «Точечная 
восстанавливающая кисть» 

 Инструмент «Точечная восстанавливающая кисть» позволяет быстро 
удалять с фотографий пятна и другие дефекты. Действия точечной 
восстанавливающей кисти аналогичны действиям восстанавливающей кисти: 
она использует пикселы по образцу изображения или узора и сопоставляет их 
текстуру, освещение, прозрачность и затенение с соответствующими 
параметрами исправляемых пикселов. В отличие от восстанавливающей 
кисти, для точечной восстанавливающей кисти не требуется указывать точку, 
которая используется в качестве образца. Точечная восстанавливающая кисть 
автоматически выбирает образцы пикселов из области вокруг ретушируемого 
фрагмента. 

4. Ретуширование с помощью инструмента «Заплатка» («Patch») 
Инструмент «Заплатка» позволяет восстанавливать выделенную область с 

помощью пикселов другой области или узора. Аналогично инструменту 
«Восстанавливающая кисть», инструмент «Заплатка» сопоставляет текстуру, 
освещение и затененность пикселов образца с аналогичными параметрами 
пикселов исходного изображения. Кроме того, с помощью инструмента 
«Заплатка» можно клонировать отдельные области изображения. С помощью 
инструмента «Заплатка» можно обрабатывать изображения с глубиной 8 или 
16 бит/канал. При восстановлении с помощью пикселов изображения 
рекомендуется выбирать небольшие области. 

5. Инструменты коррекции: Blur, Sharpen, Smudge, Dodge, Burn, Sponge. 

Фильтры групп Blur и Sharpen.  
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Инструмент «Размытие» («Blur»)  смягчает четкие края и уменьшает 
детализацию изображения. Чем больше данный инструмент применяется к 
области, тем более размытой становится эта область. 

Инструмент «Резкость» («Sharpen») усиливает контрастность вдоль краев, 
повышая видимую резкость. Чем больше данный инструмент применяется к 
области, тем более резкой она становится. 

Растушевка областей изображения. 
 Инструмент «Палец» («Smudge») имитирует эффект размазывания 

свежей краски пальцем. Инструмент определяет цвет в точке, где начинается 
движение пальца, и «размазывает» его в направлении движения. 

Осветление или затемнение областей.  
 В основе действия инструментов «Осветлитель» («Dodge») и 

«Затемнитель» («Burn»), с помощью которых можно осветлять и затемнять 
области изображения, лежит традиционный фотографический прием – 
регулировка времени экспозиции отдельных областей печати. Фотографы 
снижают освещение печатаемой области для получения более светлых 
снимков (осветление) или увеличивают время экспозиции, чтобы получить 
более темные отпечатки (затемнение). Чем больше инструменты 
«Осветлитель» и «Затемнитель» применяются к какой-либо области, тем, 
соответственно, светлее или темнее она становится. 

Настройка насыщенности цвета в областях изображения. 
Инструмент «Губка» («Sponge») едва заметно изменяет насыщенность 

цвета обрабатываемой области. При работе с изображениями в градациях 
серого инструмент увеличивает или уменьшает контрастность, смещая 
уровни серого относительно среднего уровня. 

Еще немного поговорим на тему фильтров размытия и резкости в 
Photoshop. Фильтры групп Blur (Размытие) и Sharpen (Резкость) не столько 
создают эффекты, сколько позволяют выполнить некоторую коррекцию 
изображения. Некоторые фильтры данной группы являются фильтрами 
прямого действия. Это означает, что после выбора соответствующей 
команды она выполняется сразу без вмешательства пользователя. 

Устранение эффекта красных глаз: Red Eye Tool. 
Инструмент «Красные глаза» позволяет удалять эффект красных глаз, а 

также удалять белые и зеленые блики на фотографиях людей и животных, 
снятых со вспышкой. Эффект красных глаз вызван отражением вспышки 
фотоаппарата в сетчатке глаза. Наиболее часто этот эффект возникает при 
съемке в затемненном помещении, поскольку зрачки при этом расширены. 
Избежать эффекта красных глаз можно с помощью соответствующей 
функции фотоаппарата. Гораздо лучше предотвращает появление «красных 
глаз» использование отдельной вспышки, которая устанавливается на 
фотоаппарат на большем расстоянии от объектива. 

Инструмент Color Replacement Tool. 
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Инструмент «Замена цвета» упрощает замену определенных цветов 
изображения. Выбранный цвет можно заменить корректирующим. 
Инструмент «Замена цвета» недоступен в битовом и многоканальном 
цветовых режимах, а также в режиме индексированных цветов. 

 
 
 

 
Тема 4. Векторная 2D графика, возможности и особенности 

применения. 
Мы познакомились подробно с графикой растровой, оценили ее 

достоинства и недостатки. Именно из недостатков и вытекает необходимость 
применения векторной графики. 

Программные средства для работы с векторной графикой наоборот 
предназначены, в первую очередь, для создания иллюстраций и в меньшей 
степени для их обработки. Такие средства широко используют в рекламных 
агентствах, дизайнерских бюро, редакциях и издательствах. Оформительские 
работы, основанные на применении шрифтов и простейших геометрических 
элементов, решаются средствами векторной графики намного проще. 
Существуют примеры высокохудожественных произведений, созданных 
средствами векторной графики, но они скорее исключение, чем правило, 
поскольку художественная подготовка иллюстраций средствами векторной 
графики чрезвычайно сложна. Как в растровой графике основным элементом 
изображения является точка, так в векторной графике основным элементом 
изображения является линия (при этом не важно, прямая это линия или 
кривая). Разумеется, в растровой графике тоже существуют линии, но там 
они рассматриваются как комбинации точек. 

Основными достоинствами векторной графики являются следующие 
особенности: 

• рисунок строится из векторных объектов, которые при сохранении на 
диск описываются в виде математических формул, что существенно 
уменьшает объем файла; 

• векторные объекты легко трансформируются без ухудшения их 
качества; 

• обработка векторных изображений удобна и продуктивна, т. к. имеется 
возможность оперировать целыми объектами или сразу выделять и 
обрабатывать несколько объектов рисунка; 

• печать векторных иллюстраций не связана с разрешением изображения. 
Они могут быть напечатаны с максимальным разрешением, на которое 
способно устройство; 

• одними из лучших векторных программ являются программы Adobe 
Illustrator и CorelDraw. 
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К недостаткам векторной графики можно отнести следующее: 
• векторные рисунки выглядят примитивными, плоскими, не 

фотореалистичными; 
• создание сложных художественных векторных изображений 

затруднительно и требует высоких навыков и больших затрат времени; 
• векторные изображения не могут быть получены сканированием. Их 

можно либо создавать "от руки", либо с использованием программ 
трассировки, которые не обеспечивают надлежащего качества. 

Adobe Illustrator – векторный графический редактор, разработанный и 
распространяемый фирмой Adobe Systems.  

Illustrator был задуман как редактор векторной графики, однако 
дизайнеры используют его в самых разных целях. Программа обладает 
понятным интерфейсом, легким доступом ко многим функциям, широким 
набором инструментов для рисования и большими возможностями 
управления цветом, текстом, что позволяет создавать векторные изображения 
любого уровня сложности. Adobe Illustrator является одним из наиболее 
удобных редакторов для создания различных макетов для прессы или 
наружной рекламы. Часто она используется для создания иллюстраций, 
мультяшной графики, диаграмм и логотипов.  

Преимущества при использовании векторной графики 
• Масштабируема без потерь в разрешении  
• Линии четкие и ровные при любых размерах  
• Печать на высоких разрешениях  
• Меньший размер файлов  
• Хорошо подходит для создания иллюстраций  
Недостатки векторной графики 
• Рисунки склонны выглядеть плоскими и «мультяшными»  
• Тяжело создать фотореалистичные изображения  
Перед  тем, как приступить к созданию файлов  в Adobe Illustrator, 

необходимо изучить инструменты и средства управления интерфейсом 
программы. Компания Adobe использует схожий пользовательский 
интерфейс во всех своих продуктах. Благодаря этому пользователи Adobe 
Photoshop легко могут освоить Adobe Illustrator, и наоборот.  

Интерфейс программы Adobe Illustrator включает в себя много 
уникальных элементов, которые позволяют выполнять различные операции. 
Как только вы научитесь использовать эти элементы, то также узнаете о 
комбинациях клавиш, с помощью которых можно выполнять различные 
задачи.  

Окно документа. Окно документа состоит из рабочей и монтажной 
областей, в которых отображается рисунок. Оно появляется всякий раз при 
открытии уже существующего или создании нового документа.  

 Панель инструментов. Данная палитра содержит основные инструменты. 
Каждому инструменту соответствует определенный значок. Для того чтобы 
выбрать инструмент, достаточно щелкнуть на необходимом значке.  
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 Палитры. Это плавающие окна с вкладками, которые при необходимости 
можно открыть или закрыть.  

 Меню. В верхней части окна программы расположены меню, в которых 
содержатся подменю команд и параметров.  

Монтажная область. Монтажная область – это часть окна программы, в 
которой отображается распечатываемый рисунок. Монтажная область 
обозначается прямоугольником с  тонкой обводкой. 

Окно документа состоит из двух основных элементов: монтажной 
области и рабочей области. Монтажная область всегда расположена в центре 
рабочей области, а почти все палитры закрыты, чтобы обеспечить 
возможность просмотра документа в целом. Для настройки размера, 
ориентации и единиц измерения монтажной области используется 
диалоговое окно Document Setup (Параметры документа). Для его 
отображения воспользуйтесь командой File-Document Setup. Для изменения 
размера станицы используйте команду File-Print (Файл-Печать). 
Обратившись к меню View (Вид), вы сможете скрыть монтажную область с 
помощью команды Hide Artboard (Скрыть монтажную область). После этого 
команда превратится в View Artboard (Отобразить монтажную область). 

Возможно, самая неприятная вещь, которая может случиться при работе с 
программой Illustrator – это потеря всего, что вам удалось сделать. “Куда оно 
все подевалось?” – печатный вариант оборота, который обычно 
употребляется в подобных случаях. В такую ситуацию легко попасть, если 
щелкнуть несколько раз на полосе прокрутки, расположенной в нижней 
части окна документа. При одном таком щелчке происходит перемещение 
области изображения примерно на половину ее ширины (или высоты), а 
после трех щелчков ваша страница (и все, что на ней изображено) исчезает из 
поля зрения. Вместо нее вы видите рабочую область (pasteboard) во всем 
величии белой пустоты.  

Рабочая область – это квадратная область, размером 227,5×227,5 дюймов 
(578×578 cм), которая занимает практически все пространство в пределах 
окна документа. Она доступна для создания, редактирования и временного 
хранения элементов иллюстрации. При реальном размере вы можете видеть 
лишь очень небольшую часть рабочей области. Маленький документ 
размером с письмо выглядит просто крошечным в рабочей области, которая 
довольно велика. Если вы “заблудитесь“ в ней, то советуем выполнить 
команду View-Actual Size (Вид-Реальный размер). При этом ваша страница 
переместится в центр окна с масштабом отображения, равным 100%, и тогда 
вы сможете увидеть хотя бы часть своей иллюстрации. Чтобы увидеть всю 
страницу, выберите команду View-Fit in Window (Вид-По размеру окна). 

Настройка интерфейса 
Бывает, что набор палитр, загружаемых по умолчанию, и их внешний вид 

вас не устраивают. Ситуацию нетрудно изменить, так как по умолчанию 
программа запоминает состояние палитр на момент закрытия. Для этого 
достаточно будет открыть нужные палитры на экране и закрыть ненужные, 
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сгруппировать и разместить их оптимальным образом и установить нужный 
вариант отображения элементов – тогда при следующем открытии программа 
загрузит палитры в точно таком же виде. Правда, бесполезно пытаться 
настроить подобным образом содержимое палитр, добавив в них, например, 
другие цвета, градиентные и текстурные заливки, графические стили, 
символы и кисти, поскольку данная информация при закрытии программы не 
сохраняется – для ее запоминания используются иные механизмы, о которых 
мы расскажем далее. 

Работа с пользовательскими рабочими областями 
Применение пользовательских рабочих областей (Workspace), 

сохраняющих расположение и группировку палитр в окне программы, 
позволяет быстро восстанавливать соответствующие пользовательские 
настройки. Данная возможность позволяет сконфигурировать несколько 
оптимальных рабочих областей, настроенных для решения определенных 
видов задач или для разработки разноплановых проектов (например, одна 
рабочая область может использоваться для web-дизайна, а другая – для 
полиграфии и т.п.). Пользовательские рабочие области могут применяться и 
при работе на одном компьютере нескольких пользователей, каждый из 
которых использует свою индивидуально настроенную рабочую область. Это 
очень удобно, так как можно быстро настроить программу либо под 
потребности конкретного пользователя, либо для текущей работы, загрузив 
соответствующую рабочую область из меню. При необходимости можно 
быстро переключаться между разными рабочими областями. 
Пользовательские рабочие области представляют собой файлы, которые 
можно хранить на диске и вновь подключать после переустановки 
программы. 

По умолчанию предусмотрены две базовые конфигурации рабочих 
областей: [Default] и [Minimal]. Первая загружается при создании нового 
документа, может вызываться 
командой Window=>Workspace=>[Default] (Окно=>Рабочая область=>По 
умолчанию) и обеспечивает загрузку рабочей области по умолчанию, что 
требуется в ходе работы для восстановления палитр. Вторая конфигурация 
загружается при помощи команды Window=>Workspace=>[Minimal] 
(Окно=>Рабочая область=>Минимальная) и позволяет освободить 
максимально возможное пространство для работы, так как при ее вызове 
закрываются все палитры, кроме панели инструментов и палитры Control 
Palette, содержащей переключатели и настройки используемого инструмента.  

1. Сохранение в формате Illustrator 
Если в документе содержится несколько монтажных областей и требуется 

их сохранение в предыдущей версии Illustrator, выберите функцию 
сохранения каждой монтажной области в отдельный файл или объединения 
содержимого всех монтажных областей в один файл. 

1. Выберите команду «Файл» > «Сохранить как» или «Файл» > 
«Сохранить копию». 
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2. Введите имя файла и выберите папку для сохранения. 
3. Выберите в качестве формата файла формат Illustrator (*.AI) и нажмите 

кнопку «Сохранить». 
4. В диалоговом окне «Параметры Illustrator» задайте нужные параметры 

и нажмите кнопку «ОК». 
Версия 
Определяет версию Illustrator, совместимость с которой необходимо 

обеспечить при сохранении файла. Устаревшие форматы не поддерживают 
все возможности текущей версии Illustrator. Поэтому при выборе версии, 
отличной от текущей, некоторые параметры сохранения окажутся 
недоступными, и часть данных будет изменена. Обязательно прочитайте 
предупреждения в нижней части диалогового окна, чтобы узнать, как будут 
изменены данные. 

Сократить знаковый состав шрифтов, если используется символов 
меньше чем 

Определяет, должен ли быть встроен весь шрифт (а не только символы, 
использованные в документе) на основе процентной доли символов шрифта, 
использованных в документе. Например, если шрифт содержит 1000 
символов, но в документе используется только 10 из них, возможно, 
встраивание всего шрифта не требуется, чтобы не увеличивать размер файла. 

2. Создать PDF-совместимый файл 
Сохраняет представление документа в формате PDF в файле Illustrator. 

Выберите этот параметр, если необходимо создать файл Illustrator, 
совместимый с другими приложениями Adobe. 

Включить связанные файлы 
Встраивает файлы, связанные с иллюстрацией. 
Встроить ICC-профили 
Создает документ, в котором используется управление цветом. 
Применить сжатие 
Выполняет сжатие данных PDF в файле Illustrator. При использовании 

сжатия время, необходимое для сохранения документа, увеличивается, 
поэтому отмените выбор этого параметра, если сохранение файлов 
осуществляется медленно. 

Сохранить каждую монтажную область в отдельный файл 
Сохранение каждой монтажной области в отдельном файле. При этом 

также создается отдельный главный файл, включающий все монтажные 
области. В этот файл также включено все содержимое, затрагивающее 
какую-либо монтажную область. Если требуется сместить иллюстрацию и 
подогнать ее под размер одной монтажной области, будет выдано 
соответствующее предупреждение. Размер монтажной области, 
используемой для сохраненного файла, берется из стартового профиля 
документа по умолчанию. 

Сохранение в формате EPS 
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Практически все графические приложения, программы верстки и 
текстовые редакторы работают с импортированными или помещенными 
файлами EPS (Encapsulated PostScript). Формат EPS сохраняет многие из 
графических элементов, которые можно создавать в Adobe Illustrator, 
поэтому файлы EPS можно повторно открывать и редактировать как файлы 
Illustrator. Поскольку в основе файлов EPS лежит язык PostScript, эти файлы 
могут содержать как векторные, так и растровые изображения. Если 
иллюстрация содержит несколько монтажных областей, они сохраняются 
при сохранении в формате EPS. Сохранение в формате SVG 

SVG – векторный формат, используемый для высококачественных 
интерактивных веб-изображений. Существуют две версии формата SVG: 
SVG и сжатый SVG (SVGZ). При использовании формата SVGZ размер 
файла может быть уменьшен на 50–80%, однако нельзя редактировать файлы 
SVGZ с помощью текстового редактора. 

При сохранении иллюстрации в формате SVG сетчатые объекты 
растрируются. Кроме того, изображения, не содержащие альфа-канала, 
преобразуются в формат JPEG. Изображения, содержащие альфа-канал, 
преобразуются в формат PNG. Если в документе содержится несколько 
монтажных областей, то при сохранении этого документа в формате SVG 
будет сохранена только активная монтажная область. Отдельные монтажные 
области не могут быть сохранены как отдельные файлы SVG. 

 
Тема 5. 3D графика. Трехмерное моделирование объектов. 

 
Краткое содержание 
Геометрическое моделирование как основа трехмерной графики. Классы 

геометрических моделей. Особенности и возможности полигонального и 
NURBS-моделирования. Основные подходы к геометрическому 
моделированию: конструктивная геометрия, граничное представление.   

Системы координат: декартова, мировая, экранная, видовая, локальная, 
родительская. Способы проецирования. Проекции: ортогональные, 
аксонометрические. Афинные преобразования. 

Программные средства трехмерного моделирования. Сферы применения. 
Система моделирования и анимации 3D Studio Max. Элементы интерфейса 
3DSMax. Классы объектов. Этапы создания геометрической модели сцены. 
Способы создания и изменения объектов. Особенности создания трехмерных 
объектов для компьютерных игр. 

Понятие текстурирования. Цвет объектов в трехмерной сцене. Создание и 
определение свойств материалов. Источники света и камеры. Способы 
создания анимации. Понятие визуализации (рендеринга). Типы рендеров. 
Методы рендеринга.  
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3D слои в двумерной графике. Приемы трехмерного моделирования в 
двумерной графике.  

Конфигурация компьютера для работы с трехмерной графикой. 
Интерфейс прикладного программирования (API). API графических 
интерфейсов OpenGL, Direct3D. Настройка API. 3D сканеры. 

 
Основные понятия 
Геометрическое моделирование подразделяется на каркасное, 

поверхностное, моделирование твердых тел.  

Каркасные модели (Wire-frame Geometry) характеризует форму тела 
набором пространственных линий. Элементарные геометрические объекты - 
вершины (точки) и ребра (линии). Каркасное представление часто 
используется как один из экономных методов визуализации, но его главный 

недостаток – неоднозначность. 
Модели поверхностей (Surface Geometry) характеризует форму тела 

набором ориентированных поверхностей, ограничивающих его. 
Элементарные геометрические объекты - вершины, ребра и грани тела, 
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заданные координатами точек и уравнениями линий и поверхностей. Базовые 
операции - продление, обрезка, соединение поверхностей. Такое 
представление удобно для задач программирования, однако может приводить 
к неоднозначностям при моделировании сложных объектов.  

Модели конструктивной твердотельной геометрии (CSG - Constructive 
Solid Geometry) формируется как композиция некоторых областей 
пространства с помощью теоретико-множественных операций. 
Элементарные геометрические объекты (примитивы) - простые тела (сфера, 
конус, цилиндр и др.). Базовые операции - объединение, пересечение, 
отсечение. Структура модели - дерево (вершины - примитивы, ребра - 
операции).   

Твердотельные модели граничного представления (B-Rep - Boundary 
Representation) описывает множество граничных точек как совокупность 
вершин, ребер и граней. Примитивы и базовые операции - те же, что и для 
CSG, различия состоят лишь в способах хранения модели в памяти.  

Поверхностные модели различаются по способу аппроксимации 
поверхности. Более простой в части структуры данных и используемых для 
работы с ними алгоритмов является полигональная аппроксимация, когда 
поверхность представляется набором взаимосвязанных плоских граней, на 
практике чаще всего треугольных. Такая аппроксимация легко строится, для 
нее разработаны эффективные алгоритмы реалистичной  визуализации,  она  
не  требует  значительных вычислительных ресурсов, хотя может быть и 
затратной по памяти. Главным ограничением такой аппроксимации является 
то, что она имеет фиксированную точность, т.е. отклонение положения 
модельной поверхности от «идеальной» моделируемой. Для достижения 
высокой точности требуется создание сеток с малым шагом, что ведет к 
росту требований к вычислительным возможностям системы. Поэтому 
использование полигональной аппроксимации на текущий момент 
ограничено подсистемами визуализации и простейшего 3D эскизирования. 

Этих недостатков лишена технология NURBS ( Non-Uniform Rational B-
Spline , неоднородный B-сплайн), сегодня наиболее часто используемая в 
практике. Такое описание поверхности обеспечивает определение координат 
любой ее точки, радиуса кривизны в ней, направления нормали к 
поверхности с высокой, в общем случае (без учета вычислительных затрат) с 
любой наперед заданной точностью. Определенным недостатком такого 
подхода является сложность алгоритмов работы с NURBS, однако это  
обстоятельство  исторически преодолено исследователями и разработчиками. 

В определенной степени, NURBS-представление является развитием 
полигонального, но в отличие от него позволяет описывать не только 
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плоские, но и криволинейные грани и ребра (кромки). Совокупность таких 
граней общими ребрами по традиции называют сеткой. Технология NURBS 
обеспечивает реализацию ряда функциональных возможностей, недоступных 
или существенно ограниченных при использовании каркасного или  
полигонального представления: вычисление радиуса кривизны поверхностей, 
их гладкое сопряжение, построение траекторий на поверхности, получение 
точных изображений спроецированных на плоскость, например для 
получения чертежных видов и т.д.  

Традиционно в системах автоматического проектирования (САПР) 
используется несколько типовых контекстов создания поверхностей: 

• плоская поверхность – получается заполнением плоского контура (2D-
эскиз или набор замкнутых кромок, лежащих в одной плоскости); 

• поверхность вытяжки – образуется в результате плоскопараллельного 
вытягивания замкнутого или разомкнутого 2D/3D-эскиза в направлении, 
перпендикулярном плоскости эскиза, или под произвольным углом; 

• поверхность вращения – получается вращением произвольного профиля 
(2D-эскиз) относительно оси; 

• поверхность по траектории – создается движением 2D/3D-эскиза вдоль 
криволинейной образующей (2D/3D-эскиз, 3D-кривая) и произвольного 
числа направляющих кривых (2D/3D-эскиз, 3D-кривая), деформирующих 
исходный контур; 

• поверхность по сечениям – аналог поверхности по траектории; 
отличается тем, что строится не по одному, а по нескольким поперечным 
сечениям с направляющими кривыми; 

• граничная поверхность – аналог поверхности по сечениям; отличается 
тем, что строится по нескольким произвольно сориентированным в  
пространстве 3D-кромкам других поверхностей с сохранением касательности 
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к ним и с соблюдением непрерывности по второй производной (гладкая 
стыковка); при построении могут использоваться направляющие кривые; 

• поверхность свободной формы – строится разбиением сетки с 
управляющими точками на поверхности грани 3D-модели; изменение формы 
поверхности достигается перетаскиванием контрольных точек; 

• эквидистантная поверхность – получается смещением на определенное 
расстояние от существующих граней или поверхностей; 

• поверхность разъема – используется при проектировании литейных 
форм в качестве вспомогательной геометрии для разделения матрицы и 
пуансона; 

• рединная поверхность – создается на середине (или заданном проценте) 
толщины тонкостенной детали; 

• линейчатая поверхность – строится под углом к выбранной кромке и 
предназначена для построения граней с уклоном; 

В том случае, если установлена программная связь между 
вспомогательным каркасом и результирующей поверхностью – 
моделирование становится ассоциативным, при этом изменение каркасных 
элементов ведет к автоматическому изменению геометрии поверхностей, 
поостренных с использованием этого контекста. 

Несмотря на достаточно широкие возможности, которые предоставляет 
поверхностное моделирование, и оно имеет ряд существенных ограничений с 
точки зрения использования в САПР, в частности невозможность 
вычисления объемов, масс и моментов инерции объектов, ограниченность 
применения к ним булевых операций (вычитания, объединения, 
пересечения). Эти ограничения снимаются при использовании 
твердотельного моделирования, ставшего на сегодня стандартом де-факто в 
3D CAD/CAM/CAE системах. Существуют различные алгоритмические 
методы представления твердотельных моделей – воксельное, использование 
октарных и бинарных деревьев, однако в практике САПР наиболее широкое  
применение имеет  технология,  базирующаяся  на  граничном  
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представлении элементарных односвязных тел (BREP, Boundary 
Representation) в совокупности с конструктивной геометрией (CSG, 
constructive solid geometry) описывающей операции над телами. 

Граничное представление определяет сплошное тело неявно путем 
описания ограничивающей его поверхности. Суть BREP-представления 
заключается в том, что твердое тело описывается замкнутая 
пространственная область, ограниченная набором элементарных тонких 
поверхностей (граней), с общими образующими контурами (ребрами) на 
границе поверхностей и признаком внешней или внутренней стороны 
поверхности, а также обеспечивающим следующий ряд операций, 
определенных над телами: 

• проверка правильности задания, для односвязных тел осуществляется по 
формуле Эйлера, в наиболее общем виде записываемой как: 

V - E + F = 2, 
где, V - количество вершин, E - количество ребер, F - количество граней; 
• вычисление габаритного объема; 
• вычисление кривизны поверхности; 
• нахождение точки пересечения с контуром или другой поверхностью; 

• определение положения точки относительно поверхности. 
Для описания сложных тел, моделирующих объекты реального мира, 

получаемые обработкой материала или неразъемной сборкой, используется 
иерархическая структура, описывающая тела как последовательность 
применения булевых операций над набором элементарных твердых тел - так 
называемое CSG-дерево (Constructive Solid Geometry tree). В рамках CSG 
представления для описания составных твердых тел определены следующие 
операции над исходными  элементарными телами (а): вычитание (б);  
объединение (в); пересечение (г). 

Также как и для элементарного тела, правильность построения 
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определяется формулой Эйлера, записываемой для многосвязных тел в 
частном виде: 

V - E + F - H = 2(C - G) 
где, V - количество вершин, E - количество ребер, F - количество граней, 

H – количество несквозных отверстий, C - количество компонент, G - 
количество сквозных отверстий. 

Таким образом, любое составное тело может быть описано в виде 
традиционного уравнения из булевых функций, в котором аргументами 
являются либо элементарные тела, либо другие составные тела. Это 
представление называют деревом построений. Такое представление, кроме 
удобства модификации геометрии результирующего тела, позволяет 
существенно снизить требования к вычислительным ресурсам за счет 
применения оптимизирующих процедур к дереву построений. 
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Представление твердых тел в виде дерева построений удобно также и с 
точки зрения организации пользовательского интерфейса, обеспечивающего 
наглядный и быстрый доступ к любому элементу, входящему в описание 
геометрии тела, его модификацию и получение отчетной информации. 

Системы координат – это совокупность правил, ставящих в соответствие 
каждому объекту (точке) набор чисел (координат)  

(x1, y1), (x1, y1, z1), (x3, y3).  
Число координат, требуемое для определения точки, определяет 

размерность пространства.  

 
Декартовыми прямоугольными координатами точки P в двумерном 

пространстве называются взятые с определенным знаком расстояния 
(выраженные в единицах масштаба) этой точки до двух взаимно 
перпендикулярных координатных осей или, что то же самое, проекции 
радиус-вектора r точки P на две взаимно перпендикулярные координатные 
оси. 

 Полярными координатами точки P называются радиус-вектор ρ - 
расстояние от точки P до заданной точки O (полюса) и полярный угол φ - 
угол между прямой OP и заданной прямой, проходящей через полюс 
(полярной осью). Полярный угол считается положительным при отсчете от 
полярной оси против часовой стрелки и отрицательным при отсчете в 
обратную сторону. Координатные линии в полярных системах - окружности 
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с центром в полюсе и лучи 

Формулы для перехода от полярных координат к декартовым: 
x=ρ*cos(φ), y=ρ*sin(φ). 

В литературе по компьютерной графике используют также (в 
зависимости от способа представления графических данных) следующие 
разновидности координатных систем: локальные, глобальные, мировые, 
приборные и другие. 

Локальная система координат – дву-или трехмерная система собственных 
координат объекта. В ней производится моделирование объекта. В частных 
случаях локальная система координат может быть декартовой, аффинной, 
полярной и т.д. 

Глобальная система координат – дву- или трехмерная система координат, 
в которой описывается взаимосвязь между объектами, например, их 
взаимное расположение. В частных случаях система может быть декартовой, 
аффинной, полярной и т. д. 

Мировая система координат – дву- или трехмерная система координат, 
которая является входной системой координат базисных графических систем. 
Она используется для описания изображений. 

B 3ds Max включена видовая система координат View (Видовая). Она 
характеризуется тем, что во всех окнах проекций, кроме перспективного, 
используется система координат экрана Screen - экранная, в которой 
направление осей зависит от выбранного видового окна. Глобальная система 
координат (World) или мировая является единой системой координат для 
всех объектов сцены. Bсе трехмерные объекты перемещаются по оси Х – 
горизонтально (справа налево и слева направо); по оси Y – к наблюдателю и 
от наблюдателя; по оси Z – вертикально (вверх и вниз). Глобальная система 
координат используется в окне проекции Perspective (Перспективный вид). 

Экранная система координат (Screen) используется в ортогональных 
видах, то есть в окнах проекций Тор (Вид сверху), Front (Вид спереди) и Left 
(Вид слева). В этих окнах проекций трехмерные тела спроецированы на 
заданную плоскость в виде двухмерных. Согласно системе координат Screen 
(Экранная), оси всегда одинаково повернуты в любом видовом окне: X – 
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вправо,Y– вверх, а Z направлена от наблюдателя, то есть проецируется в 
точку. 

Видовая система координат (View) сочетает в себе две предыдущие 
системы. 

Проецирование - это процесс получения изображения предмета на какой-
либо поверхности Получившиеся при этом изображение называют проекцией 
предмета. 

Элементами, с помощью которых осуществляется проецирование, 
являются: центр проецирования - точка, из которой производится 
проецирование; объект проецирования - изображаемый предмет; плоскость 
проекции - плоскость, на которую производится проецирование; 
проецирующие лучи - воображаемые прямые, с помощью которых 
производится проецирование, результатом проецирования является 
изображение, или проекция, объекта. 

 

 
Различают центральное и параллельное проецирование. При центральном 

проецировании все проецирующие лучи исходят из одной точки - центра 
проецирования, находящегося на определённом расстоянии от плоскости 
проекций. На рисунке «Центральное проецирование» за центр 
проецирования условно взята электрическая лампочка. Исходящие от неё 
световые лучи, которые условно приняты за проецирующие, образуют на 
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полу тень, аналогичную центральной проекции предмета. Метод 
центрального проецирования используется при построении перспективы. 
Перспектива даёт возможность изображать предметы такими, какими они 
представляются нам в природе при рассмотрении их с определённой точки 
наблюдения. 

При параллельном проецировании все проецирующие лучи параллельны 
между собой. Центр проецирования предполагается условно удалённым в 
бесконечность. Тогда параллельные лучи отбросят на плоскость проекций 
тень, которую можно принять за параллельную проекцию изображаемого 
предмета. В черчении пользуются параллельными проекциями. Выполнять 
их проще, чем центральные. Если проецирующие лучи составляют с 
плоскостью проекций примой угол, то такие параллельные проекции 
называются прямоугольными. Прямоугольные проекции называют также 
ортогональными.  Чертежи в системе прямоугольных проекций дают 
достаточно полные сведения о форме и размерах предмета, так как предмет 
изображается с нескольких сторон.  

Аксонометрические проекции передают одним изображением 
пространственную форму предмета. Такое изображение создаёт у человека 
впечатление, близкое к тому, которое получается при рассмотрении предмета 
в "натуре". Аксонометрические проекции получаются, если изображаемый 
предмет вместе с осями координат, к которым он отнесён, с помощью 
параллельных лучей проецируют на одну плоскость, называемой 
аксонометрической. 

Слово "аксонометрия" переводится "измерение по осям или измерения 
параллельно осям", так как размеры изображаемого предмета откладываются 
параллельно осям х, у, z называемым аксонометрическими осями. В 
зависимости от наклона осей координат х, у, z к аксонометрической 
плоскости и угла, составляемого проецирующими лучами с этой плоскостью, 
образуются различные аксонометрические проекции. Если проецирующие 
лучи перпендикулярны плоскости, то проекция называется прямоугольной. 
Если проецирующие углы наклонны к плоскости, то проекция называется 
косоугольной. 

Аффи́нное преобразование  (от лат. affinis – соприкасающийся, близкий, 
смежный) – отображение плоскости или пространства в себя, при котором 
параллельные прямые переходят в параллельные прямые, пересекающиеся в 
пересекающиеся, скрещивающиеся в скрещивающиеся.К аффинным 
преобразованиям относятся движения. Движения – это такие преобразования, 
которые сохраняют расстояние между любыми двумя точками неизменным, а 
именно параллельные переносы, повороты, различные симметрии и их 
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комбинации. Другой важный случай аффинных преобразований – это 
растяжения и сжатия относительно прямой. 

Редакторы трехмерной графики: 
- 3D-Studio Max; 
- Autodesk Maya (от Санскритского слова māyā, майа, которое означает 

иллюзия). С её помощью были реализованы такие кино- и анимационные 
персонажи, как Стюарт Литтл, Человек-невидимка, Шрэк, ВАЛЛ-И,Голлум 
(Властелин колец), Халк, Дейви Джонс (Пираты Карибского моря); 

-Blender - Многоплатформенный графический 3D пакет, 
распространяемый с открытым исходным кодом; 

- Google SketchUp – создание, редактирование и публицация 3D-моделей  
домов, мебели и интерьера; 

Sweet Home 3D - создание дизайна интерьера и др. 
3D-сканер – периферийное устройство, анализирующее физический 

объект и на основе полученных данных создающее его 3D-модель. 3D-
сканеры делятся на два типа по методу сканирования: контактный и 
бесконтактный.  

Контактный метод основывается на непосредственном контакте сканера с 
исследуемым объектом. Бесконтактные сканеры в свою очередь делятся на 
активные и пассивные. Активные сканеры излучают на объект некоторые 
направленные волны (чаще всего свет, луч лазера) и обнаруживают его 
отражение для анализа. Возможные типы используемого излучения 
включают свет, ультразвук или рентгеновские лучи. Пассивные сканеры не 
излучают ничего на объект, а вместо этого полагаются на обнаружение 
отраженного окружающего излучения. Большинство сканеров такого типа 
обнаруживает видимый свет – легкодоступное окружающее излучение. 

Полученные методом сканирования 3D-модели в дальнейшем могут быть 
обработаны средствами САПР и, а так же для разработки технологии 
изготовления и инженерных расчётов. Для вывода 3D-моделей могут 
использоваться такие средства, как 3D-монитор, 3D-принтер или фрезерный 
станок с поддержкой G-кода. 
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ПРАКТИЧЕСКИЙ РАЗДЕЛ 
 

Тема 2. Растровая 2D графика. Композитные изображения. Создание 
композиций. 

Лабораторная 1-2. Выделение и трансформация. 
Инструменты выделения в Фотошоп предназначены для того, чтобы 

выделить определенную область на изображении и далее обработать её. 
Иными словами можно, например, выделить какую-то часть на фото, и 

затемнить её, при этом остальная часть останется не тронутой. 
Если посмотреть на панель инструментов в Фотошопе, то мы 
увидим три «полочки» с инструментами выделения.  

Но на самом деле инструментов больше. Для того чтобы 
увидеть остальные, нужно зажать левую кнопку мыши. В таком 
случае они появляются в выпадающем списке. Зажав первый 
инструмент выделения, мы увидим все четыре: Прямоугольная 
область, Овальная область, Область (горизонтальная строка), 
Область (вертикальная строка). Это самые главные 
инструменты выделения. 

 
Ниже у нас идут: Лассо, Прямолинейное лассо, Магнитное лассо. 
И третья партия инструментов выделения: Быстрое выделение и 

Волшебная палочка. 
Давайте создадим новый документ и попробуем поработать с этими 

инструментами. Выбираем инструмент выделения Прямоугольная область. 
Теперь кликаем по созданному документу левой кнопкой мыши, и удерживая 
ее, тащим мышку в сторону, растягиваем. Когда нужная область будет 
выделена, мышку надо будет отпустить. Таким образом, у нас получилась 
произвольно выделенная область. Если мы хотим чтобы при выделении 
сохранялись пропорции, то все это нужно делать с зажатой клавишей Shift. 
Это выделение мы можем перемещать по всему документу. Для этого нужно 
навести курсор мыши на само выделение, зажать и перетащить в нужное 
место. Если мы попытаемся создать еще одно выделение, то первое исчезнет. 
Так выделение настроено по умолчанию. Но мы можем это подправить в 
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Опциях, выбрав второй режим «Добавление к выделенной области», кликнув 
по соответствующей иконке.  

Теперь каждое новое выделение будет оставаться. И 
еще мы можем добавлять область выделения, к уже 
выделенной области. 

 
Чтобы убрать выделение нужно выбрать меню 

«Выделение – Отменить выделение». Либо 
воспользоваться горячей клавишей Ctr+D. 

Остальные инструменты выделения данной 
группы похожи в работе. Например, Овальная 
область. С помощью него мы можем выделить 
овальную область, либо круг, если сохраним 
пропорции, зажав клавишу Shift. 

 
Далее у нас идут инструменты Лассо. Первым пользоваться очень просто, 

как карандашом, обводим нужную область, и она становится выделенной, 
после того как мы отпускаем клавишу мыши. Этот инструмент выделения 
произвольный. Далее идет Прямолинейное лассо. Выделение происходит от 
точки к точке. Ставим на документе точку, затем вторую, третью и т.д., затем 
замыкаем последнюю точку с первой и получается выделенная область. 
Наиболее удобно его использовать для выделения каких-то прямоугольных 
объектов. И Магнитное лассо, этот инструмент пытается автоматически 
определить грани объекта, который мы пытаемся выделить. Для этого ставим 
точку где-нибудь, где начинается картинка и ведем вокруг него. И 
инструмент сам примагничивает и создает точки вокруг него. После полного 
обведения, нужно замкнуть инструмент с первой точкой, и объект выделен.  

Следующая группа инструментов: Быстрое 
выделение и Волшебная палочка. С помощью 
Быстрого выделения мы можем выделять 
объект, просто как бы закрашивая те места, 
которые нужно выделить. И еще один 
инструмент – Волшебная палочка. Он выделяет 
то место, куда мы кликаем и соседние похожие 

по цвету пиксели. Здесь также есть пару важных настроек в Опциях. Первое, 
- это, как и с первым инструментом выделения – выбор режима, то есть 
каждое нажатие будет добавлять новое выделение, а старое исчезать или у 
нас выделение будет добавляться к уже тому, что есть. И второе, - это 
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Допуск, чем больше это значение, тем больше соседних цветов будет 
затрагиваться при выделении. То есть что-то вроде чувствительности. 

Команды трансформации, особенности применения.  
Самый распространенный способ изменения размера изображения, 

вращения, отражения, наклона и искажения изображений – использовать 
команды трансформирования, которые могут помочь вам сделать один 
выбранный объект или весь слой больше или меньше, не меняя размер 
документа. 

Если вы перейдете в меню Редактирование, вы увидите команды 
Свободное трансформирование (Free Transform) и Трансформирование 
(Transform) примерно в середине списка. Единственное существенное 
различие между этими двумя вариантами – это то, что при выборе пункта из 
меню Трансформирование, вы ограничиваете себя выполнением только этой 
конкретной задачи (с помощью инструмента Масштаб, например), тогда как 
другая команда позволяет выполнять несколько изменений одновременно (не 
требуя нажатия клавиши Enter) 

Примечание. Если вы попытаетесь трансформировать фигуру или весь 
контур, пункт меню Редактирование сменится на Трансформирование 
контура. При попытке изменить только часть контура, пункт меню будет 
выглядеть как Трансформирование узлов (Transform Points).  

Выбор одной из этих команд вызывает ограничительную рамку, которая 
выглядит и работает как рамка кадрирования с крошечными квадратными 
маркерами по четырем сторонам изображения. 

Вы можете преобразовать любые объекты, какие захотите. Особенно 
хорошими кандидатами на трансформацию являются векторы, контуры, 
слои-фигуры и текстовые слои, а также смарт-объекты, поскольку размер 
всех их можно изменить без ущерба изображению. Но вам не стоит слишком 
сильно увеличивать растровые изображения, потому что вы не можете 
контролировать разрешение, интерполяцию или другие важные свойства. 
Чтобы действительно обезопасить себя, изменяйте размер изображения с 
помощью команд трансформации только по следующим причинам: 

1. Для уменьшения размера выделенной области на одном слое. 
2. Для уменьшения размера всего содержимого на одном или нескольких 

слоях 
3. Для увеличения размера вектора, контура, части контура, слоя-фигуры, 

текстового слоя или смарт-объекта на одном или нескольких слоях. 
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Чтобы применить команду 
Свободное трансформирование, 
выберите слой, а затем нажмите 
сочетание клавиш Ctrl+T  или 

выберите соответствующую команду 
меню Редактирование. Фотошоп 
поместит ограничительную рамку 
вокруг изображения, содержащую 
маркеры, позволяющие применять к 
вашему объекту любую или все из 
следующих трансформаций: 
масштабирование, искажение, 
поворот, перспектива, наклон и 
деформация. 

4. Чтобы изменить масштаб 
(размер) объекта, захватите угловой 
маркер и перетащите его по диагонали 
внутрь для уменьшения или наружу 

для увеличения размера. Нажмите и удерживайте клавишу Shift при 
перетаскивании, чтобы изменить размеры пропорционально (то есть чтобы 
объект не был искажен). 

Вы можете перетаскивать по одному маркеру или нажать и удерживать 
клавишу Alt для изменения масштаба от центра наружу (имеется в виду, что 
все четыре стороны ограничительной рамки будут двигаться одновременно). 

5. Чтобы повернуть изображение, расположите указатель мыши за 
угловым маркером. Когда указатель примет вид изогнутой двунаправленной 
стрелки, перетащите мышь вверх или вниз. 

6. Чтобы наклонить (скосить) объект, удерживайте сочетание клавиш 
Ctrl+Shift и перетащите один из боковых маркеров (указатель мыши примет 
вид двунаправленной стрелки). 

7. Чтобы свободно исказить изображение, удерживайте клавишу Alt при 
перетаскивании любого углового маркера. 

8. Чтобы изменить перспективу объекта, удерживайте сочетание клавиш 
Ctrl+Alt+Shift и перетащите любой из угловых маркеров (указатель станет 
серым). Этот маневр добавляет объекту одноточечную перспективу (другими 
словами, одну точку схода). 

9. Чтобы деформировать изображение, перетащите любую контрольную 
точку или линию сетки. 

Когда вы закончите, нажмите клавишу Enter или дважды щелкните 
мышью внутри ограничительной рамки, чтобы применить изменения. 

Если применив трансформирование вы поняли, что его недостаточно, 
можно повторить операцию, выбрав команду меню Редактирование => 
Трансформирование => Применить снова (Edit => Transform => Again). 
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Ограничивающая рамка не появится, вместо этого фотошоп повторно 
применит то же самое трансформирование. 

Совет. Все трансформации основаны на крошечном центре 
преобразования, который появляется в центре окна преобразования. Он 
выглядит как круг с перекрестием. Вы можете перетащить его или 
установить собственный центр, перейдя на панель параметров или щелкнув 
мышью по одному из квадратных указателей значка, показывающего 
положение центра преобразования или указав координаты X и Y.  

 
Лабораторная работа 3-4. Слои. Основы комбинирования 

изображений. Приемы реалистичного наложения рисунка на объект. 
Режимы смешивания слоев.  

Задание 1: используя инструменты выделения, собрать пазл. 

 

           
Техника работы со слоями. 
Палитра Слои. Перемещение и копирование слоев. Видимость и 

блокировка слоя. Прозрачность слоя. Фон. Редактирование слоев. Группы. 
Сведение. Создание многослойного изображения. 

 
Сегодня я хочу обобщенно рассказать вам о Панели слоев в Фотошоп, где 

её найти в программе  и как с ней работать. Панель слои находится в меню 
ОКНО- СЛОИ и вызывается быстрой клавишей F7. Для начала давайте 

посмотрим, как выглядит данная панель: 
В верхней части панели вы можете выбрать 

режим наложения, с помощью этой возможности 
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можно создавать разнообразные эффекты для фотографий, этим мы с вами 
сегодня и займемся. По умолчанию мы видим режим обычный. Также вы 
можете установить непрозрачность любого слоя. Так, если она будет равна 
0%, слой не будет виден вообще. При непрозрачности 100%, вы увидите слой 
полностью. Слева от миниатюры каждого слоя вы увидите изображение 
глаза. Убрав его, слой станет невидимым. Внизу панели вы увидите набор 
значков, с помощью которых можно работать со слоями: 

 
С помощью левого значка «fx» вы сможете придать стиль любому слою. 

Добавить векторную и слой маску вы можете с помощью значка круг в 
Прямоугольнике, который находится чуть правее. Следующий значок – 
черно-белый круг, позволит вам создать новый корректирующий слой. 
Создать новый, прозрачный слой вам поможет второй значок справа в форме 
квадрата с загнутым углом. Ну и, собственно, удалить слой вы можете, 
нажав  на значок корзину. На фоновом основном слое зачастую стоит 
замочек, который не позволяет вам изменять его содержимое. Для того чтобы 
разблокировать слой, просто дважды щелкните по этому слою и в 
открывшемся окне нажмите «ок». 

Остановимся немного подробнее на некоторых функциях слоя: 
Как продублировать слой 
При работе со слоями у вас будет постоянно возникать необходимость 

сделать дубликат слоя. Самый простой способ – выбрать нужный слой и 
нажать Layer > Dublicate Layer. Более быстрый способ – нажать ALT и 
перетащить слой выше. Если ALT нажат, слой продублируется. Таким же 
образом можно продублировать все что угодно. Маску, эффекты стиля, 
эффекты смарт слоя. 

Как сделать прозрачный слой 
Большинство новичков интересует, как сделать некий элемент дизайна 

прозрачным? Эти настройки находятся в верхней части панели слоев – 
Opacity и Fill. Обе настройки делают слой прозрачным. На первый взгляд не 
понятна разница между ними. Тем не менее она есть. 

• Opacity – убирает видимость всего слоя целиком. 
• Fill – убирает видимость только заливочного содержания слоя, но 

оставляет видимым все остальное. 
Пока мы имеем дело с обычным слоем, вот это «все остальное», что не 

убирает Fill, нас никак не волнует. Использовать Fill нужно только тогда, 
когда мы хотим уменьшить видимость слоя, но не трогать эффекты стиля 
слоя, если они есть. Во всех остальных случаях нужно пользоваться Opacity.  

Режимы блокировки слоя 
Начинающий пользователь может столкнуться с ситуацией, при которой 

слой не реагирует на его действия. Не перемещается, не поддается 
манипуляциям. Скорее всего, слой заблокирован. Режимы блокировки слоя 
находятся в верхней части панели слоев Layers. Всего их четыре. Некоторые 
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из них запрещают конкретные команды, другие все вместе.

 
• Lock transparency pixel – из названия понятно, что эта настройка 

запрещает манипуляции с невидимыми пикселями. То есть слой можно 
перемещать, удалять видоизменять. Но менять информацию невидимости 
нельзя. Эти пиксели заблокированы. На практике это удобно использовать, 
если нужно подкрасить элементы слоя, не трогая невидимые области. 
Обычно мы создаем выделение, чтобы работать только в выделенной области 
слоя, но Lock transparency pixel представляет из себя хорошую альтернативу.  

• Lock image pixels – запрещает изменение всех пикселей, как видимых 
так и не видимых. То есть двигать можно, менять содержание графики, нет. 
Кисти, штампы, градиенты и прочие инструменты редактирования и ретуши. 
Все запрещено. 

• Lock position – запрещено менять позицию слоя. Слой нельзя сдвинуть. 
Его местоположение зафиксировано. Все остальное можно. Удобно 
использовать, понятно, в тех случаях, когда масса времени ушла на 
нахождение правильного места для слоя, и случайно сдвинуть его очень не 
желательно. А с другой стороны слой должен быть доступен для 
редактирования. 

• Lock All – и, конечно, самое простое – полная блокировка слоя. Нельзя 
двигать и менять графику. 

Заблокированный слой помечается специальным значком замочка. 
Поэтому определить, какой слой заблокированный, а какой нет очень просто. 

Как связать слои 
Часто возникают ситуации, когда вы хотите связать несколько слоев, так 

как вместе, они представляют из себя законченный элемент. Между тем, вы 
не хотите их сливать в один слой, теряя контроль над всеми элементами. В 
этом случае удобно воспользоваться линкингом в Фотошопе. Эта опция 
находится в нижней части панели слоя и выглядит как цепочка. Другой 
способ связать слои, нажать Layer > Link Layers. 

Связанные слои можно перетаскивать вместе. То есть, чтобы передвинуть 
группу залинкованных слоев, не нужно выделять все. Достаточно выбрать 
один. Привязанные слои двинутся вслед за выбранным слоем. 

Говоря о связывании слоев между собой командой Layer > Link Layers, 
хочется отметить и следующий нюанс. В некоторых ситуациях связанные 
слои раскиданы далеко друг от друга на панели слоев. Конечно, логично 
располагать их рядом группой, но на практике на организацию слоев не 
всегда есть время. В итоге разные слои находятся далеко друг от друга, они 
связаны, и вам приходится искать каждый их них, либо чтобы развязать их, 
либо чтобы передвинуть. В поиске слоев может помочь инструмент Move 
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Tool. Клик по слою на рабочей области нажав CTRL и вы выделяете слой на 
панели слоев. 

Проблема этого метода в том, что вам придется идентифицировать все 
слои, кликая по ним Move Tool. А ведь их может быть 4, 10, 20. Более 
быстрый способ организовать прилинкованные слои команда – Layer > Select 
Linked Layer. 

Как создать слой в Фотошоп 
Нет ничего проще. Быстрая команда создания слоя – иконка чистого 

листа в нижней части панели слоев. Не быстрая команда – Layer > New Layer 
> Layer или Ctrl+Shift+N Выбирая иконку, вы создаете слой на лету. Выбирая 
команду из меню, вы попадаете в окно настроек слой Layer Properties. В 
выпадающем окне Color можно задать цвет отображения слоя. Это удобно, 
если вы делаете сайт, и вам хочется визуально разделить слои по цвету.  

Как сгруппировать слои? 
Слоев порой так много, что их нужно как то сгруппировать. Если вы 

рисуете дизайн сайта, элементы могут исчисляться сотнями. То же самое со 
сложным постером или обложкой. Чтобы сгруппировать слои, выделите 
нужные слои на панели Layers и нажмите CTRL+G. В любой векторной 
программе этот шорткат группирует объекты в один блок. В Фотошопе этот 
шорткат создает специальную папку и складывает все слои в него. Пустую 
папку можно создать и из панели слоев. Для этого нужно кликнуть по иконке 
папки. А слои перетащить в неё вручную. Чтобы разгруппировать слои 
нажмите CTRL+SHIFT+G или Layer > Ungroup Layers. При удалении группы 
Фотошоп интересуется, что именно нужно удалить? Группу и содержание 
или только Группу? Ну и, конечно, ALT + клик по иконке группы вызывает 
диалоговое окно группы, которое врядли вам когда-либо понадобится. 

Навигация слоев в Фотошоп 
Порой количество слоев просто огромное. Прокручивать панель слоев 

вверх и вниз слишком утомительно. Найти две окружности, конечно, не 
сложно. А если их 100? Или 200? В такой ситуации вам нужен оперативный 
инструмент, который помогал бы находить нужный слой, при помощи клика, 
по самому объекту на рабочей области. И такой инструмент есть – Move 
Tool. Чтобы выбрать нужный слой, кликните по окружности зажав CTRL.  

Основы комбинирования изображений. Приемы реалистичного 
наложения рисунка на объект. Режимы смешивания слоев.  

Режимы наложения (Blending mode) 
Режимы наложения в Фотошопе, на первый взгляд, не простая тема. В 

действительности нет ничего проще чем режимы наложения. И вы убедитесь 
в этом сами. Режимы наложения раскиданы по всей программе. Они 
находятся на панелях настроек инструментов, они находятся в слоях, они 
находятся в стилях. Мы поговорим о режимах наложения в панели слоев 
Layers, хотя роль режимов одинаковая, где бы они не находились.  
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Каждый из режимов создавался под свою индивидуальную ситуацию. 
Нельзя применить их все к одной и той же фотографии, и сделать выводы, 
что вот эта пара режимов хороши, а остальное лучше не использовать 

никогда. 
 

В реальности, вам не 
нужно понимать весь 
список из 25 режимов. 
Достаточно понимать 
всего три из них. 

Все верно, три 
режима наложения и вы 
превращаетесь в 
маститого по режимам 
наложений. Более 
никогда вы не 
перещелкиваете все 25 
режимов подряд, так 
как теперь, вы точно 
знаете какой эффект 
хотите получить и чего 
добиться.  

И эти три режима 
наложения: Умножение-
Multiply, Осветление- 
Screen и Перекрытие-
Overlay. 

Как работают 
режимы наложения? 

Достаточно одного взгляда на меню с режимами наложений чтобы понять 
– они располагаются не хаотично. Все режимы Blending mode 
сгруппированы. Мы разберем 3 самые обширные группы этих режимов. 
Группы затемнения, осветления и контраста. В каждой группе есть свой 
приоритетный режим. В группе затемнения это Multiply, в группе осветления 
это Screen, в группе контраста Overlay. Все остальные режимы в каждой 
группе являются лишь разновидностями и вариациями этих трех. Поэтому 
поняв как устроены Multiply, Screen и Overlay вы сразу поймете 17 из 25 
режимов наложения. 

При смешивании слоев Фотошоп руководствуется тоном слоя Hue и 
степенью светлоты слоя Lightnes.  

Режим наложения Multiply 
Режим Multiply является режимом затемнения. Когда мы присваиваем 

слою режим Multiply, Фотошоп анализирует слой, находящийся ниже и 
убивает все светлые участки слоя с Multiply. Белые участки пропадают 
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совсем. Светло-серые становятся полупрозрачными. А черные остаются. В 
режиме Multiply темные пиксели всегда выигрывают. Этот режим 
используют для реалистичного наложения узора или текстуры на объект. 

Режим наложения Screen 
Screen действует противоположно режиму Multiply. На этот раз 

выигрывают светлые пиксели. Светлые области остаются, слегка светлые 
усиливаются, темные уходят.Остальные режимы наложения в группе 
осветления работают точно так. Вариации иные, принцип тот же. Черные 
пиксели уходят, белые остаются и усиливают свое значение. Им, к примеру, 
подсвечивают текст в рекламе. 

Режим наложения Overlay. 
В отличие от режимов затемнения и осветления Multiply и Screen, Overlay 

является режимом контраста. Что это значит? Это значит что Overlay убивает 
близкие к 50% Grey пиксели, оставляя только ярко выраженные темные и 
ярко выраженные светлые. Эти области он накладывает на изображение 
усиливая контрастность картинки. Остальные режимы наложения из группы 
контраста работают точно так же, с небольшими вариациями. Несомненно 
этот режим стоит использовать в тех случаях, когда мы хотим повысить 
контрастность изображения + получить некоторые интересные 
взаимодействия.  

Задание 2: поместить рыбку в лампу 
1. Создаем новый документ.  

 
1. Загружаем картинки в Adobe Photoshop (метод «перетаскивания» в 

программу); 
2. Далее - выбираем изображение лампочки и выделяем его инструментом 

«Быстрое выделение». (смотрим на скриншоте.) 
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Не забываем создать копию слоя нажав клавиши Ctrl+ J 

 
3. Теперь выделяем пространство около лампочки. У вас должно 

получиться вот так: 
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Нажимаем Delete. 
Переносим лампочку в наш документ. Нажимаем Ctrl+T и уменьшаем 

размер с зажатой клавишей SHIFT (для фиксации пропорций). 

 
Инструментом «Ластик» стираем внутреннюю часть лампочки.  

 
Настраиваем «ластик» так как на скриншоте.  
В итоге получается так: 

 
Выбираем картинку воды. И удаляем фон точно так же как и в картинке 

«Лампочка» 
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И переносим в наше изображение. Уменьшаем. 

 
Далее выбираем режим наложения «Multiply» 

 
Изображение за границами лампочки аккуратно затираем ластиком. 

 
Добавляем рыбку. 
Так как формат изображения GIF мы не можем просто выделить рыбку 

перенести ее. Мы делаем копию слоя, нажимаем команду Ctrl+A 
Берем инструмент перемещение и тащим в нашу работу. Режим 

наложения не меняем.  
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Для создания иллюзии реальности предметы мы нарисуем тень от 
лампочки и линию горизонта. 

Для содланий линии горризонта мы пользуемся прямоугольным 

выделением. Полученный  
прямоугольниу заливаем черным цветом.  И размываем через фильтр 

размытие/ размытие по Гаусу. Filter\Blur\ Gausan Blur. 
Теперь создаем собственную тень от лампочки.  

 
Копируем слой с лампочкой и трансформируем командой Ctrl+T. Тянем 

за середину вниз. Как будто тень лежит на плоскости.   
Меняем режим наложения: 
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Задание 3: используя технику работы со слоями, команды трансформации 

и режимы смешивания слоев, оформить посылку. 

 
 

 
 

Тема 3. Цифровая фотография. Ретушь и реставрация. Тоновая и 
цветовая коррекция изображений.  

Лабораторная работа 5 
Ретушь 

Необходимо сделать свою кожу матовой и гладкой, как у моделей на 
обложках глянцевых журналов. 

Шаг 1. Откройте изображение в Фотошопе, дублируйте его. 
Удалите все неровности на коже с помощью 

Лечащей/Восстанавливающей кисти .  
Шаг 2. Как только вы закончите работу с инструментом , дублируйте 

слой еще раз и примените к нему Фильтр - Шум - Пыль и царапины (Filter > 
Noise > Dust & Scratches) 

Для своего примера используем такие настройки:  
радиус 5 px и порог 0. Но знайте, что настройки зависят от качества 
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фотографии. В результате мы должны получить мягкое размытие 
изображения, примерно так: 

 

Шаг 3 
Следующий фильтр, который мы будем использовать, Размытие по 

Гауссу (Filter > Blur > Gaussion Blur). И снова настройки на ваше усмотрение, 
у меня радиус = 2. 

 

Шаг 4. И финальный шаг в создании новой матовой кожи - это 
добавление еще одного фильтра Шум - Добавить шум (Filter > Noise > Add 
Noise). Мы все прекрасно знаем, что человеческая кожа не может быть 
идеально гладкой. Благодаря этому фильтру кожа примет нужную текстуру и 
будет смотреться более реалистично. Я использовала монохромный шум в 
количестве 0.7%. 

 

Шаг 5. Новая кожа для модели готова! 
Внизу палитры слоев нажмите на кнопку Добавить маску слоя (Add a 

layer mask). Рядом со слоем появится белый квадратик. 
Возьмите , установите черный цвет и кликните по документу.  

Если не получается, то убедитесь что в качестве основного цвета стоит 
черный, затем нажмите Alt+Backspace. Что произойдет? "Мутный" слой 
спрячется, а нижний "четкий" появится. 
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Шаг 6. А вот теперь начинается самая интересная часть! Сейчас мы будем 
накладывать на модель идеально гладкую кожу. Чтобы все сделать 
правильно, послушайте следующие рекомендации: возьмите инструмент 
Кисть, убедитесь, что выбран именно белый цвет. Установите жесткость 
кисти на 0. Вы можете также уменьшить ей прозрачность. (Будет лучше, если 
вы в процессе будете возвращаться к настройкам и корректировать их по 
мере необходимости). Итак, мы находимся на маске слоя.  

Ваша задача – красить белой кистью в тех местах, где кожу нужно 
обновить, но не затрагивать глаза, брови, губы, волосы, чтобы они не 
потеряли свою резкость.Если вы случайно закрасили лишнего, то 
переключитесь на черную кисть и все исправьте. 

Палитра слоев: 
 

Шаг 7 
Кожа у девушки приятного цвета, поэтому никаких цветовых настроек 

применять не будем.  
Но если у вас другая ситуация, то помните, что есть такие параметры, как 

Цветовой тон/насыщенность, фотофильтр, цветовой баланс, которые всегда 
будут рады вам помочь. 

Шаг 8 
А теперь мы добавим немного резкости нашему изображению. 
Дублируйте средний слой, у меня называется "леч кисть". Измените ему 

режим смешивания на Перекрытие (Overlay).  
Примените Фильтр - Другие - Цветовой Контраст (Filter > Other > High Pass) 

Установите значение радиуса по своему вкусу, помните, что всегда этому 
слою можно уменьшить прозрачность 
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Если вы хотите добавить еще больше шика, то следуем дальше. 
Шаг 9. 
Слейте все слои, кроме последнего (чтобы самим было интересно 

посмотреть, как было и как стало) 
Дублируем верхний слой, режим наложения меняем на Перекрытие 

(Overlay). Добавляем фильтр Размытие по Гауссу. 
Добавим маску слоя и уберем черной кистью размытость с волос, чтобы 

оставить их блеск. Немножко добавим резкости. Применяем Фильтр - 
резкость - Контурная резкость (Sharp - Unsharp mask) 2 раза. Самое любимое 
- это итоговое сравнение: 

 
 

 
 

Лабораторная работа 6. 
Маска для ретуши.   

Данный урок покажет нам как обычному портрету придать вид портрета 
из глянцевого журнала. А так же здесь будет показана техника ретуши, что 

даст вам большую точность и контроль за действиями. 
Некоторые шаги в этом уроке сложны для новичков, но если вы поймете 

принципы, особенно принципы работы новых слоев для применения каждого 
отдельного эффекта и смысл работы маски при ретуши, то ваша работа 
перейдет в совершенно новое качество. 

Этот урок даст вам основы ретуши. Это подразумевает, что вы 
используете эти навыки, расширите их - добавите ваше собственное 
мастерство, видение и цели. Есть множество способов сделать ретушь в 
Photoshop и этот урок покажет только один способ как придать гламурный 
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вид портрету и подтолкнет вас к мысли, что лучше для вас и для вашей 
работы. 

Наш процесс состоит из 5 шагов: 1. регулировка цвета и коррекция 
яркости. 2. ретушь дефектов кожи и других пятен. 3. добавление гладкости 
кожи. 4. добавление теней. 5. добавление шума или текстуры кожи.  

Здесь несколько образцов. Заметьте как вы можете контролировать 
степень и силу ретуширования, подбирая под свой вкус и надобности. 

         
 
 Шаг 1.  
Сначала ВСЕГДА делайте копию слоя для работы и сохраняйте оригинал 

фото на самом нижнем слое. Это сохранит ваш оригинал от необратимых 
изменений.  

Итак, продублируйте слой. 
Есть три способа это сделать. 
Первый - Menu> Layer> Duplicate Layer. Второй – используйте сочетание 

клавиш Ctrl+J (Option+J). И, наконец, вы можете сделать копию слоя, 
перетащив иконку слоя на кнопку "New Layer Button" в низу палитры слоев. 

В данном случае  мы имеем плохоотсканированный снимок с пленки. 
Кадр выглядит желтым и безжизненным. Поэтому нам понадобится Цветовая 
коррекция. 

  Сделайте первую коррекцию с помощью команды Сolor Balance 
(Ctrl+B). Подтяните ползунки так, как показано на рисунке:
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Это может показаться нудным, но каждое последующее действие мы 
будем производить на отдельном слое и, исходя из манипуляций, давать 
слою название. Позже это даст вам возможность быть более креативными и в 
финале подкорректировать все параметры по вашему вкусу. 

 Следующую коррекцию совершаем  с помощью уровней Levels (Ctrl+L) 
на новом, третьем слое. Назовите слой "Level Corrections". 

Используя инструменты Levels (Ctrl+L) и Curves (Ctrl+M) мы можем 
изменить в целом яркость, темные и средние тона.  

Выберите Menu> Image> Adjustments> Curves (Ctrl+M). Инструмент 
Curves используется обычно, когда нужно повысить средний тональный 
диапазон (гамма) изображения и сделать его ярче. Кликните в центре кривой 
и потяните центр  вправо или влево, что бы убрать тусклость и излишнюю 
затемненность или яркость. Нам нужны чистые средние тона изображения. 

 
(рис. Сдвиньте кривую таким образом, чтобы придать картинке больше 

яркости) 
Коррекция с помощью инструмента Curves.(Ctrl+M) 
Коррекция Curves – потяните за центр кривой и отрегулируйте тон 

изображения. 
Коррекция с помощью Levels 
Двигайте левый (черный) ползунок ближе к краю гистограммы, что бы 

откорректировать черные тона в изображении. Затем двигайте правый 
(белый) ползунок к краю гистограммы, что бы увеличить общую яркость 
картинки в области светов. Используйте серый (средний) ползунок для 
коррекции средних тонов. Вам нужно получить чистые и точные тона 
картинки. Это хорошо, если у вас будет немного чистого белого цвета в 
изображении, немного черного и широкий диапазон средних тонов. 
Экспериментируйте! 
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(рис. Сдвиньте крайние ползунки гистограммы, отрегулируйте средние 

тона изображения) 
: если вы никогда не использовали калибратор для настройки яркости и 

цветности вашего монитора, то вы можете получить непредсказуемый 
результат при печати ваших изображений. Картинки на мониторе чаще всего 
выглядят светлее либо темнее. Так что желательно иметь откалиброванный 
монитор для работы с изображениями. 

Итак, наше изображение как следует отрегулировано при помощи Levels 
– белая и черная точки, широкий диапазон средних тонов…. Мы подготовили 
изображение для второго шага. Будем избавляться от пятнышек и морщин. 

Шаг 2. Ретушь пятнышек. 
Все мы с вами несовершенны и часто, листая глянцевые журналы 

(больше, конечно, девушки), кусаем губы от зависти и желания иметь такую 
же гладкую и идеальную кожу. Нужно сказать, что модель, талантливый 
фотограф и профессиональный визажист могут вместе создать оригинальный 
образ. Большинство из нас хотело бы выглядеть как такая модель. Этот урок 
и дает нам общие принципы как сделать подобный образ, близкий к 
журнальному. Чем лучше оригинал, тем лучше результат! 

Итак, давайте начнем справляться с недостатками. Мы должны убрать все 
пятна, если они не существенны. Мы будем делать ретушь это на одном или 
двух отдельных слоях для полного контроля.  

Создайте новый чистый слой над слоем с Levels (зайдите в палитру слоев 
Layer>New>Layer или нажмите внизу палитры слоев Add New Layer 
(Shift+Ctrl N ). Назовите этот слой «прыщики-морщинки». Дважды кликните 
на слое и переименуйте его.  

Если вы хотите получить чересчур гладкую кожу, вы можете создать 
второй корректирующий слой. На этом втором слое вы будете устранять 
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значительные морщины вокруг носа, рта, под глазами и вокруг подбородка и 
шеи.  

Первый слой - для коррекции маленьких пятнышек (прыщики, цветные 
пятнышки, морщинки…). Второй слой – для коррекции более сложных 
вещей. После ретуши лицо может выглядеть слегка не натурально, но у нас 
есть возможность смешать отредактированный и неотредактированный слои 
для более полного контроля за результатом. Поэтому каждый шаг лучше 
делать на отдельном слое. Это дает нам возможность, играя opacity 
(прозрачностью) или работая с маской, достигать более гибкого результата.  

Если вас не устроил результат работы, вы можете спокойно удалить слой 
и начать снова.  

Новый инструмент CS2 Spot Healing Brush просто превосходен для 
ретуши. Одно прикосновение кисти к пятну и оно автоматически исчезает 
без необходимости использовать образец или еще какую-либо коррекцию! 
Это самый быстрый инструмент для удаления пятен. Если вы слишком 
размазываете изображение, можно откорректировать размер кисти, ее 
жесткость. Единственное, о чем вы должны помнить – делайте кисть слегка 
больше, чем корректируемое пятно. Используйте клавиши [ ] ,чтобы 
изменить размер и Shift, чтобы изменить жесткость кисти. Также можно 
использовать обычную CS Healing Brush, где вам нужно использовать 
образец области с нажатой клавишей Alt. Иногда при коррекции темных 
областей или текстуры лучше использовать инструмент Patch. И конечно же 
Clone Stamp Tool. Здесь вы также используете клавишу Alt, но клонируемый 
образец ложится поверх, не смешиваясь с нижним слоем текстуры как в Spot 
Healing Brush и Healing Brush. Мне также известно, что можно использовать 
обычную кисть. Для этого берем образец цвета кожи с помощью клавиши Alt 
и затем просто рисуем. Иногда это помогает настроить "brush blend mode" 
таким образом, что происходит замена только цветовой информации.  

(Два замечания: будьте уверены, что вы работаете на новом слое. Будьте 
уверены, что в окошке the "Sample All Layers" в палитре options стоит 
чекбокс и выбран слой на котором вы собираетесь производить ретушь. Чаще 
всего я использую при ретуши значение opacity для кисти не более 20%. Это 
позволяет мне положить много прозрачных слоев и наращивать их 
постепенно, чтобы добиться гладкости. 100% opacity вашей кисти даст 
эффект жесткости и ненужную резкость.) 

Не забываем о морщинках в области шеи: 
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Когда вы закончите ретушь/ ваш новый Blemish Remove Layer должен 

выглядеть таким образом: 
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Иногда у вас возникает желание остановится на этом шаге. Levels 

откорректированы, пятнышки убраны – может это и все, что нужно вашей 
фотографии. Вы можете объединить ваши слои и закончить работу.  

Если вы перестарались с коррекцией, вы можете отрегулировать 
ползунок opacity в Layers Palette, чтобы уменьшить эффект и слегка вернутся 
к оригиналу. Сольно вы будете корректировать фото или нет – это на ваше 
усмотрение. Вы также можете использовать маску, но об этом чуть позже.  

Мы получили хорошую основу для дальнейшей работы. Что нам еще 
нужно …. Безупречную кожу. 

Шаг 3. Безупречная кожа.  
На изображениях, которые мы получаем после ретуши, часто есть 

цветные пятнышки на коже, неровности или резкие переходы, которые 
нуждаются в сглаживании. В прошлом вы должны были бы корректировать 
каналы, использовать фильтр gaussian blur или работать кистью, что бы 
сгладить эти погрешности. Теперь в новом Photoshop CS2 есть фильтр 
Surface Blur.  

Surface Blur Filter может дат вам великолепную базу для макияжа. Фильтр 
исследует пиксели со всего лица и аккуратно смешивает их вместе, что дает 
чудный результат и совершенно гладкую кожу. Все прекрасно выглядящие 
модели сегодня имеют одну общую особенность – в основе безупречный 
макияж. Без него будет проблематично создать новый вид.  

С новым фильтром CS2 Surface Blur мы сможем добиться всех этих 
улучшений за минуту. Главное здесь – понять, каким образом выбрать 
правильные значения и как не перестараться. Этот фильтр хорош для работы 
с портретами, фотографиями хрома и металла и со всякими фото, где есть 
большие гладкие поверхности. 

Итак, создаем новый слой с нашим портретом, содержащий все 
внесенные исправления. Лучше создать два идентичных слоя для максимума 
контроля. Один слой – это картинка со всеми изменениями. Он станет новой 
основой для нашей коррекции. Ко второму слою мы применим эффект 
Surface Blur. 

Существует короткий способ как это сделать. Нам нужно копировать все 
активные нижние слои и сделать новый композитный слой. Но, без удаления 
всех предыдущих слоев! Так же как мы делаем snapshot слой. И не удаляйте, 
не объединяйте какие-либо слои в процессе! Мы должны быть уверены, что в 
случае необходимости сможем использовать уже существующие слои.  
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Маленький трюк! Удерживайте на PC одновременно клавиши Shift, Ctrl и 
Alt и затем нажмите клавиши N и E. Вы получите объединенную копию всех 
активных слоев и одновременно оставите все слои нетронутыми.  

Сделайте два композитных слоя. Первый слой назовите "композит слой". 
Второй назовите "Surface Blur", поскольку на нем мы и будем применять 
фильтр. Порядок слоев посмотрите на рисунке ниже. 

 
 
(рис. Нажмите Shift+Ctrl+Alt+N ,чтобы создать новый слой. Продолжайте 

удерживать Shift+Ctrl+Alt+Е для создания копии всех нижних слоев и 
расположения их на новом слое) 

Выберите верхний слой и примените фильтр Filter>Blur>Surface Blur. 
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Фильтр исследует всю поверхность лица и интегрирует цвета , чтобы 

получить смешанный цветовой слой, который вы можете смешать с 
оригиналом для получения более реалистичной картинки. Позже мы добавим 
маску слоя для более полного контроля за результатом. 

Важно правильно применять данный фильтр для получения нашего 
результата. Нужно установить значения радиуса и threshold так , чтобы в 
результате мы получили мягкий и гладкий тон кожи. Вы можете выбрать 
большее или меньшее значение , это на ваш вкус. На рисунках ниже можете 
посмотреть, что может получиться. 

 

 
(рис. Кожа еще не совсем гладкая. Недостаточная степень применения 

фильтра) 
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(рис. Фото стало как в тумане. Слишком много фильтра) 
 

 
(рис. Кожа достаточно гладкая. Правильно применили фильтр) 
Ориентируйтесь на последний рисунок – это и есть результат 

правильного применения фильтра. Гладкая кожа и тонкий теневой переход от 
светов к теням. Передвигая ползунки, вы можете получить широкий 
диапазон тонов. Желательно отслеживать темные тона на щеках, чтобы не 
потерять их для наших дальнейших манипуляций. 

На данном этапе мы получили слишком сильный эффект. Для его 
смягчения мы применим технику, позволяющую контролировать силу 
применения эффекта. Мы добавим теней и затем добавим текстуры кожи для 
более естественного вида модели. 

Итак, у нас прекрасное изображение, без изъянов, с отличным макияжем 
и безупречной кожей. Скорее слишком совершенное! Позже мы смягчим 
эффект. 
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А сейчас очень важный момент!!! Создание маски для ретуши, которая 
позволит нам применить какой-либо эффект с большой точностью и 
возможностью восстановления. 

Специальная техника – маска слоя – маска для ретуши. 
По моему мнению, это очень важный момент в ретуши. Если вы освоите 

эту технику, то это позволит вам вносить любой вид коррекции и 
контролировать его применение, силу и точность. С практикой вы сможете 
рисовать поверх цветовой коррекции, текстур, светов, волос, губ, поверх 
контрастных изменений, на ресницах или даже на драгоценностях вашей 
модели не оставляя следов.  

Основная концепция: техника, которую я использую здесь называется 
"black mask" или техника скрывающей маски. Она включает один или два 
слоя и позволяет рисовать по верхнему слою или смешивать его с нижним с 
большой мягкостью и точностью.  

Обычно, если у вас есть нижний слой,  вы располагаете еще слой над ним, 
верхний слой перекрывает нижний. Что мы будем делать, чтобы изменить 
такое положение вещей? Мы просто добавим маску для верхнего слоя. Маска 
перекроет верхнее изображение на короткое время, там, где мы начнем 
рисовать белой кистью, изображение снова будет проявляться. Итак, если у 
вас есть текстура, размытие или оттенок на верхнем слое – вы можете взять 
мягкую белую кисть с низкой степенью opacity и рисовать, внося коррективы 
в нижний слой на том месте, где вам это необходимо. Это позволит вам 
контролировать весь процесс внесения корректив. 

Еще одна хитрость данного метода – если вам не понравился результат 
коррекции, просто измените цвет кисти на черный и сотрите ненужную 
коррекцию. Итак, белая кисть вносит изменения в рисунок, а черная – 
скрывает их. Даже если вы используете мягкую кисть с низкой степенью 
opacity (от 14% до 30%) вы заметите явные и резкие коррекционные линии. И 
только с практикой ваша ретушь будет выглядеть гладкой и незаметной.  

После того как вы создали два идентичных слоя (хотя это не обязательно, 
но я настаиваю на этом), добавьте маску слоя для ретуши на верхний слой (в 
нашем случае это слой surface blur). Пусть это будет эффект surface blur, 
выборочное придание резкости или цветовая коррекция – это не важно. Вы 
получили достаточно сильный эффект от применения фильтра к верхнему 
слою, начните выборочно рисовать на маске, как в следующем шаге. 
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(рис. Наверху – слой с фильтром и черной маской слоя.) 
Для того чтобы создать маску нажмите Layer>Layer Mask>Hide All. 

 
Так же вы можете использовать более короткий путь – нажать значок 

внизу палитры слоев. Если вы хотите получить специальную маску черного 
цвета, удерживайте клавишу Alt (Option) при нажатии иконки маски. Рядом с 
иконкой слоя должно появиться окошко черного цвета – это и есть наша 
маска. Для того чтобы начать работать с маской, кликните по иконке маски. 

Маска должна быть выделена, затем выберите белую кисть и уменьшите 
opacity с 6% до 14% или 30% (на ваш выбор). Затем рисовать на слое. 
Постепенно должно начать проявляться размытие. Пройдитесь несколько раз 
кистью по необходимой вам области, что бы усилить эффект. Обработайте 
щеки и лоб. Не усердствуйте в тех местах, где были морщины, иначе можете 
вернуть их обратно! Все это на ваше усмотрение. 
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После обработки маски слоя ваше изображение должно выглядеть 

примерно так. Область закрашенная белым цветом – это то, что вы 
обработали и сильно проявили эффект. Серая область – средняя степень 
обработки фото. Черная область – там, где фото осталось оригинальным, без 
обработки. 

 
Шаг 4. Добавление легких световых пятен и мягких теней. 
Внешний вид гламурных моделей в журналах имеет характерную 

гладкую кожу, но также – резкие светлые, темные и другие оттенки. Сейчас 
мы добавим очень мягкие и нежные светлые пятна и слегка сексуальные 
тени. 

Есть два способа как это сделать. 
Первый способ – создать новый слой, залить его 50% серым цветом , 

сменить режим смешивания на Overlay и рисовать белой и черной кистью с 
низкой степенью opacity. Это превосходная техника может быть 
использована после всех основных действий по ретуши. Обычно она 
используется, когда нужно вместе откорректировать яркость и темные 
участки изображения. Прелесть этой техники в том, что вы можете всегда 
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исправить результат коррекции. Для этого мы создадим два дополнительных 
слоя. Один будет использован для мягкого затемнения, другой – для 
осветления.  

Создание светлых бликов.  
Обычно сначала я делаю коррекционный слой для бликов. Это придает 

портрету восхитительное освещение и так как этот эффект расположен на 
отдельном самостоятельном слое, то его можно редактировать.  

Итак, добавьте два прозрачных слоя поверх уже существующих. Назовите 
один слой «Highlights», а другой «Shadows». Если есть необходимость 
можете сделать композитный слой ( Shift,Ctrl,Alt N и E).  

Начните работать жесткой кистью, обязательно белой. Смените режим 
смешивания слоя на "soft light". Обычно я добавляю несколько белых 
штрихов ниже глаз, по центру носа, на лбу и на подбородке. 

 
Вы можете видеть на рисунке применение эффекта во всей силе. 

Примените к слою фильтр Gaussian Blur ,что бы размыть границы светлых 
пятен. Это один из приемов добиться гладкой кожи. Отрегулируйте значение 
фильтра по вашему усмотрению. 

   
(рис. Слева направо – мало применен фильтр Gaussian Blur , достаточно, 

слишком много) 
Итак, наша цель – размыть резкие белые пятна, что бы получить 

шелковый блеск. Сначала отредактируйте слой со светлыми пятнами, затем 
вы можете подкорректировать интенсивность светов, регулируя opacity слоя. 
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Но не перестарайтесь, так слишком светлые блики будут слишком 
отвлекающими. Световые блики дадут нам ощущение внутреннего свечения. 

 Вы также можете рисовать этими светлыми пятнами везде, где вам 
необходимо подчеркнуть форму, например, на руках, ногах или челюсти. Но 
это все на ваше усмотрение. Мягкие, светлые блики вместе с тенями, которые 
мы создадим в следующем шаге, придадут сексуальности, драматизма, 
контрастности и слегка скульптурный вид. Таким образом, у вас будет 
полный контроль за всеми областями со светлыми бликами. Сохраняйте эти 
слои отдельно и называйте их таким образом, что бы позже вы могли 
свободно играть этими слоями, смешивать их различным образом. 

Создание теней.  
На этом шаге мы будем создавать ровные тени для нашего изображения. 

Еще одной характерной чертой гламурного портрета являются ровные тени. 
Мы и будем рисовать область теней точно так же, как мы создавали светлые 
блики. 

Сначала мы создадим новый прозрачный слой над оригиналом 
изображения и назовем его "shadow". Режим смешивания установите "soft 
light". 

А теперь приступим к рисованию теней. Возьмите жесткую кисть, 
среднего размера с 100% opacity и начните рисовать на щеках, в местах, где 
обычно наноситься румянец. Итак , мы имеем два четких , кошмарно 
выглядящих черных или коричневых пятна на щеках. Сейчас откройте 
фильтр Gaussian Blur и откорректируйте слой таким образом , чтобы эти 
кошмарные пятна стали гладкими и ровными.  

Вы можете оставить тени более жесткими, если у вас есть необходимость 
сделать макияж более сильным. Регулируйте opacity слоя, чтобы 
откорректировать интенсивность теней. 15 – 30 % opacity обычно достаточно. 
Насколько темными будут ваши тени – это на ваш вкус.  

 
 
(рис. Нарисуйте на новом слое темные пятна на щеках, затем смените 

режим смешивания на Soft Light). 
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Посмотрите на рисунки, где показаны три степени – «слишком много, 
норма, недостаточно». В случае с тенями применение фильтра Gaussian Blur 
не дает все-таки нужного нам мягкого результата. Поэтому мы и регулируем 
opacity слоя. Но это все на ваш художественный вкус. 

 
 
(рис. Слева направо – фильтр Gaussian Blur применен мало, достаточно, 

слишком много) 
Находите баланс между сильной степенью применения эффекта и его 

мягкостью. Если вы используете различные слои, у вас есть возможность 
смягчать их и смешивать с другими слоями.  

Иногда вам нужно будет обработать и другие области. Это зависит от 
вашего изображения. Создайте отдельный слой для каждого эффекта, 
назовите его соответствующим образом и у вас будет полный контроль над 
вашим результатом. 

Добавьте тени на область носа, подбородка, тени под глазами, чтобы эти 
области  не выглядели плоскими. 

Итак, повторяем - чтобы создать тени нам нужно нарисовать темную 
область, затем размыть, поменять режим смешивания и отрегулировать 
opacity слоя. Другие различные области, нуждающиеся в наложении мягких 
тонов – это переносица, линия подбородка, глазницы, область лба.  

Также эта методика хороша для ретуши области плеч, рук и ног, чтобы 
придать этим областям красивую округлость тела и гламурный тон. Если вы 
обладаете художественными навыками и имеете терпение, вы можете создать 
большое количество таких свето-теневых областей. Вы можете передвигать, 
менять масштаб и выборочно стирать часть этих слоев. Особенно я люблю 
использовать эти слои снова после окончательной обработки изображения. 
Так как режим смешивания для слоев установлен soft light, то они прекрасно 
сочетаются, где бы эти слои не располагались. 

Дополнительно можно взять эти свето-теневые слои и использовать 
hue/saturation/brightness для коррекции цвета. Итак, у нас есть ретушь 
недостатков кожи, с возможностью ее коррекции, ровная, гладкая кожа, тени, 
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светлые блики на ваш вкус. Некоторые любят более натуральный вид, 
некоторым нравится более гламурный. Все – на ваш выбор! 

Сейчас нам нужно добавить чуть текстуры или шума в изображение, что 
бы добавить реализма.  

Шаг 5. добавление текстуры для придания реализма изображению. 
Еще один характерный элемент для журналов, кроме гладкости и 

ровности кожи, это отличная текстура кожи и поры. Что и говорить, модель, 
прекрасно освещенная при фотосессии, покрытая достаточным слоем 
макияжа, проводит не один час для достижения такого шикарного 
результата. Но, не будьте наивными – никто не обладает такой совершенной 
кожей (если только детки ). Именно поэтому все они и нуждаются в нас, 
невоспетых героях – мастерах ретуши! Это прекрасно иметь отличный 
оригинал для работы, но большинство из нас, простых людей с самыми 
обычными фотографиями! 

Действия, которые дадут нам возможность вернуть текстуру кожи и поры 
(после предыдущей обработки): 

- вы можете смешать отретушированное изображение с оригиналом и 
дать возможность проявиться морщинкам и текстуре; 

- вы можете создать текстурную маску, используя собственную 
оригинальную кожу модели и выборочно рисовать этой текстурой по 
изображению; 

- вы можете взять из другого изображения и создать шаблон 
превосходной кожи с порами и затем применить эту текстуру к 
изображению, с которым работаете; 

- вы можете приобрести полный набор текстур кож с 3D сайта; 
- вы можете использовать любой из 7 фильтров (noise, grain, или texture), 

что бы придать гламурный или художественный вид вашему изображению. 
Итак, возвращаем оригинальную текстуру кожи. Я добавляю здесь 

короткий раздел, поясняющий как нам вернуть оригинальную текстуру в 
обработанное изображение. Ранее мы создали несколько слоев – 
корректирующий яркость, ретушь пятен, придание кожи эффекта гладкости и 
затем вернули свето-теневые переходы. В итоге наше изображение выглядит 
просто превосходно, но некоторые люди хотят получить как бы 
неотретушированное изображение, очень естественно выглядящее. 
Запомните - ретушь должна быть незаметной!!! 

У нас есть один простой выход – смешать оригинал с обработанным 
изображением, используя настройку opacity слоя. Каким образом мы это 
сделаем? Расположите отретушированное изображение поверх оригинала. 
Затем, используя ползунок opacity слоя сделайте обработанное изображение 
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слегка прозрачным. Оригинал со всеми морщинками начнет просвечивать 
сквозь слой, в этот момент вы получите смесь отретушированного 
изображения и оригинала. Выберите, какой степени реализма вы хотите 
добиться. Это достаточно просто.  

 
Приступим к следующему уровню. Есть один, действительно, 

превосходный способ вернуть текстуру кожи лица – это использование маски 
для проявления части обработанного изображения именно в тех местах, где 
для этого есть необходимость. Вы можете обработать щеки и область лба 
более сильно, но вам придется оставить мимические морщинки в области рта 
и глаз. Для большего реализма! Для этого нам не обязательно явно 
прорисовывать все морщины. Иногда достаточно 1/2 или 1/3 степени 
интенсивности, чтобы получить мягкий естественный вид морщинок. 
Однако, должна сказать, что не все фотографии обрабатываются подобным 
образом. Например, фото пожилых людей нуждаются в более характерных 
линиях и в сохранении большего количества морщин, чем двадцатилетние 
девушки и юноши. 

Другие эффекты создаваемые при помощи собственных текстур 
Photoshop и фильтра Grain. 

Итак, у вас есть фото, которым вы уже довольны. Но вы можете добавить 
зернистости, текстуры или других эффектор программы Photoshop для 
значительного улучшения внешнего вида модели. В программе нет именно 
текстуры пор кожи, но есть другие фильтры – шум, зернистость. Именно их 
применение вы часто и можете наблюдать в современных глянцевых 
журналах. Здесь мы рассмотрим 7 типов текстур, которые используются 
наиболее часто. 

• Фильтр noise. Фильтр находится в меню Filter> Noise> Add Noise. 
Внимательно смотрите на превью, где виден результат применения фильтра. 
Лучше применять монохромный шум, а не цветной. Однако, это на ваше 
усмотрение. Добавьте шум в ваше изображение ,можно даже усилить эффект, 
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т.к. позже вы можете отрегулировать степень интенсивности с помощью 
opacity или маски. Такой эффект очень популярен и вы можете увидеть его 
почти во всех модных публикациях. 

Прежде всего создайте композитный слой и расположите его наверху. 
Затем сделайте дубликат слоя. Вы можете сделать тест на верхнем 
изображении и затем используя маску ретуши выборочно проявить шум. 
Возьмите для этого кисть где-то 15% opacity. Дайте резкости верхнему 
изображению, затем проявите этот эффект только под глазами. Это их 
выделит. Почему придавая резкость всему изображению мы только 
проявляем его у глаз, можете этого не делать. Расположите ваш оригинал 
внизу палитры слоев, а откорректированное изображение наверх. Затем 
начните рисовать сквозь нижнее изображение, используя белую маску и 
белое перо.  

Используя подобную технику двух слоев (с применением маски для 
контроля за результатом) вы добьетесь наиболее креативных и 
художественных результатов.  

•Conte Crayon texture. Находится в Menu> Filter> Sketch> Conte Crayon. 
Применение этого эффекта даст вам черно-белую карту, которую вы можете 
корректировать много раз. Обычно здесь применяется режим смешивания 
soft light. Текстура sandstone очень хороша для этого. Впрочем, подходит и 
canvas, но это для придания более художественного, картинного вида. 

• Film Grain. Находится в Menu> Filter> Artistic> Film Grain. Вполне 
понятно какой эффект можно достичь, применяя его. Иногда эффект 
зернистости старых фильмов придает очарование изображению. Очень 
естественный и популярный эффект.  

• Reticulation. Находится в Menu> Filter> Sketch> Reticulation. Получается 
эффект как будто вы передержали пленку в проявителе при большой 
температуре. Пленка становится зернистой.  

•Diffuse Glow. Находится в Menu> Filter> Distort> Diffuse Glow. Фильтр 
очень хорош, но не совсем подходит для создания текстур кожи. Он 
добавляет прекрасный рассеянный свет в изображение, что придает ему 
совершенно другой вид. Попробуйте применить этот фильтр вместо 
наложения белых световых бликов (что мы делали выше). Фильтр берет 
естественные яркие точки с лица и добавляет свечение точно на эти точки. 
Вы можете отредактировать и добавить мягкий блеск, сделать модель 
сверкающей и светящейся изнутри. Примерно это будет выглядеть как будто 
фото сделано в стиле High Key. 
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Оригинал       Ретушь без текстуры и зерна          Ретушь+Оригинальная 

текстура 
Лабораторная работа 7 

Делаем коллаж в Фотошоп. Цветовая и тоновая коррекция. 
 
В этом уроке мы научимся создавать красивую абстрактную работу, 

используя всего лишь 3 изображения. Комбинирование изображений, при 
создании работ в программе Adobe Photoshop, очень часто приносит очень 
хорошие результаты. 

Самой тяжёлой частью данного урока будет совмещение упавшей капли 
воды с небом. Автор советует использовать фоновое изображение, на 
котором небо очень чистое, либо с разбросанными облаками для более 
реалистичного эффекта. Знание режимов наложения и умение применять их 
на практике, сэкономит вам значительное количество времени и 
предотвратит множество ошибок. Автор использовал режим наложения 
Multiply (Умножение) для капель воды, а также корректирующий слой Levels 
(Уровни) для осветления средних тонов. 

Шаг 1 
Давайте откроем изображение с городом (Ctrl+O) в программе Adobe 

Photoshop либо просто перенесите это изображение в программу.Тут же 
создадим новый корректирующий слой Exposure (Экспозиция) и применим 
такие же настройки, как на скриншоте. Т. о, мы сделаем изображение ярче. 
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Шаг 2 
Откроем изображение с каплей воды (Ctrl+O) либо также, можно 

перенести изображение в программму, а затем уже в документ, 
предварительно выделив его (Ctrl+A), а затем, при помощи инструмента 

Move (Перемещение) (V), либо с зажатой клавишей Ctrl перенесите 
изображение в наш документ. При помощи инструмента Free Transform 
(Свободное трансформирование) (Ctrl+T) давайте отразим изображение с 
каплей воды по вертикали, нажав правую кнопку мыши и выбрав Flip to 
Vertical (Отразить по вертикали). Далее, расположите изображение с каплей 
как на скриншоте: 

 
Примечание переводчика: для того, чтобы изображение увеличивалось/ 

уменьшалось из центра, нужно держать зажатой комбинацию клавиш 
Shift+Alt. 

Шаг 3 
Переведите слой с каплей в режим Smart Object (правый клик на слое - 

Convert to Smart Object). При помощи комбинации клавиш (Ctrl+L), которая 
вызывает команду Levels (Уровни) давайте слегка осветлим изображение 
(сдвинем средний ползунок до значения 2,55).Создайте обтравочную маску  
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Результат: 

 
Примечание переводчика: обратите внимание, что под слоем с каплей 

появилась команда Levels (Уровни), которую мы только что использовали. 
Т.о, если мы захотим внести правки, можно просто дважды кликнуть на 
надписи Levels (Уровни) и окно редактирования появится снова. 

Шаг 4 

Далее, давайте создадим белую Layer Mask (Маску слоя) для слоя с 

каплей и воспользуемся инструментом Gradient (Градиент) (G) от 
чёрного к белому. Протянем, этим инструментом, сверху вниз, как указано на 
скриншоте. 
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Результат:  
Шаг 5 
Воспользуемся инструментом Brush (Кисть) (B) чёрного цвета с Opacity 

(Непрозрачностью) 50% и пройдёмся этим инструментом по краям 
изображения с каплей, чтобы получилось как на скриншоте. 

 
Шаг 6 
Далее, нам нужно слегка осветлить изображение с каплей, чтобы можно 

было как можно лучше удалить чёрную область на этом изображении. 
Сначала, автор предлагает воспользоваться Layer Style (Стилями слоя), а 
конкретнее, ползунками Blend if (Наложить, если) в общем разделе Blending 
Options (Параметры наложения), которые указаны на скриншоте: 

 
Примечание переводчика: если вы обратите внимание на эти ползунки, то 

вы увидите, что каждый из них разделён на две половины, которые тоже 
можно регулировать. Автор пробует двигать правую половину левого 
ползунка. Замечу, что для того, чтобы двигать одну из двух половин, нужно 
нажать и удерживать клавишу Alt. 
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Становится заметно, что чёрная область начинает исчезать, но края 
выделенной области слишком резкие, а также этот способ удаления плохо 
сказывается на капле, которая замерла на изображении. Что нас не 
устраивает! Давайте попробуем воспользоваться альтернативным способом 
удаления чёрной области. Дважды кликнем на Levels (Уровни), которые 
находятся под слоем Smart Object и сдвинем левый нижний ползунок, 
находящийся в чёрной области, вправо, до значения 55. 

 
И вот результат: 

Шаг 7 
Теперь, приближая чёрную область мы увидим, что она уже не такая 

чёрная. Теперь можно снова попробовать удалить эту чёрную область с 
помощью ползунков Blend if (Наложить если) в разделе Blending Options 
(Параметры наложения). Установим такие же значения ползунков, как на 
скриншоте и изменим режим наложения на Multiply (Умножение). 
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И вот наш получившийся результат: 

 

По окончанию, снова воспользуйтесь инструментом Brush (Кисть) (B) 

для удаления лишних фоновых участков на Layer Mask (Маске слоя). 
Если вдруг вы заметили, что стираете нужную вам область, просто смените 

цвет инструмента Brush (Кисть) (B) на белый и удалившаяся область 
начнёт восстанавливаться. 

Шаг 8 
Теперь, давайте продублируем изображение с фоном (Ctrl+J) и применим 

его в качестве Clipping Mask (Обтравочной маски) к слою с каплей (для этого 
нужно навести мышь на область между копией слоя и слоя с каплей, зажать 
клавишу Alt и сделать левый клик мышью.) Затем измените режим 
наложения копии слоя на Color (Цвет) и Opacity (Непрозрачность) 
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уменьшите до 70%. Результат на скриншоте: 

 
Шаг 9 
А сейчас пришло время добавить модель в наш документ. 

Предварительно, не забудьте отделить её от фона. 
Примечание переводчика: можно использовать любые инструменты 

выделения. Главное - чтобы было аккуратно. Процесс рисования волос я уже 
описывал в этом уроке https://photoshop-master.ru/lessons/photo/retush-
studiynogo-foto-v-fotoshop.html 

После того, как модель будет добавлена, разместите её под каплей. При 
помощи инструмента Free Transform (Свободное транформирование) (Ctrl+T) 
немного уменьшите, а затем отразите по вертикали Flip Vertical (Отразить по 
вертикали). Назовите этот слой woman. Результат: 

 
Шаг 10 
Создадим новый слой Shift+Ctrl+N и сразу же изменим его режим 

наложения на Screen (Экран). Сейчас мы создадим нечто вроде воздушной 

перспективы. При помощи инструмента Brush (Кисть) (B) разного 
диаметра, с цветом #795228, сделайте несколько кликов в области модели, 
чтобы было примерно как на скриншоте. Opacity (Непрозрачность) слоя 
уменьшите до 50%. 
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Шаг 11 
Давайте снова продублируем фон изображения, вернее его копию. 

Поместим её в самый верх списка слоёв и изменим режим наложения на 
Normal. Также, не забудьте вернуть Opacity (Непрозрачность) этого слоя до 
100%. Перейдём в Filter - Distort - Pinch (Фильтр - Искажение - Дисторсия) и 
поставим Amount (Радиус) -100, чтобы получился такой результат: 

 
При помощи инструмента Free Transform (Свободное 

трансформирование) (Ctrl+T) уменьшим изображение до размеров капли и 
разместим на том же месте, где находится сама капля. Отразите её по 
вертикали (Ctrl+T - правый клик на выделенной области Flip Vertical 
(Отразить по вертикали)). Теперь нам нужно удалить лишние участки, чтобы 
эта область стала такой же, как и капля. Уменьшите Opacity 
(Непрозрачность) до 60% и на белой маске слоя, чёрной кистью, пройдитесь 
по лишней области, для её удаления. Примечание переводчика: ничего 
страшного, если вы стёрли нужную область. Для её восстановления 
переключите кисть на чёрный цвет (X) и прорисуйте по этой области. Таким 
образом получается рефлекс. 

Результат: 
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Шаг 12 
Осталось провести финальные настройки. Создадим новый 

корректирующий слой Gradient Map (Карта градиента). Дважды кликнув на 
цветовом переходе, выберите из появившегося списка градиент под 
названием Sepia 4 и измените режим наложения на Hue (Цветовой тон), а 
также уменьшите Opacity (Непрозрачность) этого слоя до 20%. Настройки на 
скриншоте: 

 
Результат: 

Создайте новый 
корректирующий слой Color Lookup (Поиск цвета). В списке рядом с 
3DLutFile выберите Candlelight.CUBE. Opacity (Непрозрачность) уменьшите 
до 10%. Настройки на скриншоте: 
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Результат: 

 
Далее, создайте новый корректирующий слой Curves (Кривые) и 

применим такие же настройки, как на скриншоте: 
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И вот мы получаем финальный результат. Урок оказался очень простым и 

я надеюсь, что полученный результат вам понравился. Нажмите на 
изображение, чтобы увеличить. 

 
Порядок расположения слоёв прилагается: 
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Лабораторная работа 8 
Создание фотореалистичного изображения 

. 
ШАГ 1. Создаем новый рабочий документ с параметрами, как на 

скриншоте.  

 
ШАГ 2. Из папки с изображениями (или из интернета) берем картинку 

острова. Перетягиваем ее в наш документ. Масштабируем с помощью  
«горячих» клавиш CTRL+T. Не забываем зажать SHIFT для 
пропрорционального масштабирования. 
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Когда картинка подогнана под размер окумента, нажмите галочку вверху.  
ШАГ 3. Далее работаем с инструментом градиент. Важно: Если значка 

градиента нет и вы его не нашли. Посмотрите внутри группы за Заливкой.  
Напоминаю что все инструменты со стрелочкой справа открываются и 
внутри них есть еще инструменты 

 
ШАГ 4. Если вы нашли инструмент. Нужно его настроить. Вверху, под 

меню у каждого инструмента есть парраметры.  Вот настройки градиента. 

 
1. Редактор градиентов (настройка шветов и направления) 
2. Виды градиентов (линейный, радиальный, конусовидный, зеркальный, 

ромбовидный) 
3. Режимы наложения. (Точно такие же как и в слоях.) 
Эти 3 пункта нужно запомнить. Что бы в дальнейшем пользовоться 

градиентом.  
Для нашей картинки с черепом- остравом нам нужно настроить градиент, 

который будет симулировать воду.  
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Для этого создаем новый слой. Кликаем по окошку редактора 

градиентов.Нижний ползунок отвечает за цвет. Нам нужно взять образец 
цвета с картинке, что бы максимально похоже сделать. 

Если присмотрется к курсору мыши, мы увидим, что он похож на 
пипетку. Им-то мы и будем брать пробу цвета. Сначала самого светлого, а 
потом самого темного. Настроили градиент- жмем ОК. 

 
 
ШАГ 5 
Проверяем остальные настройки.  

На новом слое, который мы создали проводим линою инструментом. 
Вертикально вниз 

Слой с градиентом перекрыл все 
остальные. Что бы картинка была видна. 
Поменяем ее местами с градиентом.  

Теперь картинка будет сверху. 
 
 
 
 
 
 
ШАГ 6 
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Теперь у картинки четкая нижяя граница. Убераем ее ластиком с 
настройками: 

 
Получается вот так: 

 
Делаем воду реалистичной. Добавляем фильтр Облака. 
 Внимание!!! Перед применением фильтра убедитесь что цвета выбраны 

по умолчанию. 
 
 
 
 

 
Сверяем с картинкой. У вас должно быть точ в точь.  4 слоя на панели. 
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После применения фильтра добавится еще один слой. 
Для него применяем режим наложения- Перекрытие и заливку 

уменьшаем до 17% 
Что должно произойти. Эфект «Облака» снижен. Вы видиье легкую рябь.  
ШАГ 7. Добавляем картинку дна морского. Из папки или из интернета. 

Стираем край ластиком. 

 
 ШАГ 8. Добавляем череп. Инструментом «волшебная палочка» удаляем 

белый фон и подгоняем размеры. Масштабируем череп, что бы его верхняя 
часть была размером с остров. Накладываем текстуру скалы. Режим 
ноложения- перекрытие.  
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ШАГ 9. Удаляем лишние части текстуры. Обрезать ее нужно в форме 
черепа. Поэтому, зажимаем клавишу CTRL и кликаем по слою с 
изображением черепа.  Побежали «мурашки» выделения. Далее нажимаем 
горячие клавиши CTRL+SHIFT+i для инверсии выделения. Картинку должна 
обрамлять рамка из мурашек. Если так произошло- все верно. Переходим на 
слой с текстурой. Нажимаем Delete. 

ШАГ 9. Нам остается сделать цветовую и тоновую работу. Будем 
пользоваться корректирующими слоями. Расположены они ниже панели 
слоев.  

 
В списке можно найти разного рода коррекции. Почему стоит 

пользоваться именно корректирующими слоями, да потому, что их эфекты 
можно менять. А если пользоваться меню Изображение- коррекция. После 
применения невозможно ничего изменить. Текстуру скалы нам нужно 
сделать контрастнее. Используем соответствующий корректирующий слой. 
Напимер я хочу применить цветовой тон и насыщенность к морскому дну. 
Выбираю картинку в списке слоев и захожу в корректирующие. Ищу 
цветовой тон 

 

 
Сейчас корректирующий слой действует на всю картинку, а нам нужно 

применить только к картинке с дном. Мы зажимаем клавишу ALT и кликаем 
между слоями с дном и коректирующим слоем. Появляется значок. Это 
обтравочая маска.  
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Лабораторная работа 9-10. Реставрация: демонстрация применения 

общей схемы по реставрации старых фотографий. 
 

    

Фото 10а. Исходный 
снимок. 

Фото 10б. За счёт 
растяжения гистограммы 
повышаем контраст и яркость. Да, 
немого «нарушена» 
последовательность действий. Но 
я честно предупреждал – это 
общая схема, а не жёстко 
детерминированная 
последовательность! 

Фото 10в. Кадрируем 
изображение и убираем цвет 
командой “Desaturate”. В 
частности, этот ход позволил 
избавиться от жёлтого пятна на 
лице. 

Фото 10г.Ретушируем 
мусор, помятости, загибы… 
Согласитесь, фотография 
выглядит уже не так плохо? 

   

Фото 10д. Самый ответственный для 
реставрации участок портрета – лицо. Видно, что 
работы предстоит много. 

Фото 10е. На ретушь всех дефектов у меня 
ушло более двух часов. Но результат того стоит! 

Фото 10ж. 
Отреставрированный 
вариант портрета. 

 
 
Прежде, чем приступить к реставрации, необходимо составить 

примерный план работы, чтобы делать все последовательно и не бросаться от 
одного к другому. Рекомендуют следующую последовательность действий: 
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http://photo-element.ru/photoshop/restavration/10d.JPG
http://photo-element.ru/photoshop/restavration/10e.JPG
http://photo-element.ru/photoshop/restavration/10f.JPG
http://photo-element.ru/photoshop/restavration/10g.JPG


1. Работайте только с копией отсканированного изображения. 
2. Кадрируйте изображение. Будьте осторожны, чтобы не затронуть важные 
детали. 
3. Определите основные проблемные области для ретуши, выполните 
необходимые операции. Это самый длительный и трудоемкий этап. 
4. Убираем шум и другой нежелательный налет. Не старайтесь убрать 
полностью зерно фотопленки и сделать подобие цифрового снимка! Ведь при 
реставрации важно сохранить дух того времени. 
5. Регулируем яркость, контрастность, насыщенность. В цветных 
фотографиях настраиваем баланс цветов, особенно обращаем внимание на 
правильный цвет кожи. 
6. Повышаем резкость изображения. 

 Итак, приступим к процессу. Вот наше исходное фото. 

 
Шаг 1. Начинают реставрацию обычно с исправления относительно 

больших областей. Для этого лучше всего использовать инструмент Заплатка

(Patch tool). На рисунках показана примерная последовательность 
действий. Сначала исправляются большие области на фоне, затем более 
мелкие. 

 
Шаг 2. После ретуширования крупных дефектов перейдем к мелким. Для 

этого используем инструменты Восстанавливающая кисть (Healing 

Brush), Точечная восстанавливающая кисть (Spot Healing Brush) и Штамп

 (Clone Stamp). Не бойтесь экспериментировать с этими инструментами. 
Инструмент  Точечная восстанавливающая кисть желательно 

использовать для устранения только очень небольших точечных дефектов. 
Для более больших областей лучше использовать 
обычнуюВосстанавливающую кисть и Штамп. 
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На скриншоте ниже отмечены области, в которых использовались 
указанные инструменты: красным –Восстанавливающая кисть, зеленым –
 Штамп. Хочу обратить ваше внимание, что при работе с инструментами 
Заплатка и Восстанавливающая кисть бывают нежелательные эффекты при 
работе на краях изображения, особенно если они имеют белый цвет. Чтобы 
избежать этого, сначала просто закрасьте эти области ближайшим цветом с 
помощью кисти, а затем уже работайте с восстанавливающими 
инструментами. 

 
Вот что должно получиться на этом этапе. 

 
Шаг 3. Теперь будем работать с более серьезными повреждениями. Для 

восстановления изображения левого глаза мужчины мы используем 
изображение его правого глаза. Здесь специально взят крайний случай. Если 
есть другие фотографии этого человека, то лучше взять недостающие части 
изображения с них, так будет правильнее. 
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Итак, выделяем область вокруг правого глаза и копируем на новый слой, 
нажав CTRL+J. Далее нажимаем CTRL+T чтобы применить свободную 
трансформацию. 

 

 
Шаг 4. Щелкните правой клавишей мыши внутри рамки и 

выберите Отразить по горизонтали (Flip Horizontal). 

 
Шаг 5. Для того чтобы правильно разместить отраженную копию глаза, 

уменьшаем непрозрачность слоя и выравниваем  глаз относительно 
исходного изображения. Затем нажимаем ENTER и возвращаем 
непрозрачность на 100%. 
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Шаг 6. Добавим маску слоя, нажав на отмеченную зеленым кружком 

иконку внизу палитры слоев. 

 
Шаг 7. Нажмите D, чтобы сбросить цвета, затем выберите 

инструмент Кисть (Brush). Черной кистью маскируем лишние области. 
Помните, что белый цвет проявляет, а черный скрывает. Чтобы получить 
мягкие незаметные переходы, используйте кисть с мягкими краями. 

Совет: удерживайте палец над клавишей Х для быстрого переключения 
между черным и белым цветом. Если где-то скрыли лишнее, закрасьте эту 
область белым. Если хотите увидеть только маску, щелкните на ее 
миниатюре в палитре слоев, удерживая ALT. 
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Шаг 8. Теперь подобным же образом восстанавливаем изображение 
левого уха. Чтобы точно подогнать форму, используйте 
инструмент Деформация (Warp). 

 
Также восстанавливается и небольшая область линии волос на левой 

части лица. Напоминаю, что каждую операцию нужно производить на новом 
слое. Это должно стать главным правилом работы. 

 
Шаг 9.  После восстановления всех крупных областей вернемся к 

инструменту Штамп  и исправим все недочеты. Делать это нужно на 
новом прозрачном слое, поставив галочку в параметре Образец всех слоев. 
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Можете объединять слои, если это необходимо. 

 
Вот что должно получиться. 

 
Шаг 10. Выделяем все слои. Объединим слои в группу, нажав CTRL+G. 

Затем создаем новый слой выше этой группы, нажав ATL+SHIFT+CTRL+E, и 
называем его Шум. 
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Шаг 11. Теперь уменьшаем шум с помощью фильтра «Уменьшить 

шум» (Reduce noise). 
Важный момент: наибольшее подавление шума следует производить в 

синем канале, так как он содержит наибольшее его  количество. Сохранение 
деталей для этого канала желательно поставить на 0%. 
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Шаг 12.  После подавления шума нужно восстановить резкость 

изображения. Для этого есть много разных способов, в том числе есть 
несколько уроков нашем сайте: 

Повышение резкости или  Адаптивное повышение резкости 
В данном уроке используется способ повышения резкости с помощью 

фильтра Цветовой контраст(High Pass), но лично я предпочитаю способ с 
маской, так как он наиболее  управляемый. Не буду подробно 
останавливаться на технике повышения резкости, желающие могут 
ознакомиться с ними из вышеприведенных уроков. Хочу добавить, что если 
вы планируете печатать восстановленное фото, следует сильнее повышать 
резкость, так как принтеры слегка размывают изображение. Это довольно 
важный момент. 
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https://photoshop-master.ru/lessons.php?rub=3&id=515
https://photoshop-master.ru/lessons.php?rub=3&id=530


 
Шаг 13. Часто возникает необходимость повысить резкость только в 

определенных местах. Для этого нужно создать маску слоя, как мы это уже 
делали, и закрасить ненужные области. 

 
Шаг 14. Создаем новый корректирующий слой Кривые. Придадим кривой 

S-образную форму для повышения контраста. 
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Шаг 15. Теперь сравним результаты. 

 
 
 
Тема 4. Векторная 2D графика, возможности и особенности 

применения.  
 

Лабораторная работа 1. Создание векторной иллюстрации для 
закрепления практических навыков по теме 4: «Рисуем мишку». 

1. Берём инструмент "Эллипс"(L) и рисуем овал для головы медведя. 
-также эллипсом рисуем основные части головы(глаза, нос, щёки, блеск на 
блеск на лбу). 

 
2: 
-теперь дорисовываем нос. Для этого рисуем 2 овала как на рисунке снизу. 

-открываем Окно>Обработка контуров. 
-выделяем эти овалы(Shift) 
-в окне обработка контуров жмем "Исключить область пересечения фигур 
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-разгруппировывыем объекты(в окне Обработка контуров или 
Обьект>Разобрать оформление. 

-лишний обьект удаляем(Delete) 

 
3: 
-теперь рисуем остальные части тела эллипсом и инструментом "перо" 
-регулируем положение фигур с помощью монтажа(Обьект>Монтаж) 

 
4: 
-теперь придаем мишане форму, тени ,красивый вид. 
-копируем овал головы(Редактирование>Скопировать) 
-и вставляем на передний план 2 раза(Редактирование>Вклеить на передний 
план) 
-верхний овал смещаем и к нему выделяем тот что остался наместе. 
-теперь делаем как с носом. 

 
-Осталось всего лишь сделать то же, что и с головой, с другим частями тела, 
как на рисунке внизу. 

 
финал: 
-теперь можна включить фантазию  
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Лабораторная работа 2. Создание векторной иллюстрации  «Логотип 
в виде животного». 

Результат урока: 

 
В этом уроке вы, используя основные фигуры, нарисуете ежика. В 

процессе мы также используем линии с заостренными концами, случайное 
рассеивание объектов и манипуляции с формой фигур. 

1. Рисуем тело 
Шаг 1 
Активируйте инструмент Polygon, выберите режим «Star», этим 

инструментом просто щелкнике по листу, в появившемся окне измените 
количество углов на 15 и залейте этот объект коричневым цветом

 
Инструменотом Работы с узлами, измените остроту лучей вашей фигуры 

 
 
Шаг 2 
Измените размеры многоугольника на 410×465. 

120 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
Шаг 3 
Продублируйте многоугольник (Ctrl+C ,Ctrl+F) и измените цвет копии на 

чуть более темный. 

 
Шаг 4 
Поскольку эти два многоугольника будут перекрывать друг друга, 

давайте увеличим размеры одного из них, а именно более темной копии.  
Выделите оба объекта, откройте панель выравнивания  

 
Шаг 6 
Теперь нарисуем тело ежика. Вооружитесь инструментом Ellipse (E) и 

нарисуйте круг, удерживая для этого Shift.  Измените цвет заливки этой 
фигуры на телесный.Цвет обводки можно выбрать такой же, а можно 
избавиться от контура, разделив фигуру Object-Expand, удалить контур, 

выделив его инструментом  
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Шаг 7Измените форму круга примерно так, как показано ниже. 

 
2. Рисуем глаза 
Шаг 1 

Инструментом рисуем треугольник, , окрашиваем или 

аналогично удаляем контур,меняем его форму  
Шаг 3 
Измените положение опорных точек примерно так, как показано ниже, 

чтобы сделать форму глаза более реалистичной. Заметьте, что здесь фигура 
уже располагается на фоне тела, чтобы лучше представлять размеры и 
собственно форму. 

 
Шаг 4 
Зрачок обозначит еще один круг темно-серого цвета. 

 
Шаг 5 
Двумя меньшими кругами добавьте блики белого цвета. 

 
Шаг 6 
Когда одни глаз готов, сделайте копию всех его элементов и отразите их 

по горизонтали, за исключением бликов – потому что иначе получится, что 
свет падает с двух сторон 

122 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
3. Рисуем нос 
Шаг 1 
Здесь производим уже знакомые действия: нарисуйте эллипс, 

преобразуйте его в фигуру без контура и отредактируйте опорные точки так, 
чтобы было похоже на показанное ниже. 

 
Шаг 2 
Добавьте по центру носа овал темного цвета, обозначающий его кончик и 

еще один белый овал-блик белого цвета.Можно позаимствовать их у глаза 
Ctrl+C,Ctrl+F. 

 
Сейчас ваш ежик должен выглядеть примерно так: 

 
4. Рисуем уши 
Шаг 1 
Для ускорения процесса и избавления от лишних действий, 

продублируйте коричную фигуру глаза. Ctrl+C,Ctrl+F.Переместите копию 
влево и измените форму фигуры так, чтобы она стала похожа на ухо. 

 
Шаг 2 
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Добавьте фигуре уха обводку толщиной 12 пикселей. Измените значения 
цветов обводки и заливки указанным ниже образом. Затем командой Object> 
Lower (PageDown) отправьте ухо «за» тело. 

 
Шаг 3 
Не забудьте сделать копию этой фигуры для другой стороны.

 
Кистью нарисуйте ручки 

 
6. Рисуем ноги 
Шаг 1 
Можно сделать это так же карандашом, но быстрее скопировать одну из 

рук и повернуть и немного изменить ее форму с последующим 
расположением на надлежащем месте. Пространство «внутри» контура 
необходимо залить телесным цветом. Сейчас мы этим займемся. 

 
Шаг 2 
Продублируйте обе фигуры ноги. 

 
7. Добавляем тени 
Шаг 1 
Добавим иллюстрации немного глубины. Продублируйте фигуру тела. 

Измените цвет заливки копии на темно-коричневый. 
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Шаг 2 
Не снимая выделения с этого дубликата, опустите его примерно на 10 

пикселей вниз и вправо Правой кнопкой мыши ищем 

команду размещения в стопке слоев  
Шаг 3 
Теперь сделайте копию большого многоугольника. Измените цвет ее 

заливки на черный, уменьшите его непрозрачность, задав 50%. 

 
Шаг 4 
Отправьте полупрозрачный многоугольник на самый задний план 

 
Шаг 5 
Теперь нарисуйте прямоугольник, центруйте его и залейте фигуру 

зеленым цветом. 

 
8. Рисуем листья 
Шаг 1 
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Рисуем эллипс, выделяем инструментом Direct Tool, конвертируем 

верхний узел в острый.  
Шаг2 
задам ему оранжевый цвет заливки. Инструментом дуга, кисть или 

карандашом рисуем прожилки  

 
Шаг 4 
Карандашом или кистью дорисуйте черенок. Обратите внимание на 

параметры обводки, показанные ниже. Цвет этого контура будет темно-
серым. Не забудьте также отправить его «за» лист. 

 
Шаг 5 
Один цвет для листьев неинтересен. Поэтому продублируйте уже 

имеющийся лист пару раз и измените цвет заливки основной фигуры на 
указанные ниже. Когда вы сделаете это, сгруппируйте каждый лист. 

 
9. «Разбрасываем» листья 
Шаг 1 
Выделите первый нарисованный нами лист, поверните его, измените 

размер. Так же поступите и с другими листьями. Сгрупируйте все листочки. 
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Включите панель символов и 

перетяните туда группу листьев. Теперь работайте 
инструментом как кистью, «разбрасывая» листья по изображению.

Шаг 4  
Наконец, отправьте группу листьев на самый задний план, а потом 

поднимите на один вверх, чтобы группа была выше фона.  
 
Лабораторная работа 3. «Создание городского пейзажа». 

Как создать городской пейзаж в Adobe Illustrator 

 
1.  Создать первый тип зданий 
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Шаг 1 
Начнем с нижних зданий. Использование  прямоугольника - Rectangle 

Tool (M).  
Используйте   панель Stroke,  нажмите на  Align Stroke. 

 
Шаг 2 
Для дверей рисуем еще один прямоугольник. Возьмите Pen Tool (P) и 

нарисуйте линии, как на рисунке. Чтобы убедиться, что линии точно в 
середине, используйте  панель Align (Выровнять). Нажмите 
на  горизонтальной Align Center. 

 
Шаг 3 
 CTRL+G, чтобы сделать группу. Теперь вы можете дублировать окна, 

удерживая  клавишу Alt и перетаскивая мышью. Чтобы убедиться, что окна 
выравниваются по центру здания, повторите те же действия, что и для окна, 
используя только здание как объект для выравнивания ваших окон. Также 
убедитесь, что вы выбрали  Выровнять по выделенному. Например, если вы 
хотите выровнять по монтажной области, выберите Выровнять по монтажной 
области - ваш рисунок будет всегда в центре композиции. 

 
Шаг 4 
Создадим окно на крыше с помощью 

прямоугольника. Используем инструмент Перо:  Add Anchor Point 
Tool (+),  нажмите в середине верхней строке прямоугольника и 
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удерживая  сдвиг  нажмите  стрелку вверх на клавиатуре. Результат должен 
выглядеть следующим образом: 

Шаг 5 
Затем, используя Pen Tool (P),  создайте окно. Для создания цветов, 

используя Ellipse Tool (L)  создать небольшие круги (нажмите Shift, чтобы 
сделать их идеальными кругами!) И в панели Pathfinder (обработка 
контуров)  нажмите на Unite (объединить). 

 
Шаг 6 
Создайте два белых прямоугольника: один под цветы и один на 

нижней части здания. Создать флаг на левой стороне, путем 
создания   прямоугольника, Pen Tool (P) и Ellipse Tool (L), чтобы 

создать флагшток.  
2.  Создадим второй тип зданий 

Шаг 1 
Снова создаем два прямоугольника Для окон используем ту же тактику, 

что и раньше. Результат должен выглядеть следующим образом. 

 
Шаг 2 
Для двери использовать Ellipse Tool (L), потом возьмите инструмент 

Direct Selection Tool (A) или белую стрелочку, выберите нижнюю точку круга 
и нажмите Удалить. Используйте Pen Tool (P),  чтобы нарисовать остальные 

двери.  
Шаг 3 
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Создать  прямоугольник окна на крыше. Как и прежде, использовать  Add 
Anchor Point Tool (+), чтобы создать верхнюю и удалите нижнюю 
линию. Используйте Pen Tool (P), чтобы добавить нужные элементы кровли   

 
Шаг 4. Чтобы создать тень, с инструмент Direct Selection Tool 

(A),  выберите форму стены и перетащите его на стороне. Теперь 
возьмите инструмент Pen Tool и нарисуйте форму, как на рисунке 
ниже. Удалить контур с обеих форм и в Pathfinder панели нажмите на Divide 
(разобрать). 

  

 
Выберите разделенную форму и перетащите его на 

стену. Выключите непрозрачность до 30%. Теперь у нас есть второе здание! 

 
3.  Дублировать Здания 
Нажмите и, удерживая клавишу Alt, перетащите его в сторону второго 

здания. Изменить цвет стены и дверей. И т.д. как на картинке 
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4.  Создаем  Деревья 
Шаг 1 
Для создания деревьев, давайте использовать тот же метод, что и для 

цветов. Создать три круга: Поместите их все, как показано на рисунке, и с 
помощью панели Pathfinder  объединяем. 

Создать стволы и разместить деревья, как на рисунке. 

 
5.  Создадим башню 
Использовать ту же тактику, что и для зданий и для дверей, которые мы 

создали ранее. Используйте Pen Tool для линий, и не забудьте выровнять все. 

 
Шаг 2 
Создать тень, как раньше. Для крыши, создать  круг. С помощью Direct 

Selection Tool (A) выберите нижнюю точку и удалите его, и 
использовать  Pen Tool, чтобы дорисовать. 

 
С помощью Rectangle Tool (M)   прямоугольник и выровнять его, далее 

уже известные вам операции в панели Pathfinder 

 
Шаг 3 
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Для верхней части, вам нужно будет немного попрактиковаться в 
использовании инструмента Pen Tool. Используйте клавишу Shift, чтобы 
создать более совершенные линии и создать форму, как эта. 

 
Выберите форму, щелкните правой кнопкой мыши>  Transform> Reflect и 

нажмите COPY (Копировать). 

 
Соедините обе формы вместеДорисуйте шпиль с помощью Pen Tool (P). 

 
6.  Добавить детали 
Шаг 1 
Для корзины, создать  прямоугольник. С помощью Direct Selection Tool 

(P) выделите нижние точки и перетащите маленькие круги, чтобы создать 
круглые углы. 

 
Создать линии, используя  Pen Tool (P)  и создайте небольшие круги (те 

же цвета, как за деревьями) для кустарников, с белыми штрихами для света. 
Добавить несколько строк, чтобы определить улицу. 

 
Шаг 2 
Для облаков использовать ту же технику, что и для деревьев и цветов 

создать круги и использовать  панель Pathfinder  Удалить точки, выбрав их 
с  помощью Direct Selection Tool (A) и добавьте строки с помощью Pen Tool 
(P). 
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Лабораторная работа 4. «Паттерн из набора животных». 
 

Мы создадим в программе Adobe Illustrator CC набор животных в 
плоском стиле, сделанных из простых форм. Используя прямоугольники, 
треугольники, круги, Live Corners и несколько волнистых линий, мы 
создадим целый зоопарк существ, из которых с помощью панели Pattern 
Options создадим паттерн-узор, который можно использовать в дальнейшем 
для разнообразной печатной продукции. Давайте начнем! 
Прим.переводчика: этот урок можно выполнить и в более ранних версиях 
программы. Если в программе нет возможности использовать Live Corners, то 
можно использовать инструмент Direct Selection Tool (А) для перемещения 
опорных точек и регулировать направляющие опорных точек, чтобы 
получить требуемый изгиб. 

1. Жираф 
Шаг 1. Создайте в программе Adobe Illustrator CC новый документ. 
Используйте инструмент Rectangle Tool (M) (прямоугольник), чтобы 
нарисовать ярко-желтый прямоугольник. Затем нарисуйте длинный, узкий, 
вертикальный прямоугольник с правой стороны первого прямоугольника. 
Для головы жирафа нарисуйте маленький прямоугольник наверху длинной 
шеи. 
Прим. переводчика: если вы выполняете урок в более ранних версиях 
программы, где нет возможности скруглять углы с помощью Live Corners, то 
удобнее для головы жирафа нарисовать не обычный прямоугольник, а 
прямоугольник со скругленными углами. 
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Шаг 2. Нарисуйте четыре одинаковых прямоугольника для небольших ножек 
жирафа. Посмотрите как они идут! Выделите все четыре ноги, и на панели 
Align нажмите Vertical Align Bottom (Вертикальное выравнивание по низу), 
чтобы выровнять эти элементы по нижнему краю, в результате все ноги 
получатся стоящими на одной линии. 

 
Шаг 3. Выделите прямоугольник-голову. С помощью инструмента Direct 
Selection Tool (A), выберите нижнюю правую опорную точку и потяните Live 
Corner к центру, чтобы скруглить этот угол. Выберите верхнюю правую 
опорную точку и слегка потяните Live Corner, чтобы сделать и этот угол 
немного закругленным. 
Закруглите верхний левый угол прямоугольника-тела так же, как мы это 
сделали с головой: потянув внутрь за Live Corner для этого узла. 
Прим. переводчика: здесь и в шагах далее, при выполнении операций по 
скруглению углов в более ранних версиях программы, воспользуйтесь 
инструментом Direct Selection Tool для перемещения опорных точек и 
отрегулируйте их направляющие так, чтобы получить требуемый изгиб. 

 
Шаг 4. Обратите внимание, что часть левой ноги торчит вверху из тела. 
Выберите прямоугольник-тело и две задние ноги жирафа (ноги слева). 
Используйте инструмент Shape Builder Tool (Shift-M), выберите лишнюю 
выступающую часть левой ноги. Снимите выделение и удалите этот объект, 
так жираф получит гладкую спину. 
Прим.переводчика: если у второй ноги нет частей, выступающих вверх из 
тела, которые тоже нужно удалить, то выделять эту ногу не обязательно. 
Также можно просто выделить левую ногу и выполнить ее трансформацию: 
переместите верхнюю границу этого прямоугольника на уровень низа 
прямоугольника-тела. Не перестарайтесь, следите за тем, чтобы границы 
прямоугольников совпадали, иначе нога «оторвется» от тела.  

 
Шаг 5. Рожки жирафа созданы из двух маленьких прямоугольников и двух 
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кругов, нарисованных инструментом «эллипс» Ellipse Tool (L). Поместите их 
в верхней левой части головы жирафа. 

 
Шаг 6. Добавьте с помощью инструмента Rectangle Tool небольшой хвост 
слева, в нижней части тела жирафа. Объедините все желтые объекты в 
панели Pathfinder, воспользовавшись Unite. Используйте инструмент Ellipse 
Tool, чтобы нарисовать коричневый эллипс для глаза жирафа. Затем 
нарисуйте серию кругов по всему телу жирафа и на шее, чтобы 
сформировать простой узор. Используйте инструмент Shape Builder Tool , 
чтобы удалить выходящие за пределы жирафа части кругов, как мы делали 
это ранее для ног. Сгруппируйте все компоненты вместе с помощью Group 
(Control-G), и ваш первый элемент паттерна готов. 

 
2. Кит. Шаг 1. Как и при создании жирафа, начнем рисовать кита с 
прямоугольника. Нарисуйте большой синий прямоугольник с помощью 
инструмента Rectangle Tool. Выделите нижнюю левую точку прямоугольника 
и потяните Live Corner внутрь, чтобы закруглить левый угол 
прямоугольника. 

 
Шаг 2. Для хвоста нарисуйте треугольник с помощью инструмента Pen Tool 
(P) или инструмента Polygon Tool. Потяните Live Corner для нижней левой 
опорной точки внутрь. Скопируйте Copy (Ctrl + C) и вставьте Paste (Ctrl + V) 
этот элемент, и поверните копию Rotate ® влево. Разместите оба элемента 
хвоста в правом верхнем углу тела кита. 

 
Шаг 3. Чтобы нарисовать киту горло - нарисуйте большой голубой круг с 
частичным наложением на левую сторону тела кита. Воспользуйтесь 
инструментом Shape Builder Tool, чтобы удалить часть круга, выходящую за 
пределы тела. Также в этом шаге я закруглила правый нижний угол 
прямоугольника тела кита.  

 
Шаг 4. Для вертикальных «углублений» на горле кита я использовала 
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инструмент Pen Tool, чтобы нарисовать простую изогнутую линию; в панели 
Stroke задайте толщину обводки (контура) примерно 2-5 пункта (2–5 pt) (эта 
величина зависит от размера вашего объекта и того, насколько толстыми Вы 
хотите сделать «углубления»). Сделайте несколько копий этой гладкой линии 
с помощью Copy и Paste и поместите их на форму горла кита (как показано 
на рисунке ниже). Разверните и если нужно измените размер линий так, 
чтобы их концы выходили за пределы формы горла, выполните Expand 
(чтобы превратить линии в объекты с заливкой), а затем используйте 
инструмент Shape Builder Tool, чтобы удалить участки линий, выходящие за 
пределы формы горла (прим.переводчика – не забудьте перед этим выделить 
как линии, так и форму горла кита), таким образом, у вас на рисунке 
останутся только изогнутые полосы для горла кита. 

 
Шаг 5. Нарисуйте несколько голубых кругов для водяного облака, 
выпускаемого китом. Объедините их, используя Unite в панели Pathfinder. 
Затем нарисуйте три или четыре тонких вертикальных прямоугольника, 
соединяющие тело кита с водяным облаком. 
Нарисуйте темно-коричневый эллипс для глаза кита, затем создайте 
округлый треугольник плавника на теле кита (так же, как делали для 
плавников хвоста) и измените цвет заливки «углублений» горла на синий 
цвет (такой же, как у тела кита), чтобы завершить работу над дизайном кита. 
Сгруппируйте (Group) все элементы вместе. 

 
3. Тигр. Шаг 1. Вначале с помощью инструмента Rectangle Tool нарисуйте 
оранжевый прямоугольник, как на рисунке ниже. Затем используйте 
инструмент Direct Selection Tool, чтобы выбрать обе нижних опорных точек и 
потяните Live Corners внутрь, чтобы закруглить низ головы тигра. 

 
Шаг 2 

Теперь таким же образом, как сделали голову, мы создадим ухо тигра 
(прямоугольник с закругленными углами), но также немного закруглим и 
верхние углы, чтобы на этой фигуре нигде не было острых углов. Поверните 
немного ухо и разместите его на одном из верхних углов головы. Сделайте 
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такое же ухо на голове с другой стороны. Затем нарисуйте яркий розовый 
прямоугольник для носа, мы продолжим с ним работать в следующем шаге. 

 
 
Шаг 3 

Внутренние части ушей тигра - округлые прямоугольники с ярко-
розовым цветом заливки. Решите, какой нос вы хотите сделать тигру – в виде 
скругленного прямоугольника или скругленного треугольник (см. рисунок 
ниже). Я выбрала скругленный треугольник. 
Нарисуйте два темно-коричневых эллипса для глаз и рот в форме 
перевернутой буквы "V" (прим. пер. - например используйте инструмент 
перо, и задайте получившемуся пути обводку темно-коричневого цвета). В 
панели Stroke установите округлые (Rounded) перегибы и концы линий. 

 
Шаг 4 

Нарисуйте серию треугольников вокруг головы тигра, это будущие 
«полоски». Также как при создании узора из кругов на жирафе, используйте 
инструмент Shape Builder Tool, чтобы удалить части треугольников, 
выходящие за пределы формы головы тигра, а затем сгруппируйте (Group) 
все компоненты тигра вместе. 

 
4. Лев 

Шаг 1 
Скопируйте (Copy) и вставьте (Paste) нарисованного ранее тигра. Удалите 

его полоски и измените цвет заливки с оранжевого на ярко-желтый. Я также 
изменила форму глаз, сделав их круглыми, а не в виде эллипсов как у тигра, 
просто чтобы сделать эти мордочки менее похожими. 

 
Шаг 2 

Чтобы сделать гриву льва, нарисуйте оранжевый круг чуть больше 
мордочки льва (так вы получите общее представление о размерах). 
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Перейдите в Effect> Distort & Transform> Zig Zag и введите следующие 
параметры (или те, которые дадут вам подобный эффект): 

• Size: 0.1 in 
• Absolute 
• Ridges per Segment: 11 
• Points: Corner 

 
 
Шаг 3 

Примените Expand к гриве, измените ее размер как вам требуется и 
поместите ее позади головы льва. Сгруппируйте вместе (Group) все 
компоненты льва. 
 

 
5. Муравьед 

Шаг 1 
Начнем с головы муравьеда, для этого нарисуйте треугольник. Выберите 
верхнюю опорную точку и потяните ее Live Corners к центру, чтобы 
закруглить этот угол треугольника. Повторите тоже самое для левой опорной 
точки, чтобы закруглить левый угол треугольника. 

 
Шаг 2 

Для маленьких ушей муравьеда нарисуйте два маленьких треугольника и 
закруглите у каждого треугольника верхний и правый углы. Поместите оба 
уха в верхней части головы муравьеда. 
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Шаг 3 

Тело и хвост муравьеда сделаем из двух прямоугольников. Скруглите 
левый нижний угол прямоугольника-тела и правый нижний угол 
прямоугольника-хвоста. Используйте инструмент Перо (Pen Tool) или 
инструмент Карандаш (Pencil Tool) (клавиша N), чтобы нарисовать 
волнистый розовый путь-язык. Убедитесь в панели Stroke, что концы для 
линии пути (cap) и углы (corner) установлены как Rounded (округлые). 

 
Шаг 4 

Нарисуйте маленькие прямоугольники для ножек муравьеда, кремовый 
эллипс будет глазом, а прямоугольник с закругленными углами станет 
узором на спине муравьеда. Сгруппируйте (Group) все компоненты 
муравьеда вместе. 

 
6. Черепаха 

Шаг 1 
Нарисуйте зеленый прямоугольник и потяните Live Corners внутрь, чтобы 

создать верх панциря черепахи. Выделите эту фигуру и измените размер 
нижней части закругленного прямоугольника так, чтобы общая высота 
фигуры получилась чуть больше, чем высота половинки круга верхней части 
панциря. 
Голова черепахи - это прямоугольник, закругленный с левой стороны, 
который помещен под фигуру-панцирь. Хвост – это треугольник, а ноги - 
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четыре маленьких прямоугольника. Сделайте цвет заливки панциря темно-
зеленым, более темным, чем цвет заливки головы, хвоста и ног. 

 
Шаг 2 

Используйте инструмент рисования многоугольников (Polygon Tool), 
чтобы нарисовать простой узор из соприкасающихся шестиугольников. Я 
решила, что, чтобы получить большой узор, проще копировать (Copy) и 
вставлять (Paste) участки из шестиугольников. Варьируйте оттенки и тона 
зеленого цвета, используемые для заливок шестиугольников. Сгруппируйте 
(Group) все шестиугольники вместе. Поместите форму панциря над узором из 
шестиугольников и создайте маску, выполнив Clipping Mask (Ctrl-7). 

 
Шаг 3 

Нарисуйте маленький коричневый эллипс для глаз черепахи и 
сгруппируйте (Group ) вместе все компоненты черепахи. 

 
 
7. Осьминог 

Шаг 1 
Последним животным для нашего узора будет яркий красно-оранжевый 

осьминог. Также как мы делали раньше, начнем с прямоугольника. Он 
должен быть вертикальным. Выберите две верхние опорные точки в углах 
прямоугольника с помощью Direct Selection Tool и потяните их Live Corners 
внутрь, чтобы полностью скруглить верхнюю часть прямоугольника. 

140 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
Шаг 2 

Используя инструмент Перо (Pen Tool), нарисуйте слева волнистую 
линию, идущую от низа тела осьминога. Установите в панели Stroke толщину 
обводки, задайте этой линии закругленные (Rounded) углы и концы. Этим же 
способом продолжайте рисовать другие щупальца осьминога. 

 
Шаг 3 

Нарисуйте четыре щупальца на левой стороне. Примените к ним Expand 
(превратив их в объекты с заливкой), сгруппируйте их (Group), а затем 
скопируйте (Copy) и вставьте (Paste), получив щупальца для правой стороны. 
Отзеркальте их (Reflect) относительно вертикальной оси (Vertical Axis) и 
разместите на правой стороне осьминога. Я добавила коричневые эллипсы 
для глаз и несколько светло-красных кругов для узора в левом верхнем углу 
тела осьминога. Сгруппируйте (Group) все элементы вместе. 

 
8. Создание узора-паттерна 

Шаг 1 
Откройте панель Библиотеки (Libraries) и внизу выберите опцию Создать 

новую библиотеку (Create New Library). Выделите и перетащите группу 
каждого животного в библиотеку и дайте новой библиотеке имя, например 
«животные» (animals). Это позволит далее легко создать свой узор. 

 
Шаг 2 
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Поместите трех ваших животных на небольшой площади, например как 
на рисунке ниже. Масштабируйте (изменяйте размер) и поворачивайте 
(Rotate) элементы как вам требуется. 

 
Шаг 3 

Выберите все три объекта-животных и откройте панель Pattern Options. 
Нажмите Make Pattern в настройках панели. Выберите в поле Tile Type в 
качестве типа узора Brick by Column. С помощью также открытой панели 
Libraries, перетащите других животных на узор, чтобы они частично 
выходили за границы рамки, так вы создадите бесшовную модель узора-
паттерна. Поворачивайте (Rotate), изменяйте размер и переставляйте 
элементы при необходимости. Когда будете довольны своим рисунком - 
нажмите Done. Вы найдете только что созданный паттерн готовым к 
использованию в панели Swatches. 

 
 

 
Лабораторная работа 5. Создать векторную иллюстрацию по 

приведенным образцам. Абстрактные деревья 
 

Какие кисти имеются в Adobe Illustrator, как создавать и применять их. 
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Запустите Illustrator и перейти к Файл> Создать, чтобы открыть новый 
документ. Введите имя и настроить размеры выберите Pixels, 
цветовой режим RGB.  

Создайте Art Brush 
Шаг 1 
Форма Art Brush(базовую кисть) может быть создана путем изменения 

основных фигур. 
Мы создадим простой Art Brush из с треугольника. Так, возьмите Star 

Tool и нарисуйте треугольник, 90 градусов, используя Transform. Далее, 
взять Delete Anchor Point Tool (-) и нажмите на трех точках, указанных для их 
удаления. 

 
Шаг 2 

Используйте инструмент Direct Selection Tool (A) 

 
 

Шаг 3 
Прежде чем сохранить кисть, выберите черный цвет заливки. Теперь вы 

можете перетащить его в панель кистей  и выберите New Art Brush. В 
открывшемся окне введите имя, выберите направление и установите метод 
раскрашивания в Tints.  ОК, а затем вы можете найти кисть в панели Brushes. 
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Используйте Art Brush, чтобы создать дерево 

Шаг 1 
Возьмите Pencil Tool (N) и нарисуйте волнистую линию 

на монтажной области, как на картинке. Вы можете изменить настройки для 
инструмента Карандаш (N) по двойному щелчку на нем  

Шаг 2 
Далее, выберите Art Brush, сохраненное в панели кистей  для того, чтобы 

применить ее на этот путь. Поставьте толщину обводки в 1pt, двойным 
щелчком на кисти применяется в Внешний вид панели, чтобы открыть 
окна Stroke Options и установить ширину в %. 

 
Шаг 3 

Также с помощью инструмента Карандаш (N), создать три новых линии   
и установить ширину в %. В зависимости от того, какие штрихи кисти 
(толстые и тонкие) вы хотите, вы можете регулировать ширину. Для разных 
веток ширина кисти будет разная. Можно создать дубликаты кистей разной 
ширины. 

 
 

Шаг 6 
Можно создать более сложные деревья. Вы также можете перейти 

к Effect> Distort & Transform и примените Roughen эффект с минимальными 
значениями, чтобы получить более реалистичное дерево. 
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Создайте листик Scatter Brush 
Шаг 1 
Символом Scatter Brush в данном случае будет лист. Мы начнем с базовой 

формы: берем  Ellipse Tool (L) и нарисуйте эллипс, имеющий 
размеры. Используйте инструмент Direct Selection Tool (A),чтобы выбрать 
только верхнюю точку затем перейдите к Object> 
Transform>Move, введите 25px в вертикальной области, и OK. Тем не менее, 
имеющий верхнюю точку, выбранную, нажмите Преобразовать выбранный 
опорные точки в углу иконы в управления панели (3). 

Наконец, выберите левые и правые опорные точки с помощью Direct 
Selection Tool (A) и перетащите верхнюю ручки, чтобы сделать их немного 
больше. Вы получите более округлую форму (4). 

 
 

Шаг 2 
Далее, взять Rectangle Tool (M) и нарисуйте прямоугольник над тонкой 

листовой форме. Выделите обе фигуры и нажмите Horizontal Align 
Center вAlign панели. Используйте инструмент Direct Selection 
Tool (A), чтобы выбрать только нижнюю левую точку и переместите 
ее 2px влево, нажавлевую клавишу со стрелкой на клавиатуре два 
раза. Теперь, выберите правую нижнюю точку и переместить его 2px вправо. 

 
Шаг 3 

Используйте Rectangle Tool (M), чтобы сделать еще один прямоугольник, 
имеющий показанные размеры. Поверните на 45 градусов и переместить его 
на левой стороне листа ), затем сделайте две копии. Возьмите еще один 
прямоугольник и Поверните -45 градусов,  переместите его на правой 

стороне листа.  
Шаг 4 
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Выберите форму листа и средний прямоугольник. Нажмите Subtract в 
панели Pathfinder.  Прежде чем продолжить сгруппируйте все угловые 
прямоугольники. Теперь выберите новую форму листа и группу 
прямоугольников и нажмите Subtract в панели Pathfinder  снова  

 
 

Шаг 5 
Лист готов и, прежде чем вы сохраните его, выберите черный цвет 

заливки.Перетащите в  символ новая кисть панели кистей и выберите New 
Scatter Brush. В открывшемся окне введите имя, установить вращение 
относительно Пути и раскрашивания на Tints. Мы будем работать с 
остальными настройками позже.  ОК и теперь вы можете найти свой лист в 
Scatter Brush панели кистей. 

 
5. Нанесите Leaf Scatter Brush 

Шаг 1 
Двойной щелчок на Pencil Tool (N) в Сервис панели, чтобы 

открыть Настройки окна. Там, установите Fidelity для 10px, а также 
увеличьте гладкость, чтобы получить меньше узловых точек вдоль 
путей. Рисуем дополнительные линии, которые станут путями для наших 
листиков. Важно не соединять их в середине. Первые два пути пусть будут 
темно зеленого цвета, остальные делаем светлее и светлее. Листья подбирают 
цвет обводки. Большая заслуга Scatter кисти в том, что вы можете 
контролировать порядок, в котором символ (лист) рассеивается. Для этого у 
вас есть четыре метода: размер, расстояние рассеивания и поворот Rotation в 
окне Stroke Options . Вы можете получить доступ к ним  двойным щелчком 
на кисти.  Используйте те же настройки для другого пути. 
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Шаг 2 
Возьмите снова Pencil Tool (N) и нарисуйте два новых путей по контуру 

существующих листьев. На этот раз выберите более светлый оттенок 
зеленого цвета. Потом еще и т.д.  

 
 

 
Шаг 6 

Сделаем несколько корректировок. Если ваши слои листьев не красиво 
выровнены, можно переместить некоторые из опорных точек с помощью 
Direct Selection Tool (A), чтобы исправить проблему. Не беспокойтесь о 
перекрывающихся листьях,  это исправим позже. 

Если все испрвлено с вашим деревом, выберите все пути Scatter Brush и 
выберите Expand Appearance из меню объекта. В результате, вы получите 
группу листьев. 
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Шаг 7 
Чтобы сделать несколько корректировок,  дважды щелкните по одной из 

групп листьев, чтобы войти в режим изоляции. Теперь вы можете выбрать 
каждый лист, поворачивать и перемещать их, чтобы покрыть пустые места 
или освободить образование пятен. После того как вы все сделали, нажмите 
на стрелочку в левом верхнем углу монтажной области, чтобы Выйти из 
изолированной группы.  

 
 

Шаг 8 
На следующем рисунке вы можете увидеть основные области, в которых 

я переставила листья.  
 

 
6. Создание второй кисти Art Brush 
Шаг 1 
Во-первых, вам нужно треугольник, имеющий тот же размер, как один с 

самого начала. С форма выбрана, перейдите к Object> 
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Transform> Reflect, проверьтеVertical и нажмите Копировать. Перемещение 
новый треугольник рядом с первым, как на картинке. 

 
 

Шаг 2 
Выберите два спина к спине треугольники и 

нажмите Добавить в Pathfinderпанели, чтобы объединить их в одну 
фигуру. Используйте инструмент Direct Selection Tool (A), чтобы выбрать 
только верхние и нижние точки затем нажмите Преобразовать выбранный 
опорные точки, чтобы сгладитьзначок в управления панели. В результате вы 
получите закругленные углы. 

 
 

Шаг 3 
Прежде чем сохранить кисть, выберите черный цвет заливки для 

фигуры.Теперь, перетащите его в кистей панели и выберите New Art Brush. 

 
 

7. Создать Второй лист Scatter Brush 
Шаг 1 
Используя ранее созданную ромб Art Brush Вы создадите новый 

лист ScatterBrush. Возьмите Pencil Tool (N) или Pen Tool (P) и нарисуйте 
волнистую путь, как показано ниже, то ход его вновь спас Art Brush. 
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Шаг 2 

Нарисуйте еще один волнистый путь, но короткий и через середину 
черного листа. Ход этот путь с той же Art Brush, но 
установить обводки в 0.1pt. 

 
Шаг 3 

Выберите два пути и с объектов меню выберите Expand 
Appearance затемРазгруппировать (Shift-Control-G) в два раза. В результате 
штрихи превратится в форм, заполненных черный и синий, в этом 
случае. Имея два новых форм выбран, нажмите Subtract в Pathfinder панели и 
результат будет лист № 2. 

 
Шаг 4 

Перетащите черный лист в кистей панели и выберите New 
Scatter Brush. ВOptions окна, введите имя (лист 2), установите относительное 
вращение путь и раскрашивания на оттенки затем нажмите ОК. Вы будете 
играть с другими настройками позже. 

 
 

8. Нанесите второй лист Scatter Brush 
Шаг 1 
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Во-первых, сделать копию дерева силуэт. Возьмите Pencil Tool (N) и 
нарисуйте случайный спираль над ветвями затем удар этот путь с листьев 2 
ScatterBrush. Поскольку раскрашивания установлен в оттенки листья 
подберут цвет обводки, который является более темный оттенок красного. 

Теперь давайте играть с другими настройками, и для этого дважды 
щелкните вВнешний вид панели на кисти применяется, чтобы открыть Stroke 
Optionsокна. Выберите Random для Размер перетащите ползунки 
до 20% и 30%. Я хранил эти два значения для следующих ходов, а также 
потому, что я не хочу основные различия между 
листьями. Значения Интервал, Scatter и вращенияслучайно были выбраны и 
вы можете использовать их, если вы хотите, или выберите свой собственный. 

 
 

Шаг 2 
Скопируйте первый удар, нажав выбран пункт Дублировать значок в 

нижней части Внешний вид панели то изменить цвет на 
оранжевый. Откройте Stroke Options окна и изменять 
значения Интервал, Scatter и вращения. На рисунке ниже вы можете увидеть, 
те, которые я использовал. 
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Шаг 3 
Добавьте третью обводку и измените цвет на голубой. Опять же, 

перетащите ползунки и измените значения пока вы не получите желаемого 
результата. 

 
 

Шаг 4 
Для четвертого использования инсульт синего и той же кистью, 

конечно.Изменить настройки как на картинке или, как вы хотите. По этой 
причинеразброса Кисти в Illustrator очень разносторонний. 
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Шаг 5 
На следующем рисунке вы можете увидеть следующий удар. 

 
 

Шаг 6 
Вот еще один штрих: 
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Шаг 7 
И, наконец, последний, используя красный, как цвет обводки. На данный 

момент, откройте графических 
стилей панель (Window> графическихстилей), то перетащите миниатюру 
из Appearance панели в Стили графикипанели, чтобы сохранить его, в то 
время как выбран путь. 
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Шаг 8 
Чтобы быстро увеличить количество листьев, взять инструмент Pencil 

Tool (N)и нарисуйте еще один виток по ветвям (1). Применить для этой 
спирали графический стиль, который вы ранее сохраненный, выбрав его 
изграфических стилей панели (2). Последнее, что нужно сделать, это перейти 
на этот путь позади дерева силуэт с помощью Слои панели для того, чтобы 
раскрыть некоторые из ветвей (3). Второй абстрактный дерево готово. 

 
 

9. Создание и применение третьего Scatter Brush 
Шаг 1 
Третий кисть простой. Возьмите Ellipse Tool (L) и нарисуйте 50 х 

50px круг. Он не имеет серую заливку, но черный 
на 50% непрозрачности. Таким образом, вы получите перекрывающийся 
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полупрозрачный вид. Перетащите этот круг вкистей панели и выберите New 
Scatter Brush. В Опции оконного типа имя затем установите вращение 
относительно Пути и раскрашивания на Tints, как обычно. 

 
 

Шаг 2 
Сделайте еще одну копию дерева нарисуйте случайный спираль по 

ветвям, используя инструмент Pencil Tool (N). Ход этот путь с Circle Scatter 
Brushоткройте Options окна и изменять 
значения Размер, Интервал и Scatter. Не имеет смысла вращать круг, поэтому 
держать поворот на 0 градусов. В общей сложности, я добавил четыре удара 
с использованием различных оттенков фиолетового. 

 
 

Шаг 3 
Теперь давайте исправим нижнюю часть ствола, но сначала убедитесь, 

что формы, которые составляют дерево не сгруппированы. Если это так, 
нажмитеShift-Control-G. Затем, нарисуйте прямоугольник над наклонной 
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части, как на картинке. Выберите прямоугольник, а также ствол-формы 
и пресс-Subtract вPathfinder панели. 

 
 

Шаг 4 
Повторите то же самое для двух других деревьев. 

10. Создание тени под деревьями 
Шаг 1 
Урок о художественных и Scatter кисти заканчивается в этой точке, но 

если вы хотите, чтобы добавить тени под деревьями продолжать читать 
несколько дополнительных шагов. Начните с рисования три плоских 
эллипсов разных размеров и заполнить их с цветами, указанными. Выбрать 
все из них и нажмитеВертикальный Выровнять по центру в Align панели 
переместите их под абстрактные фиолетовый дерева. Тем не менее наличие 
их выбрана, перейдите к Object> Blend> Параметры Blend и выберите 20 
конкретныешаги. Хит ОК затем вернуться к Object> Blend> Make (Alt-
Control-B).Уменьшить непрозрачность для результате смесь группе с 50%. 
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Шаг 2 

Использование слоев панели найдите и откройте Blend-группу, 
созданную на предыдущем шаге. Выберите только средних и малых 
эллипсов, тоКопировать и Вставить их в фронта (Control-F). Перетащите эти 
две копии за пределами Blend-группы, над ним. Держите те же цвета, 
заливки, но уменьшитьнепрозрачность до 3 0%. 

 
Шаг 3 

Чтобы создать тень под многоцветный дерева, просто выберите тени (все 
пять форм), которые вы создали под фиолетовым деревом и сделать 
копию. Затем просто замените оттенки фиолетового с оттенками желтого, как 
указано. 

 
 

Шаг 4 
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То же самое идет для первого дерева. Сделайте еще одну копию тени и 
организовать его под деревом, то заменить существующие цвета с оттенками 
зеленого. 

 
Шаг 5 
Убедитесь, что вы отправили тени за деревьями, а затем деревья 

готовы.Вместо этих символов, которые вы можете использовать практически 
любой другой, и, чтобы назвать несколько: сердца, письма, простые цветы, 
бутоны, плоды или даже птицы, почему нет. 

 
 

 
 

Тема 5. 3D графика. Трехмерное моделирование объектов. 
Лабораторная работа 1. Основы моделирования. 

Переходим к практике. Итак, самое трудное на первом этапе – это 
освоение интерфейса. Во многих книгах в действительности все показано 
достаточно громоздко, поскольку их задачей является полное отображение 
всех функций программы. Не стоит за это ругать авторов. Мы же возьмем за 
основу только то, что необходимо новичкам. 
Расшифровка кнопок меню быстрого доступа. 
Для начала следует определиться с тем, что интерфейс программы является 
трансформируемым под разные задачи, основные из которых: 
моделирование, анимация и работа с текстурами (если у вас стоит Body Paint, 
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а если не понимаете, что это такое – не важно). Между этими режимами 
можно переключаться. Но при обычной загрузке дается вариант интерфейса 
Standart, который объединяет в себе ключевые функции от всех остальных 
режимов. Его и рассмотрим. 

 
Интерфейс в режиме Standart состоит из нескольких ключевых 

структурных блоков: 
. Главное меню. 

. Меню кнопок быстрого доступа слева. Здесь вы переключаетесь между 
различными режимами работы с объектами и их составляющими. 
. Меню кнопок быстрого доступа сверху. В нем собран весь инструментарий, 
который необходим для работы, другими словами, выведены основные 
элементы из главного меню. 

. Функциональное окно справа, в которое входит менеджер объектов 
(сверху) и окно свойств для любого выбранного элемента (снизу). 

.Рабочая область. Здесь мы делаем основную работу. 

. Менеджер текстур и материалов. В режиме Standart находится под 
рабочей областью, в остальных вызывается из пункта главного меню Window 
-> Material Manager (или Shift+F2). 

Основные функциональные блоки 
интерфейса в режиме Standard 
Обратите внимание на то, что у окон 
менеджеров (объектов, материалов) 
имеются свои собственные главные 
меню. 
Стоит сказать, что наполнение 
функциональных окон и меню 
быстрого доступа можно также менять 
по своему усмотрению, но в нашем 
случае это абсолютно не важно. 
Особенности управления мышью 

Основная работа происходит в рабочей области, которая по умолчанию 
состоит из четырех окон проекций: перспектива, вид сверху, вид сбоку, вид 
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спереди. В принципе, можно предусмотреть и другие варианты, но мы 
остановимся на исходном. Во всех случаях увеличение/уменьшение 
масштаба просмотра делается с помощью колесика мыши. 
Дополнительно предусмотрены следующие ключевые функции управления: 
. При удерживании клавиши «1» и нажатой левой кнопке мыши мы смещаем 
область просмотра вправо/влево. 

. При удерживании клавиши «2» и нажатой левой кнопке мыши мы 
плавно смещаем область просмотра вперед/назад (при использовании 
колесика мыши приближение/удаление происходит ступенчато). 

. При удерживании клавиши «3» и нажатой левой кнопке мыши мы 
вращаем область просмотра вокруг центра координат выбранного объекта 
(работает только в режиме перспективы). 

. Если в рабочей области вы хотите выделить несколько элементов 
объекта (точек/вершин, граней, полигонов), то это делается кликом левой 
кнопки мыши на них при удерживании клавиши Shift. 

Понятие рендеринга (визуализации) 
Вы, наверняка часто слышали слово «рендеринг» или его менее редкий 

русскоязычный терминологический аналог «визуализация» применительно к 
3D. Под всем этим подразумевается довольно сложный процесс создания 
готового 2D-изображения на базе трехмерной сцены, которую в нашем 
случае вы будете проектировать. При визуализации производятся расчеты 
расположения объектов и их отдельных элементов (вершин), связанных с 
ними материалов и текстур, параметров освещения и так далее. 
Для самого простого примера, поместите в рабочую область какой-нибудь 
простой 3D-объект, например, куб, перейдите к окну перспективы, выберите 
нужный ракурс. Затем нажмите в верхнем меню быстрого доступа кнопку 
Render Active View (либо в опции главного меню Render выберите Render 
View), в результате чего запустится процесс визуализации, и вы увидите в 
итоге его работы готовое изображение. 

Создаем кривую 
Первым делом давайте научимся работать с кривыми (сплайнами) на 

самом простом уровне. Перейдите в одно из окон проекций (не перспективы), 
затем на верхнем меню быстрого доступа нажмите на нижний правый уголок 
кнопки сплайнов (помечен треугольником), в результате у вас откроется 
окошко, где отображены все доступные виды кривых, некоторые из которых 
уже заранее описывают какую-либо конкретную форму и имеют 
специфические настройки для нее. Мы же выберем самый простой вариант: 
Linear (простая ломаная). Нажав на него, интерфейс уже готов к вашему 
рисованию и ждет дальнейших действий в рабочей области. В ней мы 
начинаем рисовать линию, расставляя точки. Обратите внимание на то, что 
ее окрашивание происходит градиентно от белого к синему. Белый 
соответствует началу линии – это знать важно. 

Уже поставив первую точку, вы можете увидеть в менеджере объектов 
новый элемент под названием Spline. После клика на него указателем мыши, 
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в окне свойств появляются основные настройки для нашей линии, их 
немного, причем в данном случае нам интересно вообще только два из них:  
.Type – тип кривой, стоит выбранный нами изначально перед рисованием, но 
его можно менять. 

.Указатель Close Spline. Если он активен, то первая и последняя точки 
автоматически соединяются, формируя замкнутую кривую. 
Попрактикуйтесь с этими параметрами, привыкните к режиму рисования. 
Причем, когда вы создаете линию, автоматически включается режим 
редактирования точек, что видно на боковом левом меню. Но при рисовании 
редактирование самих точек не работает, то есть операцию по созданию 
линии мы проводим единожды. 

В случае переключения на режим перемещения объекта по осям (кнопка с 
изображением двух осей и треугольника в боковом левом меню быстрого 
доступа), линия станет завершенным объектом, который можно двигать. 
Если после этого опять переключиться на редактирование по точкам, вы 
можете уже можете менять их положение и проводить редактирование. 

Итак, нарисуйте линию Linear, включающую больше двух точек. 
Выделите любые две точки на ней и нажмите правую кнопку мыши, в 

результате чего появится специализированное контекстное меню с 
множеством функций. В данном случае нас будет интересовать его пункт 
Soft Interpolation (мягкая интерполяция). Что произойдет в итоге? 
Выделенные точки станут элементами кривой Безье, то есть линии вокруг 
них округлятся и появятся ручки управления кривизной. Чтобы 
воспользоваться ими и опробовать в деле, на верхнем меню быстрого 
доступа включите режим смещения, после чего поднесите указатель мыши к 
черным ручкам и удерживая левую кнопку можно начинать менять форму 
кривой. А в итоге линия у нас получилась гибридной, включающим как 
точки, подразумевающие простое линейное соединение, так и варианты 
Безье. 

 
Рисуем кривую Linear 
Далее имеет смысл более подробно изучить пункты контекстного меню. 

Для нашего последующего примера достаточно освоить операцию Add Point 
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(добавить точку). Для удаления точек достаточно ее выделить и нажать 
клавишу Delete. 

Лабораторная работа 2. Шторы с помощью Cinema 4D. 
В этом уроке вы сможете разобраться с тем, как правильно использовать 

инструменты NURBS, чтобы быстро и без особых усилий получить 
пластичную форму. 

Выберите среди объектов инструмент Linear Spline, чтобы создать в 
верхней части чертежа углообразную линию, как на изображении ниже. 

 
  
Основа для дальнейшей обработки готова, осталось только придать ей 

требуемую форму. 
Теперь можно вооружиться инструментом Extrude NURBS и немного 

поработать с настройками, чтобы получить желаемый эффект. Всё зависит от 
того, какие именно шторы вы хотите сделать.  

 
 Результат должен быть таким. 
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Будущие шторы понемногу начинают преобразовываться. Необходимо 

придавить верхнюю часть полотна вдоль оси Z. Сделать это будет удобнее 
всего через редактирование точек при полностью выделенном верхнем ряду. 

 
 После этого выберите вид Right и сожмите все точки, которые были 

выбраны по оси Z, чтобы получить такой результат: 

164 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
 Теперь можно немного доработать свойства точек, чтобы изгибы стали 

более реалистичными. Особое внимание нужно уделить выбору материала 
штор, так как от него зависит очень многое. 

В примере мы этого делать не будем из-за того, что: 
• 1) Цель этого урока дать необходимые знания и понимание основной 

идеи начинающим пользователям Синема 4Д. Высокореалистичные занавеси 
можно оставить для конкурсов. 

• 2) Мы будем работать с текстурой Тяжелого бархата, что само по себе 
снимает необходимость в тщательной проработке изгибов и линий, так как 
ветра не будет. 

Работаем дальше. Угловатую занавесь нужно сделать более плавной, 
подправить её внешний вид. Сгладить острые выступы поможет элемент 
Hyper NURBS с панели Объектов. После этого нужно создать второй слой 
для верхних подборок. Необходимо снова перейти к боковому виду и 
сформировать еще одну зигзаг-линию, которая по контуру должна быть 
похожа на первый вариант. Точное соблюдение количества углов не является 
обязательным. 
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 Дальше полученную линию придется вытянуть с использованием 

инструмента Extrude NURBS, а потом внести соответствующие настройки. 

 
 После перейдите на панель редактирования точек, отметьте боковые 

пункты, чтобы результат получился похожим на рисунок ниже: 

 
 Используйте инструмент Scale Tool для сжатия всех элементов вдоль 

вертикальной оси Y, а потом перейдите к точкам оси Z. 
Итог будет выглядеть следующим образом. 

 
 Необходимо приподнять выделенные пункты, чтобы усовершенствовать 

вид кривой. 
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 Снова используйте инструмент Hyper NURBS, чтобы сгладить углы, и 

полюбуйтесь результатом. 

 
 Форма изделия получилась квадратной, что необходимо 

подкорректировать. 
Следует графическим рекомендациям с рисунка ниже, выделите 

центральные точки и слегка растяните их по вертикали вдоль оси Y. 

 
  
Готовый объект можно скопировать и равномерно распределить по 

ширине занавеси. 
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 Теперь подберите световое оформление, цвет и текстуру, которая вам по 

душе, сохраните внесенные изменения и примените Рендер. 

 
 
 
Лабораторная работа 3. Как создать космический пейзаж в 

программе Cinema 4D 
Чтобы выполнить эту задачу, нужно взять за основу особую плоскость, 

которая должна выступить в роли заднего плана. Сформируйте её и задайте 
параметры 4000х4000. 
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 Дальше нужно поработать над материалами, которые будут наложены на 

базовую плоскость. 
Первый материал понадобится для создания туманности на рабочем фоне. 

Для этого нужно будет сформировать новый материал, отключить свойство 
Specular. В нем банально нет необходимости. Через вкладку Цвета подберите 
текстуру формата Noise. Разновидность шума – Турбулентность. Пункту 
Global Scale придется присвоить около 3000 процентов. Параметр будет 
меняться  в зависимости от размеров рабочей плоскости. Эти манипуляции 
будут менять форму и размеры генерируемых туманностей. Пункт Low Clip 
должен быть равен 0 процентов, High CLip – 100 процентам, а значение 
Контраста выставьте на 30 процентов. Отдайте предпочтение черному и 
темно-синему цвету текстур. 

 
  
Готовый материал нужно будет поместить поверх сформированной 

плоскости. 
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 В итоге должен получиться прямоугольник черного цвета. Это совсем не 
должно вас пугать. В дальнейшем мы дополним композицию парой звезд для 
подсветки туманности. 

Именно звезды и станут вторым рабочим материалом. Сформируйте 
новый компонент, установите флажки напротив пунктов Alpha и Luminance. 
Свойство Specular лучше отключить. Сформируйте текстуру Noise на панели 
Цвета. Разновидность шума – Hama, а пункт Global Scale должен быть равен 
всего 10 процентам. Пунктам Low Clip и High Clip задайте значения в 40 и 80 
процентов соответственно. Выведите Яркость на 70, а Контраст – на 80 
процентов. 

 
  
На панели Luminance необходимо выставить такие цветовые параметры 

(128, 128, 255). Потом перейдите на рабочую вкладку Alpha, где в роли 
текстуры должен выступить продублированный вариант с вкладки Цвета. 
При этом параметру Brightness нужно присвоить 30 процентов. Подобные 
манипуляции приведут к тому, что на заднем плане появится несколько 
звезд, но они не будут перенасыщать пространство. 
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Теперь готовую текстуру можно поместить поверх плоскости. 

 
 В роли третьего материала выступят звезды и туманность на ближнем 

плане. 
Сформируйте новый материал, по традиции отключите параметр Specular 

и установите галочки напротив Alpha и Luminance. По аналогии с 
предыдущими материалами тип шума должен быть Hama, уровень Global 
Scale около 20 процентов. Значение Low Clip и High Clip будет 0 и 100 
процентов соответственно. Переведите Контраст на 65, а Яркость всего на 20 
процентов. 

 
Установите цветовую гамму на вкладке Luminance (200, 100, 200). 

На вкладке Alpha должна быть создана текстура шума типа Gasous. 
Присвойте Global Scale значение около 2000 процентов, Контраст – 45 
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процентов, Яркость – 10 процентов, Low Clip – 0 процентов, а High Clip – 100 
процентов. 

 
 Поместите третий материал поверх плоскости. 

 
 Стоит поработать над созданием отдельных, более выраженных звезд. 
Сформируйте четыре или пять всенаправленных световых источников – 

Omni. На картинке их лучше поместить там, где расположилось наиболее 
плотное скопление туманности. Примените к каждому световому источнику 
эффект под названием Lens: Масштаб=10 процентам, Яркость=100 
процентам, а пункт Glow= Sun1. Яркость и масштаб некоторых звезд можно 
увеличить вдвое. 
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 После можно будет сформировать еще до 15 источников света 

всенаправленного типа, которым необходимо присвоить параметр Lens с 
такими характеристиками: Яркость=100 процентов, Масштаб=4-8 процентов, 
а пункт Glow=Star 2. 

 
 Группу созданных звезд нужно выделить, а потом применить к ним 

функцию Functions – Randomize для распределения в плоскости. 
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Используем уже опробованную пошаговую инструкцию, чтобы 
сформировать еще одну группу световых источников. На этот раз свойства 
Яркости параметра Lens должно быть около 50 процентов, Масштаб=2-5 
процентов, а Glow=Blue 2. Гармонично расположить их в пространстве 
поможет команда Functions – Randomize. Внимательно проследите за тем, 
чтобы созданные источники освещения находились в пределах рабочей 
плоскости, иначе они просто выйдут из вида. Примените Рендер и оцените 
результат! 

 
 

Лабораторная работа 4. Делаем текстовый эффект с помощью 
Cinema 4D 

Чтобы справиться с этим уроком, вам понадобится программное 
средство Cinema 4D и минимальные знания о нем. Мы поработаем со 
стандартными функциями, а также отдельными инструментами типа 
MoGraph-а и Scetch and Toon-а. Если у вас есть всё, что нужно, можно сразу 
перейти к практике. 

Начните с создания нового документа, а потом перейдите к меню сплайна 
и выберите текстовый элемент. Можно просто использовать меню сплайна и 
комбинацию Objects-Spline Primitive-Text. 

 
  
Дальше можно перейти к окну атрибутов сплайна текстового формата. 

Достаточно нажать на него наведенным курсором среди других объектов 
менеджера. Поле Текст необходимо наполнить требуемым описанием, а 
потом определиться с подходящим шрифтом в разделе Font. Параметр 
высоты можно изменить в любой момент, но свойство Horisontal Spacing, 
отвечающее за расстояние между буквами, можно увеличить сразу. В 
дальнейшем при выделении текста его легко можно будет прочитать. 
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 Дальше нужно выбрать функцию Extrude NURBS на панели объектов. 

Текст необходимо сделать зависимым от используемого инструмента, с 
помощью перетягивания на инструмент Extrude NURBS из менеджера 
объектов. Поработав над атрибутами, следует наладить правильную глубину 
выдавливания "Movement" Z, а потом сделать округлой кромку букв через 
манипуляцию параметрами Старт и Конец. Инструкции указаны на 
изображении ниже. 
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После применения процедуры рендеринга должно получиться нечто 

подобное: 

 
 К сожалению, нас интересует немного другой результат. Воспользуйтесь 

комбинацией клавиш Ctrl+B или перейдите на вкладку Render-Render 
Settings. Затем кликните по Effect и перейдите на вкладку Scetch and Toon. 
Изменяемые параметры модуля отобразятся с правой стороны. На панели 
Shading необходимо изменить параметры Объекта, среди Custom Color 
выберите цветовую гамму, подходящую для создания тени обрабатываемых 
элементов без манипуляций над цветом. В данном случае выбраны настройки 
RGB 190 220 255, так как отдаю предпочтение синему оттенку. 
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 На панели Main необходимо нажать на клавишу Load Style, а потом 

ввести путь "..\Cinema 4D R11.5\library\sketch\styles" для выбора стиля под 
названием Fine Sketch.c4d. Данные манипуляции должны привести к тому, 
что окно с материалами пополнится парой дополнительных компонентов: 
пиктограмма линии и сферы. Линейной пиктограмме нужно присвоить 
название Text lines, позже кликнуть по сформированному объекту два раза и 
получить доступ к зоне редактирования. Возле параметра Stokes нужно 
выставить значение Enable, а параметру Opacity необходимо присвоить 100 
процентов непрозрачности. Останется только присвоить цветовую гамму 
RGB 40 15 0 или любую другую по вашему усмотрению параметру Color. 

 
 После этого в рамках менеджера объектов Extrude NURBS необходимо 

перетянуть материал на текстовый фрагмент. Перейдите на панель Scetch 
Style, где среди прочих атрибутов найдите вкладку Shading и используйте её 
для выбора главного цвета. 
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 Подберите подходящий ракурс и примените рендеринг к выделенному 

тексту. 

 
 Теперь итог больше похож на то, что нужно. Это отличный формат для 

создания надписей и подписей, но у него еще можно найти немало 
недостатков. Поработаем немного над фоном. 

Выключите видимость текста на время и создайте простой куб через 
панель объектов, с размером каждой стороны в 100 пунктов. Перейдите к 
меню, где нужно выбрать MoGraph-Cloner Object, чтобы подчинить куб 
выбранным характеристикам. В атрибутах Mode необходимо заменить 
параметром Grid Array, присвоить Cout значение 6х6х6, а пункту Size - 
7500х7500х15000. Наибольшее значение должно быть выбрано по 
направлению от камеры. 
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 Нам нужно, чтобы кубики были разнообразными, поэтому стоит выбрать 
команду MoGraph-Random Effector. Объекту Parameter следует присвоить 
галочки напротив свойства Scale и Position. Пунктам "P.X", "P.Y" и "P.Z" 
нужно присвоить 500 пунктов. Перейдем на панель масштабирования, 
установим флажок напротив Uniform Scale, что предотвратит превращение 
кубов в параллелепипеды. Останется только задать коэффициент равный 5. 

 
Результат будет выглядеть следующим образом: 

 
 Дальше можно перейти к распределению материалов. Мне показалось, 

что будет гораздо интереснее, если скрытые линии сделать видимыми. Для 
этого необходимо выбрать сразу два материала. Упростим работу, 
скопировав готовый материал текстового элемента несколько раз. Копиям 
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нужно дать два отдельных имени: Cube lines hidden и Cube lines. После этого 
следует перейти к настройкам, как мы уже делали раньше. 

Присвойте черный цвет элементу Cube lines, а также сделаем его 
непрозрачным на 60 процентов. Аналогичным образом следует поступить и с 
Cube lines hidden, только уровень непрозрачности лучше снизить до 40 
процентов. Сократите разброс копий для скрытых линий, из-за этого 
результат не будет загроможденным. В свойствах Main пункт Control Level 
следует заменить элемент Advanced. После этого перейдите на панель Clone, 
где можно задать функции для копирования линий. Значение Line Offset с 
десяти пунктов по умолчанию лучше перевести на восемь. 

 
Закройте панель редактирования материалов и нажмите на материал 

линий в объектном менеджере. Выберите окно Атрибутов, чтобы перейти к 
характеристикам Lines и вместо пункта Combine выбрать All. Как только вы 
перетащите Cubes lines hidden в зону Default Hidden, все тайные линии станут 
видимыми. 

 
 Выделить грани кубического объекта, которые находятся ближе всего  к 

пользователю, можно с помощью дополнительного ранее неиспользуемого 
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материала, его несложно создать и самостоятельно через функцию File-Scetch 
Material. Цветовая гамма должна быть черной, а уровень непрозрачности 45 
процентов. Готовый материал перетяните на куб. Поработаем над 
финальными штрихами. Картинку необходимо дополнить воздухом. 
Воспользуйтесь комбинацией Objects->Scene->Environment. Установите 
флажок напротив параметра Fog на панели атрибутов, а свойству Distance 
задайте значение в 75000 единиц. Сформированные кубы будут постепенно 
растворяться. 

 
  

 
 Вот и всё. Теперь можно переместить текст, Определиться  с ракурсом и 

применить комбинацию Shift+R. Полюбуйтесь готовым результатом! 

 
 
 

Лабораторная работа 5. Модель стула в Cinema 4D. 
Заранее покажем вам, как именно должен выглядеть итог проделанной 

работы. 
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 Следует отметить, что в этом уроке нет подробного описания настроек 

рабочей сцены и используемых материалов для указанного объекта. 
Пошаговая инструкция посвящена исключительно моделированию. 
1) Кликните по клавише F3, чтобы переключиться на «Вид с правой 
стороны». Перейдите к меню, чтобы выбрать в нем вкладку Edit и дойти до 
Configure, а там нужно запустить работу панели под названием Back. После 
этого останется только скачать подложку, чтобы сделать её фоном через 
элемент Image. 
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2)Дальше займемся сплайнами, которые должны помочь нам 
сформировать ножки будущего деревянного стульчика. Для этого идеально 
подойдет B-Spline. 

 
 3) Используйте рисунок ниже в роли наглядной инструкции для 

прорисовки рабочего контура. 

 
 4) Создайте объект Extrude Nurbs, а потом перетащите на него элемент со 

сформированной частью стула. Подправьте некоторые характеристики в 
свойствах Extrude Nurbs. Их нужно открыть, дважды кликнуть по требуемым 
элементам из списка. Затем перейдите на вкладку Объекта, где параметру 
Movement следует присвоить 20 сантиметров, а пункту Subdivision – 5 
единиц. Важнее всего изменить параметры на панели Caps, следуя 
инструкциям с картинки ниже. 
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 5) Результат будет выглядеть приблизительно так. 

 
 6) Для создания двух недостающих элементов нужно применить 

технологию Extrude Nurbs и В-сплайн. Сформируйте спинку, 
подкорректировав свойства Extrude Nurbs, а пункту Movement задайте 26 
сантиметров. Когда вы будете делать ручки, последнее свойство должно 
быть уже не 26, а 18 сантиметров. В конце воспользуйтесь инструментом 
Rotate Tool для вращения детали на -0.904 единиц. 

 
 7) Итог должен выглядеть, как картинка ниже. 

 
 8) Поработаем над созданием муфт для объединения созданных 

элементов. Сформируйте Capsule, а потом кликните по кнопке С, чтобы 
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объект можно было отредактировать. Используйте инструмент Use Point на 
панели Embedded, которая находится в левой части рабочего экрана. 

 
 9) С помощью функции Live Selection определитесь с точечными 

элементами, которые изображены на скриншоте, а потом опустите их через 
использование Move. 

 
 10) Продублируйте готовый элемент, чтобы получилось нечто похожее 

на изображение ниже. 

 
  
11) Готовую сторону стульчика нужно отобразить зеркально. Готовый 

Шейп нужно будет перенести в объект Symmetry. Иногда результат не 
соответствует ожиданиям и отображается неправильно. В таком случае 
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нужно сделать как на картинке ниже, увеличить параметр на 200 
сантиметров. 

 
 12) Сформируйте элемент Cube, а потом, следуя инструкциям с картинки 

ниже, отладьте рабочие параметры. 

 
 13) Когда объект будет готовым, создайте его дубль и объедините 

сформированные элементы стула. 
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 14) Теперь можно заняться созданием сидения. Сделайте шесть 

дополнительных линий на базе инструмента В-сплайн. Их можно сделать 
прямыми, но для достижения максимальной реалистичности лучше придать 
объектам изогнутые линии. 

 
 15) Сформируйте  кубический элемент с параметрами 430 x 15 x 65 

сантиметров. Кликните по С, чтобы объект можно было редактировать. 
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16) Остановитесь на инструменте Use Edge, потом обратитесь к панели 
Selection, где есть пункт Ring Selection. 

 
 17) Грани должны быть такими, как на этой картинке. 

 
 18) Когда четыре кромки будут полностью выделены, кликните по ним 

правой кнопкой и выберите объект Knife. 

 
 19) Остановите свой выбор на режиме Loop, а потом поработайте ножом, 

чтобы прийти к желаемому результату. Расстояния должны быть 
одинаковыми, чтобы сохранилась симметричность объекта. 
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 20) Готовый куб переместите на панель HyperNurbs. 

 
 21) Теперь работа будет проводиться с помощью бесплатного плагина 

PathDeformer 2 – Lite. Воспользуйтесь его меню, чтобы дополнить сцену 
элементом Pathdeformer. Потом останется только перейти на панель Объекта. 
Перейдите на поле Path, где содержатся ранее сформированные сплайны. 

 
 22) Дальше остановитесь на объекте Hypernurb, который необходимо 

открыть для редактирования. Ранее мы уже разбирались с тем, как это 
сделать лучше. Сформированный элемент Pathdeformer нужно сделать 
зависимым от Hypernurb. Выполнить это необходимо после открытия 
доступа к редактированию. 

189 
 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
 23) Вращайте и перемещайте созданные элементы Pathdeformer, чтобы 

добиться оптимального расположения вытянутых деталей спинки. Подобные 
манипуляции необходимо выполнить над всеми сплайнами. 

 
 24) Такую же технологию примените и для изготовления спинки. 

Сформируйте еще один сплайн вместе с кубами, используйте ранее 
проработанные функции. Особое внимание нужно уделить правильному 
размещению и соединению всех сформированных деталей. Чтобы итоговый 
объект был максимально приближен к реальному стулу, внимательно следите 
за размерами и количеством используемых палок. В примере было 
использовано восемь продолговатых элементов для спинки и шесть палок 
для сидения. 
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Тема 8. Допечатная подготовка.  
Краткое содержание 
Основы допечатной подготовки. Операции, завершающие 

производственный процесс. Подготовка к тиражированию экранной и 
полиграфической продукции. Подготовка к печати растровых изображений и 
векторных иллюстраций.  

Краски для печати: триадные и смесевые. Цветоделение. Перекрытие 
цвета и треппинг. Растискивание. Цветопробы.  

Калибровка. Цветовые профили. Способы калибровки: регулировка 
настроек монитора, регулировка настроек принтера, использование пары 
ICC-профилей для изменения файла в процессе печати, изменение 
определения RGB или CMYK профилей в Photoshop, формирование 
корректирующих кривых. 

Цифровые шрифты. Методы описания символов. Форматы 
компьютерных шрифтов: Аdobe Type1, True Type. Язык описания Post Script. 
Основные принципы установки и деинсталляции шрифтов.  

Тенденции развития современных графических систем. 
Основные понятия 
Допечатная подготовка – это комплекс мероприятий, позволяющий 

воспроизвести точную копию оригинал-макета при помощи печатного 
процесса, а также учет и исправление ошибок, которые могут возникнуть при 
печати. 

К допечатной подготовке относятся следующие операции: 
– проверка оригинал-макета на наличие ошибок; 
– цветокоррекция изображений; 
– цветоделение; 
– учет потенциальных проблем при печати (обеспечение воспроизведения 

насыщенных цветов, профилактика растровых разрывов и т.д.); 
– запись PS-файла; 
– растрирование; 
– вывод печатных форм.  
Макет дизайна проверяется на расположение значимых элементов вблизи 

линии реза и в корешке. Обычно, эта величина не должна быть менее 5 мм. 
Необходимо грамотно расположить элементы на полосе, идущие на вылет 
(bleed), им следует задать размер вылета. Стандартно - 5 мм. При 
размещении изображений на вылет необходимо следить, чтобы не зарезались 
значимые элементы работы.  

Важный аспект – это грамотное размещение изображений на развороте. 
Согласно правилам препресс, нежелательно чтобы основные объекты 
попадали на разворот.  

В процессе допечатной подготовки издания обычно применяется два 
этапа работы с изображениями. Первоначально делается первичная 
обработка изображений: цветокоррекция; ретушь. Следует учитывать, что 
векторные полутона, градиенты и прозрачности должны быть растрированы, 
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растровые элементы, изображения – должны быть в формате «CMYK» и 300 
dpi. Полноцветные изображения представляются в «CMYK»-модели и 
должны иметь стандартное разрешение для печати при полном масштабе, а 
насыщенность цвета - от 9 до 95 %. Во избежание потери качетва, все 
сложные элементы обычно растрируются. 

Необходимо указывать наличие или отсутствие белой подложки. Все 
шрифты и тексты должны быть переведены в кривые, а черный текст – в 
«over print». В первичной обработке художественных элементов  
присутствуют обтравка; «total ink limit» согласно выбранному типу печати и 
бумаге; переименование файлов согласно принятым специалистами по 
допечатной подготовке правилам - латинские буквы без пробелов, а также 
сохранение изображений в правильном формате («tiff» или «psd»).  

Второй этап представляет собой работу с вёрсткой. Здесь необходимо – 
наращиваются вылеты.  

Для изображения устанавливается масштаб 100% и разрешение согласно 
выбранной линиатуре печати. В самом конце производится процедура 
предпечатной обработки изображений. 

Для правильного совмещения красок в оттисках следует поставить в 
макете приводочные метки или «приводочные кресты». Приводочные кресты 
служат для контроля совмещения красок на оттиске при печати и для оценки 
точности приводки после печати, находятся они в обрезном поле, при 
отделке печатной продукции их удаляют. Также в обрезном поле 
присутствует шкала оперативного контроля качества печати. 

Обрезные меткии (линии), используются для обозначения обрезного 
формата издания, они служат руководством при окончательной обрезке 
издания.Метки, созданные из верстки, предназначены для контроля 
позиционирования полосы в спуске, поэтому важно их отодвинуть от 
обрезного формата на несколько мм.  

Следующая задача допечатной подготовки – проверка вёрстки с точки 
зрения соответствия техническим требованиям типографии. Для этого 
необходимо правильно сконфигурировать среду и настроить программу 
вёрстки (в данном случае – например «Scribus»).  

PostScript - язык описания страниц, в основном используемый в 
настольных издательских системах. Это конкатенативный язык 
программирования с динамической типизацией. PostScript является языком 
управления принтером, а так же полнофункциональным языком 
программирования. Многие прикладные программы могут преобразовать 
документ в PostScript-программу, при выполнении которой будет получен 
начальный документ. Эта программа может быть послана непосредственно 
на принтер с поддержкой PostScript или преобразована интерпретатором 
PostScript в другой формат (для принтеров без поддержки PostScript), или 
результат её выполнения интерпретатором может быть показан на экране. 
Так как исходная PostScript-программа одна и та же, PostScript называется 
независимым от устройства. Большинство высокопроизводительных 
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принтеров и плоттеров имеют встроенный интерпретатор языка PostScript. В 
то же время, простые принтеры домашнего класса поддерживают только 
элементарные графические операции, поэтому задача создания растрового 
изображения возлагается на центральный процессор. Существуют 
интерпретаторы языка PostScript для различных операционных систем. 
PostScript – полнофункциональный тьюринг-полный язык 
программирования. Программы на PostScript создаются в основном не 
людьми, а другими программами, однако это не исключает того, что человек 
может писать на нем программы для обсчёта графики, реализации численных 
методов решения математических задач и т. п.  
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4. РАЗДЕЛ КОНТРОЛЯ ЗНАНИЙ 
 
В качестве одного из элементов, рекомендуемого для выявления уровня 

учебных достижений студента, используются критериально- 
ориентированные тесты. Они представляют собой совокупность тестовых 
заданий закрытой формы с одним или несколькими вариантами правильных 
ответов; заданий открытой формы с формализованным ответом; заданий на 
установление правильной последовательности. 

Для измерения степени соответствия учебных достижений студента 
требованиям образовательного стандарта также рекомендуется использовать 
проектную деятельность, включающую проблемные, творческие задачи, 
предполагающие эвристическую деятельность и неформализованный ответ. 

 
 

4.1. ЗАДАНИЯ ДЛЯ КОНТРОЛИРУЕМОЙ САМОСТОЯТЕЛЬНОЙ 
РАБОТЫ СТУДЕНТОВ 

 
Методические рекомендации 

по организации и выполнению самостоятельной работы студентов по 
учебной дисциплине 

Дисциплина изучается в течение двух семестров и предусматривает 
самостоятельную работу студентов.  

Самостоятельная работа студентов направлена на обогащение их умений 
и навыков по учебной дисциплине «Компьютерная графика» в свободное от 
обязательных учебных занятий время.  

Цель самостоятельной работы студентов – содействие усвоению в полном 
объеме содержания учебной дисциплины через систематизацию, 
планирование и контроль собственной деятельности. Преподаватель даёт 
задания по самостоятельной работе и регулярно проверяет их выполнение. 

Для самостоятельной работы по учебной дисциплине по выбору 
разработаны тесты. Кроме того, по ключевым темам предлагается выполнить 
проекты. 

Тесты, задания для самостоятельной работы студентов, вопросы к 
экзамену и зачету прилагаются. 

 
 
 
Тема 2. Растровая 2D графика. Композитные изображения. Создание 

композиций. Тест. 
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ТЕСТ ПО ПРОГРАММЕ «ADOBE PHOTOSHOP» 
Фамилия, Имя ________________________________________________ Группа 

________________ 
1. Каким является графический 

редактор Adobe Photoshop? 
o Фрактальным. 
o Прямолинейным. 
o Векторным. 
o Растровым. 

2.  Элементарным объектом растровой 
графики является: 

o  примитив. 
o  то, что рисуется одним инструментом. 
o  пиксел. 
o  символ. 

3.  Что означает аббревиатура RGB? 
o  Red, Great, Black. 
o  Red, Green, Blue. 
o  Red, Green, Black. 
o  Right, Good, Bad. 

4.  Какое расширение файлов является 
в Adobe Photoshop основным? 

o  .gif. 
o  .jpg. 
o  .psd. 

5.   Как называется инструмент, 
позволяющий залить изображение плавно 
перетекающими друг в друга цветами? 

o Заливка. 
o  Ведро краски. 
o  Градиент. 

6. Какой один из перечисленных ниже 
инструментов отсутствует в Photoshop? 

o Архивная кисть (History Brush) 
o Кисть-клякса  (Blob Brush) 
o  Восстанавливающая кисть (Healing 

Brush) 
o Палец (Smudge) 

7.  Что за инструмент? 
o Историческая кисть. 
o  Осветление. 
o  Автоматизация. 
o  Волшебная палочка. 

8.  Что за инструмент?  
o  Прямоугольная область. 
o Рисование 

прямоугольника. 
o  Прямоугольный 

фрагмент. 
o  Перемещение. 

9. Какой клавиатурной клавишей можно 
быстро открыть панель слоёв 

o  F3. 
o  F5. 
o  F7. 
o  F9. 

10. Удерживая, какую клавиатурную 
клавишу, можно проводить идеально 
прямые линии с инструментом Кисть? 

o Shift. 
o  Alt. 
o  Ctrl. 

11. Каким пунктом меню нужно 
воспользоваться, чтобы скрыть/показать 
нужную палитру.  

o  Окно. 
o  Просмотр. 
o  Редактирование. 

12. Какая комбинация клавиш позволит 
отменить выделение? 

o  CTRL + A. 
o  ESC. 
o  SHIFT + B. 
o  CTRL + D. 

13. У вас есть выделенная область, и вы 
к ней хотите добавить ещё. Какая клавиша 
позволит сделать это? 

o CTRL + SHIFT. 
o A. 
o SHIFT. 
o CTRL + ALT. 

14. Вы выделили область и решили, что 
вам нужно наоборот все, кроме того, что 
выделено. Как это сделать? 

o Выделение – Отменить выделение. 
o Изображение – Коррекция – Инверсия. 
o Слой – Инверсия. 
o Выделение – Инверсия. 

15. Вы создаете документ для 
дальнейшей печати в типографии. Какой 
цветовое пространство вам понадобится? 

o RGB. 
o Lab. 
o HSB. 
o CMYK. 

16. Как называется инструмент, при 
помощи которого можно устранить эффект 
красных глаз. 

o Размытие. 
o Палец. 
o Красные глаза. 
o Затемнитель. 
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Тема 3. Цифровая фотография. Ретушь и реставрация. Тоновая и 

цветовая коррекция изображений.  
Проект: Реставрация и оцифровка изображений. 

Задание: Основываясь на данном примере, оцифровать и отретушировать 
фотографии из семейного архива. 

 
Предварительная подготовка 
Для настройки сканера можно пользоваться практически 

единственным инструментом – гистограммой. Благодаря ей, не нужно 
гадать, насколько качественными получатся фотографии на «выходе» – на 
графике всё хорошо видно. Для глянцевых фотографий (которых, кстати, в 
архиве оказалось меньше всего) выбираем весь тоновый диапазон, а для 
матовых – чуть-чуть обрезаем область «светов», чтобы нивелировать 
рассеяние отражённого света (см. Фото 1 а, б, в). Конечно, для достижения 
максимального качества придется «поиграть» настройками, но это 
делалаетс один раз и практически сразу для всех подобных фотографий, 
поэтому не жалейте времени! 
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http://photo-element.ru/photoshop/restavration/01a.JPG
http://photo-element.ru/photoshop/restavration/01b.JPG


Фото 1а, 1б, 1в: На этих скриншотах видно, что сканирование 
матовой фотографии требует ручной доводки. 

а) Экспозиция по версии автомата. 
б) Ручные коррективы значительно улучшили качество 

предварительного скана. 
в) При детальном рассмотрении фотографии видно, что её поверхность 
не просто матовая, а еще и с определённой структурой бумаги, также 

увеличивающей светорассеяние. 

 

Программное обеспечение большинства современных сканеров 
позволяет сканировать и сохранять фотографии в очень удобном и 
экономичном режиме (так называемый «пакетный» режим) – кладём на 
стекло сканера столько фотографий, сколько помещается, выделяем 
каждую, и, пока они сканируются, можно успеть подготовить следующую 
партию (см. Фото 2) 

 

Фото 2. Подготавливаемся к «пакетному» сканированию. 
 
Выбор разрешения 
Несмотря на кажущиеся трудности, с выбором разрешения всё 

относительно просто. Если фотографии не планируется печатать крупным 
форматом (20х30 см и более), то можно ориентироваться на 
следующие примерные цифры: фотографии размером от 20х30 до 15х20 см 
я сканирую с разрешением не более 300 dpi, размером от 15х20 до 6х9 см – 
не более 600 dpi. Сканировать с большим увеличением (вплоть до 2400 
dpi) имеет смысл только очень маленькие и резкие фотографии. Еще один 
совет – численные значения выставляемого разрешения лучше делать 
такими, чтобы они были меньше максимального оптического разрешения в 
2, 4 и т.д. раза. Пример: максимальное оптическое разрешение сканера 
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http://photo-element.ru/photoshop/restavration/01c.JPG
http://photo-element.ru/photoshop/restavration/02.JPG


составляет 2400 dpi. Значит, выставлять будем следующие значения –2400 
dpi, 1200 dpi, 600 dpi, 300 dpi. 

 
Формат файлов для первоначального сохранения 
Сохраняйте сканы фотографий в формате TIFF. Причина только одна – 

незначительная коррекция сканов, вероятнее всего, всё-таки потребуется 
(см. Фото 3 а, б, в). А так как при сохранении в формате JPEG изначально 
происходит потеря информации (именно за счет этого достигается 
значительное уменьшение объёма файла), то при повторном сохранении в 
JPEG, в отличие от TIFF, будет потеряна еще часть, а с ней, увы, и 
качество. 
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http://photo-element.ru/photoshop/restavration/03a.JPG
http://photo-element.ru/photoshop/restavration/03b.JPG


Фото 3а, 3б, 3в: Демонстрация того, что даже после 
качественного сканирования фотография требует «доводки». 
а) Автоматическая экспозиция сделала фотографию блёклой. 

б) Ручные коррективы улучшают вид фотографии. 
в) Однако, открыв скан в Photoshop’е, становится видно, что, 
несмотря на предпринятые прежде шаги, его динамический 

диапазон сужен (курсор на рисунке указывает на один из двух 
пустых участков гистограммы) (нажмите на фото, если желаете 

увеличить его). 

 

 
Если требуется уменьшить занимаемое фотографиями место 

(например, для записи на CD/DVD), то в формат JPEG их лучше всего 
переводить по завершению основной работы, после коррекции 
изображения (см. Фото 3г). 

 

 

Фото 3г. Конечный вариант скана стал более контрастным и более чётким. 
 
После того, как с фотографиями, находящимися в хорошем состоянии 

мы разобрались, настала пора взяться за реставрацию повреждённой части 
архива. Работа это весьма трудоёмкая и кропотливая, и сэкономить время 
можно только за счёт грамотной поэтапной её организации. 

 
Этап первый 

Если фотография порвана, собираем 
все имеющиеся фрагменты на стекле 
сканера в правильном порядке. Если есть 
какие-то замятости и загибы бумаги, их 
следует распрямить. Можно 

Можно попытаться осторожно 
протереть перед сканированием 
фотографию сухой (!!!) мягкой 
тряпочкой – мелкую пыль и даже 
некоторые пятна таким способом 
образом удается легко ликвидировать. 
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попытаться осторожно протереть фотографию сухой(!!!) мягкой 
тряпочкой – мелкую пыль и даже некоторые пятна таким способом 
образом удается легко ликвидировать (см. Фото 4 a, б) Важно помнить, что 
чем больше операций удастся сделать «вживую» на этом этапе, тем 
меньше потом придется обрабатывать фотографию на компьютере. 

  

Фото 4а, б. Насколько может улучшить фотографию банальное протирание тряпочкой! 
а) До. Убирать такой мусор на компьютере было бы сплошной головной болью. 
б) После. Протирание тряпочкой заняло у меня секунд 30 (не пожалейте своего времени!). 

 
Этап второй 
Готовый скан теперь нужно почистить компьютерными средствами. С 

помощью инструментов «Healing brush» («исцеляющая кисть», наиболее 
удобный и «продвинутый», но есть только в программе Adobe Photoshop, 
начиная с версии 7) и «Clone Stamp» («клонирующий штамп», 
большинство современных графических редакторов имеют его в своём 
арсенале) убираем все мелкие дефекты с фотографии (соринки, царапинки, 
пятнышки и прочую мелочь). (см. Фото 5 а, б) 

  

Фото 5а, б. Различные повреждения фотографии на ровном фоне заретушировать – пара пустяков! 
а) С помощью инструмента “Healing brush” или “Clone stamp” стираем линию сгиба. 
б) Отретушированную фотографию можно заново печатать! 
Кстати говоря, несмотря на то, что исходный размер фотографии был всего 5х7,5 см, он был получен контактным способом. В 
результате чего он получился настолько чётким, что видно время на наручных часах! Поэтому мой совет – не бойтесь увеличивать 
старые маленькие портреты! 

 
Зачем это делать в самом начале работы? А вот зачем: так как для 

восстановления поврежденных или вовсе отсутствующих фрагментов 
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фотографии информация обычно берётся с других похожих её участков, то 
разумнее заранее очистить их от мусора. Кроме этого, такая 
последовательность действий обусловлена психологически – мелкий-то 
мусор легко убирается, а в результате фотография становится заметно 
лучше, что способствует дальнейшей продуктивной работе 
воодушевлённого реставратора! 

 
Этап третий 
Цветовая и тоновая коррекция. Несмотря на то, что подавляющее 

большинство старых семейных фотографий чёрно-белые, многие из них 
напечатаны с незначительными, но приятными глазу оттенками. Поэтому 
всегда сканируем в режиме «24-битный цвет». Но сканы чёрно-белых 
фотографий в таком режиме часто, кроме своего исходного, приобретают 
еще и какой-нибудь дополнительный «паразитный» оттенок. Чтобы потом 
от него избавиться, я применяю команду «Desaturate» (в переводе звучит 
как «разбавление»). На мой взгляд, наличие трёх цветовых каналов 
позволяет сохранить большее количество оттенков чёрного, по сравнению 
с наличием только одного канала Grayscale («серый») (см. Фото 6 а, б). 

  

Фото 6а, б. Паразитный зелёный оттенок портит общее впечатление от снимка. 
а) До применения команды “Desaturate” (Image –> Adjustments –> Desaturate) 
б) Посsле. 

Подчас весьма небольшие преобразования гистограммы и гаммы 
изображения весьма положительно сказываются на его качестве. Общий 
совет таков – если динамический диапазон скана фотографии сужен (на 
графике имеются пустые участки перед и/или после гистограммы), то его 
растяжение в большинстве случаев значительно улучшает качество 
изображения. Подобную коррекцию настоятельно рекомендуется 
проводить совместно с изменением значения гаммы (её изменения очень 
наглядны, и после нескольких экспериментальных перемещений ползунка 
становится видно, удачны они или нет) (см. Фото 7 а, б, в). 
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Фото 7а, 7б, 7в Иногда, для улучшения восприятия фотографии, приходится жертвовать частью динамического диапазона. 
а) Исходный вариант скана выглядит блёклым. 

б) Для улучшения его восприятия оказалось недостаточно просто убрать пустоту перед и после гистограммы, пришлось «подрезать» 
область теней. 

в) Чтобы стало видно, какую часть информации мы потеряем, можно воспользоваться следующим приёмом – просто сдвинуть 
ползунки в предполагаемую позицию. 

 
Этап четвёртый, завершающий 
Собственно реставрация. Это самая длительная и самая ответственная 

часть всей работы. Однако она оказалась и самой интересной – 
фотографии буквально возрождались заново (см. Фото 8 а – д)! 

   

Фото 8а. Порою семейные 
портреты приходится восстанавливать и из 
таких вот карточек, находившихся на 
старых документах. На фото показано 
исходное состояние портрета. 

Фото 8б. Используя замечательный 
по своим возможностям Photoshop’овский 
инструмент “Healing brush” можно с 
лёгкостью «исцелить» даже сложные 
повреждения. И не стоит пугаться таких 
вот предварительных результатов, так как 
… 

Фото 8в. …в конце этого действия 
все будет выглядеть значительно лучше, 
чем в начале. 
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Фото 8г. Однако, этот инструмент 
требует бережного обращения. Не 
рекомендуется проводить ретушь рядом с 
четкими контрастными границами – на 
рисунке хорошо виден артефакт от такого 
вот неправильного применения данного 
инструмента. 

Фото 8д. Конечный вариант – 
старая фотография возрождена! 

 

 
К большому сожалению, этот этап совершенно не автоматизируем, 

поэтому над каждой фотографией приходится довольно долго работать 
(иногда по нескольку часов), но результат стоит этих усилий! Более того, в 
такой работе не существует единой схемы, единого алгоритма действий, 
который достаточно было бы один раз запомнить. 

И всё же, попробую предложить несколько обобщающих советов, 
которые помогут в воссоздании облика старых фотографий. 

1. Не стоит пренебрегать функциями автоматического удаления пыли и 
царапин (разумеется, если сканер предоставляет такую возможность). 
Хотя их возможности ограничены, они, в большинстве случаев, прекрасно 
справляются с однородным фоном. В своей работе я использую такой 
инструмент, как слои (layers), чтобы совместить два изображения 
(дефектное и частично восстановленное) и оставить от последнего только 
те части, которые наиболее качественно были заретушированы автоматом. 

2. Крайне важно избежать одного весьма распространённого 
заблуждения,  

связанного с якобы зеркальной 
симметричностью человеческого лица. 
Лицо человека не симметрично! Также при 
реставрации портретов нельзя забывать о 
том, что вы работаете с документом, и 

«вольности» здесь не столь неуместны. Если вы не знаете точно, как 
именно выглядел ваш предок, то полную реставрацию лучше не 
проводить. В таких ситуациях наилучший выход – оставить фотографию 
так, как есть.  

Крайне важно избежать одного 
весьма распространённого заблуждения, 
связанного с якобы зеркальной 
симметричностью человеческого лица. 
Лицо человека не симметрично! 
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Но, разумеется, из этого правила есть исключения, особенно при 
реставрации семейного архива. В отдельных случаях можно пренебречь 
«исторической достоверностью» фотографии, в основном на групповых 
портретах (бывший очень популярным в своё время сюжет). В той 
ситуации, когда на таком снимке в повреждённых участках кадра 
оказались не родственники, а посторонние и малозначимые для вас люди, 
то в принципе, можно «подправить» их изображения «для фона», чтобы не 
портить общего впечатления. 

В другом случае реставрировать портрет  
можно, когда у вас имеются другие снимки этого 

человека, или же есть тот, кто хорошо его помнит. 
Чтобы качественно провести реставрацию, 
необходимо обладать маломальскими 
художественными навыками. 

3. Для повышения качества портретной 
фотографии нужно использовать психологию человеческого восприятия – 
основное внимание следует уделять глазам, как самому важному элементу 
портрета. Порою достаточно повысить резкость глаз, как весь снимок 
начинает восприниматься более чётко и можно уже не менять его резкости 
в целом (см. Фото 9 а – е). 

 

 

 

Фото 9а. Исходный снимок без 
резкости. 

Фото 9б. За счёт растяжения гистограммы 
повышаем общий контраст снимка. 

Фото 9в. Выделяем область 
глаз. Для этого лучше всего 
воспользоваться инструментом под 
названием “Elliptical marquee” 
(эллипсовидная область 
выделения). 

   

Фото 9г. С помощью команды 
Feather (вольный перевод – размытие, 
растушевка) (меню Select (Выделение) 
растушевываем края области выделения. 
Это позволяет нам снизить заметность 

Фото 9д. С помощью фильтра Unsharp mask 
(нерезкая маска) визуально контролируем 
повышение резкости в выделенных областях. 

Фото 9е. Окончательный 
вариант снимка выглядит 
значительно более резким. 

Для повышения качества 
портретной фотографии нужно 
использовать психологию человеческого 
восприятия – основное внимание 
следует уделять глазам, как самому 
важному элементу портрета. 
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перехода от области, резкость в которой 
будет повышаться, до всей остальной 
части портрета. Величина размытия 
подбирается экспериментально. Чтобы 
увидеть, как именно размылись края, 
достаточно включить режим Quick Mask 
(быстрая маска). Не стоит пугаться 
красного цвета – им обозначаются 
маскированные области, на которых 
воздействие производиться не будет. 

 
4. Всегда стремимся сохранить «первоначальный» задний фон портрета 

– это позволяет передать «дух старины». 
 
 

Тема 4. Векторная 2D графика, возможности и особенности 
применения. 

Самостоятельная работа: Проект «Весна» 
 

 
1. Рисуем тело птицы 
Шаг 1 
Создайте новый документ и нажмите Ellipse Tool (L). Мы сначала создать 

тело птицы. Установите цвет обводки без заливки. Создайте эллипс. Затем 
добавить меньший эллипс на вершине. Возьмите Rectangle Tool (M) и 
нарисуйте прямоугольник; это будет горлышко птицы. Чтобы завершить 
фигуру, возьмите инструмент Direct Selection Tool (A) и сделать нижнюю 
часть прямоугольника широкой. 

В конце концов, форма должна выглядеть следующим образом: 

 
Шаг 2  
Использование Ellipse Tool (L), нарисуйте два длинных узких эллипса, 

чтобы создать хвост. Поместите их, как показано на рисунке ниже. 
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Шаг 3 
Теперь давайте создадим клюв. Вам нужно будет получить острый угол с 

помощью Convert Anchor Point Tool (Shift-C). Нажмите на правую опорную 
точку. Затем возьмите инструмент Direct Selection Tool (A) и выберите 
верхний и нижний опорные точки. Сдвиньте их влево.  

  
Шаг 4 
Поместите клюв в его месте и добавьте эллипс, чтобы показать глаза 

птицы. 

 
Шаг 5 
Выберите формы, которые мы использовали, чтобы создать тело птицы. 

Перейдите  к Pathfinder панели (Окно> Pathfinder) и нажмите 
на Unite (объединить). 

Возьмите Convert Anchor Point Tool (Shift-C) и конвертируйте острые 

углы в гладкие.   
Шаг 6 
Удалить все обводки,залить цветом. Цвет глаз черный с белой 

подсветкой. 
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Шаг 7 
Теперь давайте создадим крыло. Установите цвет заливки  R = 96 G = 115 

B = 128 (или свой) и с помощью Ellipse Tool (L), нарисовать эллипс. С 
помощью Convert Anchor Point Tool (Shift-C) изменяем форму. Затем 
переместите верхнюю и нижнюю опорные точки слева. Выберите опорные 
точки, используя инструмент Direct Selection Tool (A), и переместите их, 
используя стрелки на клавиатуре. 

 
Шаг 8 
Поместите крыло на птицу. 

 
Шаг 9 
Теперь, давайте создадим темную область вокруг птичьего 

глаза. Сделайте острыми углы эллипса (R = 96 G = 115 B = 128). 

 
Шаг 10 
Поместите его за глаза птицы. 

 
Шаг 11 
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Нарисуйте эллипс. Поместите его, как показано на рисунке 
ниже. Выберите форму тела птицы и сделайте еще одну копию на переднем 
плане (Ctrl-C, F-Ctrl). Держите его выбран и, удерживая Shift,ключ, выберите 
новый перекрытия овал. В Pathfinder, нажмите Intersect (пересечение). 

 
Шаг 12 
Нарисуйте узкий эллипс, установите цвет заливки на R = 221 G = 213 B 

= 74. Затем выделите опорную точку перейдите к Effect> Warp> Arc (Эффект, 
искажение, арка). Введите нужные параметры. Не забудьте разобрать 
полученную фигуру (Object> Expand Appearance). 

 
Шаг 13 
Поместите вновь созданную форму на клюве. Птица готова! 

 
2. Создание другой птицы 
Используя тот же процесс и изменение цвета, мы можем создать другую 

птицу. 

 
3. Создание Лук 
Шаг 1 
Начните с розового (R = 246 G = 160 B = 169) прямоугольника, с 

помощью Rectangle Tool (M). Перейти к Effect> Warp> Arc и введите 
следующие параметры: 
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Шаг 2  
Разобрать форму (Object> Expand Appearance) и нарисуйте 

прямоугольник перекрывающийся, как показано на рисунке. Выберите две 
фигуры и на Pathfinder панели, нажмите Intersect (Пересечь). 

 
Шаг 3 
Выберите Reflect (зеркальное отражение) в контекстном меню 

Трансформации и в диалоговом окне выберите Vertical и 
нажмите Копировать. 

 
Шаг 4 
Прямоугольник который будет составлять среднюю часть 

банта. Введите параметры Warp с настройками, которые вы видите ниже: 

 
Шаг 5 
Использование Reflect Tool (O), сделать горизонтальное отражение 

частей банта и установите цвет заливки  R = 232 G = 116 B = 18. Не забудьте 
положить их за бант (Ctrl-X, Ctrl-B). 
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Шаг 6 
Возьмите одну из частей и сделайте ее немного больше. Наклоните. Затем 

поместите его позади всего (Ctrl-C, Ctrl-B) и измените цвет заливки на R = 
244 G = 144 B = 159. После этого сделайте вертикальное отражение. 

 
4. Размещение. 
Упорядочить все, как показано. 

 
5. Составление цветочных веточек 
Шаг 1 
Теперь давайте создадим ветку. Установите цвет заливки  R = 128 G = 69 

B = 0.Возьмите инструмент Polygon Tool установите 3 стороны с 
любым радиусом. Вы получите треугольник, который вам нужно будет 
сделать очень узким и длинным. Copy-Paste несколько раз. 

 
Шаг 2  
Эллипс  залейте цветом R = 177 G = 190 B = 45. Выберите Convert Anchor 

Point Tool (Shift-C), и сделатйте острыми опорные точки. Вы получите форму 
листа. 

 
Шаг 3 
Скопируйте и вставьте  создать столько листьев, сколько вы хотите, и 

расположите их на ветке. 

 
Шаг 4 
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Возьмите инструмент Polygon Tool и сделайте 6 сторон,  радиус не имеет 
значения, но не слишком большой. Установите белый цвет заливки с любым 
цветом обводки. Из него сделаем цветок, перейдем в Effect> Distort & 
Transform> Втягивание & Bloat и установим ползунок на 60%. Цветок готов.  

  
Шаг 5 
Добавим желтый круг на средней части цветка. 

 
Шаг 6 
Расположите цветы на ветке, как вам нравится. 

 
6. Размещение. 
Сделайте вертикальное отражение и добавьте еще несколько цветов и 

листьев. 

 
7. Создание фона 
Шаг 1 
Нарисуйте прямоугольник поместите его на задний план. 
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ТЕСТ ПО ПРОГРАММЕ «ADOBE ILLUSTRATOR» 
 

Фамилия, Имя ________________________________________________ Группа ________________ 

1. Каким графическим  редактором 
является Adobe Illustrator? 

 
o Векторным  
o Фрактальным. 
o Растровым. 

 

2.  Какие  способы выбора инструментов  
существуют  в программе Adobe Illustrator? 

 
o Выбор инструмента в панели 

инструментов или горячими клавишами с 
клавиатуры. 

o Выбор инструментов в контекстном меню 
некоторых палитр. 

o Выбор в главном меню. 
3.  В каких цветовых пространствах 

программа Adobe Illustrator может создавать 
рабочие документы?  

 
o Lab. 
o CMYK и RGB. 
o HSB. 

4.  Какое расширение файлов является в 
Adobe  Illustrator  основным? 

 
o  .gif. 
o  .jpg. 
o  .cdr. 
o  .ai. 

5.  Что представляет собой pattern (узор) в 
программе Illustrator? 

 
o Повторяющийся рисунок, расположенный 

в пределах единичной плитки. 
o Плавный переход между цветами. 
o Расположенные в ряд объекты. 

6.  Каким образом в программе Adobe 
Illustrator можно менять прозрачность 
объектов?  

 
o Через палитру Layers (слои). 
o Через палитру Transparency 

(прозрачность).  
o Через панель инструментов. 

 
7.  Какая из нижеперечисленных палитр 

используется для управления параметрами 
текста? 

 
o Type (Тип). 
o Appearance (Внешний вид). 
o Graphic Style (Графический стиль). 
o Character (Символ). 

8.  Каким образом возможно 
редактирование настроек эффектов после их 
применения к объекту? 

 
o Через палитру Appearance (Внешний 

вид). 
o Через палитру Layers (Слои). 
o Через главное меню Effects (Эффекты). 
o Через палитру Swatches (Образцы). 

9.  Как называют векторные линии, на 
основании которых программа Adobe Illustrator 
строит контуры? 

 
o Кривые Рено. 
o Кривые Безье. 
o Кривые Adobe. 

10.  При создании нового образца pattern 
он появляется в палитре: 

 
o Color (Цвет). 
o Swatches (Образцы). 
o Brushes (Кисти). 
o Symbols (Символы). 

11.  Какие типы заливок могут 
использоваться в программе Adobe Illustrator? 

 
o Цвет (Color), Градиент (Gradient), Узор 

(Pattern). 
o Цвет (Color), Материал (Material). 
o Материал (Material), Градиент (Gradient) 

12.  Как нарисовать треугольник? 
 

o Указать в настройках инструмента 
Многоугольник (Polygon) количество сторон – 3. 

o Создать прямоугольник и у него удалить 
одну из сторон. 

o Воспользоваться специальным 
инструментом Треугольник (Triangle). 

 
 
 
 
 

13.  Как можно повернуть объект?  
 

14.  Каким образом можно назначить для 
линии рисунок кисти, выбранный в палитре 213 
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o Инструментом Черная стрелка (Selection) 
или инструментом Поворот (Rotate). 

o Инструментом Белая стрелка (Direct 
Selection). 

o Инструментом Белая стрелка+ (Group 
Selection). 

 

Brushes?  
 

o Выбрать интересующий вариант кисти в 
палитре и нарисовать линию инструментом Кисть 
(Paintbrush). 

o Выделить линию и выбрать для нее 
рисунок кисти в палитре Stroke. 

o Нарисовать линию инструментом Blob 
Brush (кисть-клякса). 

15.  Как выровнять объекты относительно 
монтажной области (Artboard)? 

 
o Нарисовать прямоугольник, равный по 

размеру документу и выровнять объект 
относительно него. 

o Включить специальный режим Align to 
Artboard (выровнять относительно монтажной 
области). 

o Данная опция задается сразу при создании 
документа. 

 

16. Для чего применяется маленькая 
согнутая стрелка, нарисованная в панели 
инструментов рядом с Обводкой (Stroke) и 
Заливкой (Fill)? 

 
o Щелкая по ней, можно сделать активной 

то Обводку (Stroke), то Заливку (Fill). 
o Щелкая по ней, можно менять местами 

цвета Обводки (Stroke) и Заливки (Fill). 
o Щелкая по ней можно убрать Обводку 

(Stroke) или Заливку (Fill) у объекта. 

17. Как скрыть из видимости отдельный 
объект? 

 
o Применить к нему команду Hide 

(Спрятать). 
o Включить для него настройку Overprint Fill 

(Наложение фона). 
o Убрать у него обводку. 

18. Каким инструментом можно выделять 
опорные точки? 

  
o Инструментом Черная стрелка (Selection). 
o Инструментом Белая стрелка +(Group 

Selection). 
o Инструментом Белая стрелка (Direct 

Selection) или Инструментом Лассо (Lasso). 

19. Как переместить объект на задний 
план? 

 
o Написать в Управляющей панели (Control) 

его порядковый номер в стопке. 
o Выделить все объекты и применить к ним 

команду Object>Arrange>Send to Back (Объект – 
Расположение-Отправить на задний план). 

o Применить к отдельному объекту команду 
Object>Arrange>Send to Back. 

20. На основе каких критериев, может 
выделять объекты инструмент Magic Wand?  

 
o Цвет. 
o Толщина линий обводки. 
o Размер. 
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ТЕСТ ПО ПРОГРАММЕ «CINEMA 4 D» 
Фамилия, Имя ________________________________________________ Группа ________________ 
 

1. Вертикальной осью координат 
в Cinema 4D является  6. Материалы отображают: 

⃝ ось а ⃝ количество полигонов 
⃝ ось b ⃝ количество объектов в группе 
⃝ ось х ⃝ свойства поверхности объектов 
⃝ ось у ⃝ сплайны 
⃝ ось z ⃝ генераторы 

  2. Окно, содержащее список 
объектов в сцене, позволяющее 
управлять ими  
(группировать, показывать и 
скрывать, изменять иерархию) 
называется: 

7. При клонировании объектов в режиме инстанции, 
создаются: 

⃝ окно объектов ⃝ дубликаты объектов 
⃝ окно примитивов ⃝ клоны объектов 
⃝ менеджер слоев ⃝ образы объектов 
⃝ менеджер объектов ⃝ сплайновые примитивы 
⃝ менеджер свойств ⃝ группы сглаживания 

    

3. Окно, отображающее свойства 
активного объекта или инструмента 

называется: 

8. Для выделения связанных между собой и 
расположенных в форме кольца элементов используется 

инструмент: 

⃝ окно настроек ⃝ выделение пути 
⃝ окно свойств ⃝ контур выделения 
⃝ менеджер параметров ⃝ выделение по окружности 
⃝ менеджер атрибутов ⃝ прямоугольное выделение 
⃝ менеджер свойств ⃝ циклическое выделение 
4. Для работы деформатора, он 

должен  быть: 
9. При использовании текстуры в качестве рисунка 
поверхности ее необходимо добавитьт в канал: 

  ⃝ дочерним объектом  ⃝ свечения 
⃝ независимым объектом ⃝ тумана 
⃝ скрытым объектом ⃝ отражения 

⃝ 
сплайновым   

примитивом ⃝ альфа-канал 
 
⃝ родительским объектом  ⃝ цвета 

5. Для работы объектов 
генераторов необходимы: 

10. Для сохранения результата визуализации в 
качестве двумерного  изображения необходимо 

выполнить: 
⃝ примитивы ⃝ рендер фрагмента 
⃝ деформаторы ⃝ создать предпросмотр 
⃝ сплайны ⃝ интерактивный рендер участка 
⃝ растровые изображения ⃝ рендер активного вида 

 ⃝  
полигональные 
объекты  ⃝ рендер в менеджере изображений 
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Проект: смоделировать объекты по образцу. 
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4.2. ПЕРЕЧЕНЬ ТЕОРЕТИЧЕСКИХ ВОПРОСОВ 
ДЛЯ ПРОВЕДЕНИЯ ЗАЧЕТА 

ПО УЧЕБНОЙ ДИСЦИПЛИНЕ ПО ВЫБОРУ «КОМПЬЮТЕРНАЯ 
ГРАФИКА» 

 
1. Основы компьютерной графики. 2D и 3D графика.  
2. Графика растровая, векторная и фрактальная, достоинства и 

недостатки. 
3. Цвет и модели цвета. Цветовой охват.  
4. Цифровая цветовая модель RGB. Типографская цветовая модель 

CMYK.  
5. Пользовательская цветовая модель HSB и Lab.  
6. Форматы растровой графики. Совместимость форматов.  
7. Входные и выходные характеристики изображения: линейный размер, 

входное и выходное разрешение изображения.  
8. Элементы интерфейса Adobe Photoshop. Работа с палитрами. Рабочее 

пространство. Навигация в окне документа. Настройки программы. Работа с 
документом. Создание и сохранение документа. Организация окон. Панели. 

9. Ручные инструменты выделения и приемы создания выделенных 
областей. Режимы выделения. Автоматические инструменты выделения. 
Команды для работы с выделенными областями. Модификация выделенной 
области. Меню «Выделение». 

10. Команды трансформации, особенности применения. Операции с 
выделенными фрагментами. Отмена трансформации.  

11. Масштаб с учетом содержимого. Кадрирование изображения. 
Сложные комбинации: работа с клавиатурой.  

12. Вставка изображений в слой. Смарт-объекты.  
13. Палитра Слои. Перемещение и копирование слоев. Видимость и 

блокировка слоя. Прозрачность слоя. Фон.  
14. Редактирование слоев. Группы. Сведение. Создание 

многослойного изображения. 
15. Основы комбинирования изображений. Приемы реалистичного 

наложения рисунка на объект. Режимы смешивания слоев.  
16. Основные приемы рисования. Работа с цветом. История 

действий. Инструмент заливка. Контуры и узоры.  
17. Инструмент обводка. Инструмент градиент.  
18. Кисти. Прозрачность и жесткость кисти. Пользовательские 

настройки. Создание собственных инструментов рисования.  
19. Режимы наложения пикселов цвета.  
20. Приемы и инструменты фотореалистичного раскрашивания и 

тонирования фотоизображений. Тени, блики, свет. Применение режима 
«цветность».  

21. Понятие векторного изображения. Контуры. Операции с 
фигурами.  
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22. Создание и свойства текста. Ввод и редактирование. Палитра 
символ, палитра абзац, текст вдоль пути. Блочный текст.  

23. Текст как выделение. Растрирование текста.  
24. Понятие стилизации слоя. Добавление эффектов к слоям. 

Комбинирование, редактирование и удаление эффектов.  
25. Галерея фильтров. Работа с фильтрами. Категории фильтров.  
26. Имитация традиционных методик живописи и графики и 

транспонирование их в компьютерные творческие технологии.  
27. Фильтр «Пластика». Смарт-фильтры.  
28. Понятие ретуши. Приемы восстановления, реставрации и 

перекомпоновки изображений. Комплексность приемов инструментов 
ретуши.  

29. Портретная ретушь.  
30. Команды тоновой коррекции: Яркость/Контрастность. Уровни. 

Кривые. Команды цветовой коррекции: Цветовой баланс. 
Оттенок/Насыщенность. Замена цвета, выборочная коррекция цвета.  

31. Автоматическая коррекция. Установка точек вручную. Тени и 
света. Тонирование фотографий любым оттенком. 

32. Создание и редактирование корректирующего слоя. Маска 
отсечения (обтравочная маска). Палитра свойств корректирующего слоя. 

33. Правила маскирования слоев. Маска как профессиональный 
способ коллажирования.  

34. Типы масок: маска слоя, (маска отсечения), векторная маска.  
Маска слоя. Связь со слоем. Отключение и удаление маски слоя.  
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4.3. ПЕРЕЧЕНЬ ТЕОРЕТИЧЕСКИХ ВОПРОСОВ  
ДЛЯ ПРОВЕДЕНИЯ ЭКЗАМЕНА 

ПО УЧЕБНОЙ ДИСЦИПЛИНЕ ПО ВЫБОРУ «КОМПЬЮТЕРНАЯ 
ГРАФИКА» 

 
1. Основы компьютерной графики. 2D и 3D графика.  
2. Графика растровая, векторная и фрактальная, достоинства и 
недостатки. 
3. Цвет и модели цвета. Цветовой охват.  
4. Цифровая цветовая модель RGB. Типографская цветовая модель 
CMYK. Пользовательская цветовая модель HSB и Lab.  
5. Форматы растровой графики. Совместимость форматов.  
6. Входные и выходные характеристики изображения: линейный размер, 
входное и выходное разрешение изображения.  
7. Элементы интерфейса Adobe Photoshop. Работа с палитрами. Рабочее 
пространство. Навигация в окне документа. Настройки программы. Работа с 
документом. Создание и сохранение документа. Организация окон. Панели. 
8. Ручные инструменты выделения и приемы создания выделенных 
областей. Режимы выделения. Автоматические инструменты выделения. 
Команды для работы с выделенными областями. Модификация выделенной 
области. Меню «Выделение». 
9. Команды трансформации, особенности применения. Операции с 
выделенными фрагментами. Отмена трансформации. Масштаб с учетом 
содержимого. Кадрирование изображения. Сложные комбинации: работа с 
клавиатурой.  
10. Вставка изображений в слой. Смарт-объекты.  
11. Палитра Слои. Перемещение и копирование слоев. Видимость и 
блокировка слоя. Прозрачность слоя. Фон.  
12. Редактирование слоев. Группы. Сведение. Создание многослойного 
изображения. 
13. Основы комбинирования изображений. Приемы реалистичного 
наложения рисунка на объект. Режимы смешивания слоев.  
14. Основные приемы рисования. Работа с цветом. История действий. 
Инструмент заливка. Контуры и узоры.  
15. Инструмент обводка. Инструмент градиент.  
16. Кисти. Прозрачность и жесткость кисти. Пользовательские настройки. 
Создание собственных инструментов рисования.  
17. Режимы наложения пикселов цвета.  
18. Приемы и инструменты фотореалистичного раскрашивания и 
тонирования фотоизображений. Тени, блики, свет. Применение режима 
«цветность».  
19. Понятие векторного изображения. Контуры. Операции с фигурами.  
20. Создание и свойства текста. Ввод и редактирование. Палитра символ, 
палитра абзац, текст вдоль пути. Блочный текст.  
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21. Текст как выделение. Растрирование текста. Понятие стилизации слоя. 
Добавление эффектов к слоям. Комбинирование, редактирование и удаление 
эффектов.  
22. Галерея фильтров. Работа с фильтрами. Категории фильтров.  
23. Имитация традиционных методик живописи и графики и 
транспонирование их в компьютерные творческие технологии.  
24. Понятие ретуши. Приемы восстановления, реставрации и 
перекомпоновки изображений. Комплексность приемов инструментов 
ретуши.  
25. Портретная ретушь.  
26. Команды тоновой коррекции: Яркость/Контрастность. Уровни. Кривые. 
Команды цветовой коррекции: Цветовой баланс. Оттенок/Насыщенность. 
Замена цвета, выборочная коррекция цвета.  
27. Обзор инструментария  для создания и обработки векторной графики.  
28. Редактор векторной графики Adobe Illustrator. Элементы интерфейса.  
29. Основы комбинирования изображений 
30. Работа с кривыми Безье в векторном редакторе 
31. Типографика. Шрифты. Работа с текстовой информацией. 
Инструменты для работы с текстом. Создание и размещение текста. 
Заголовочный текст. Блочный текст.  
32. Работа с избыточным текстом. Создание текста в области. Создание 
текста по закрытому и открытому контуру. Преобразование текста в кривые. 
Стили символов и абзацев. 
33. Группировка и упорядочивание графических объектов. Выравнивание 
и распределение объектов. Порядок следования. Изменение порядка 
наложения объектов. Скрытие объектов. Закрепление объектов.  
34. Комбинирование и редактирование фигур. Палитра Обработка 
контуров. Объединение, пересекание, вычитание и исключение контуров.  
35. Работа с инструментом Создание форм. Инструменты деформации 
объектов.  
36. Глобальные цвета. Плашечные цвета. Создание цветовых групп. 
Библиотека образцов.  
37. Векторная живопись в иллюстративной графике.  
38. Инструмент Кисть. Применение кистей к обводкам. Типы кистей: 
дискретные, каллиграфические, из щетины, объектные, узорчатые. Палитра 
кистей. Параметры кистей. Создание и удаление кистей. Библиотека кистей.  
39. Палитра Символы. Библиотека символов. Создание и удаление 
символа. Замена образца символа. Отмена связи с символом.  
40. Художественные эффекты в графическом редакторе.  
41. Растровые и векторные эффекты. Эффекты группы 3D, искажения, 
деформации, обработки контуров, стилизации. 
42. Веб-графика: особенности и ограничения. Виды веб-графики: визуал, 
фоновая графика, навигационная, логотип, фовикон, банер. Форматы 
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графических изображений в Интернет. Системы представления цвета в 
Интернет (Цветовые модели. Веб-цвета). 
43. Иконографика в Adobe Illustrator.  Подготовка векторных изображений 
для публикации в сети Интернет. Оптимизация размера графического файла.  
44. Информационная графика. Диаграммы и графики. Типы графиков и 
диаграмм. Создание объектов инфографики.  
45. Представление о перспективе. Инструмент Сетка перспективы. 
Добавление и редактирование объектов и текста в перспективу.  
46. Импорт векторных, растровых изображений. Работа с растровыми 
изображениями в Illustrrator. Способы переноса растровых рисунков. 
Связанные файлы. Палитра Связи.   
47. Трассировка растрового изображения. Настройка, виды трассировки.  
48. Импорт текста. Экспорт из Adobe Illustrator. Сочетание графики Adobe 
Illustrator и Photoshop. 
49. Допечатная подготовка. Настройка параметров печати (цветовые 
модели, разрешение, форматы, обрезка, вывод, программная настройка 
принтеров). 
50. Объекты трехмерного моделирования. Булевы операции. Копии и 
клоны. Симметрия. 
51. Сплайны. Инструмент безье. Генераторы. 
52. Полигональные объекты и их компоненты. 
53. Деформаторы. Материалы. 
54. Камеры. Освещение. Визуализация. 
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5. ВСПОМОГАТЕЛЬНЫЙ РАЗДЕЛ 
5.1.УЧЕБНАЯ ПРОГРАММА (прилагается) 

5.2.ОСНОВНАЯ ЛИТЕРАТУРА 
 

1. Агапова,  И. Adobe Photoshop. Чудеса ретуши / И. Агапова. – М.: 
Эксмо, 2012 . – 416 с.  

2. Adobe Illustrator CC. Офиц. учеб. курс. – М.: Эксмо, 2014. – 592 с. + 1 
электрон. опт. диск (CD-ROM). 

3. Айсманн, К. Маски и композиция в Photoshop : Пер. с англ. / К. 
Айсман, Ш. Дугган, Д. Порто. – М.: Вильямс, 2013. – 600с.: ил. 

4. Айсманн, К. Ретуширование и обработка изображений : Пер. с англ. – 
М.: Вильямс, 2007. – 484с. 

5. Джамбруно, М. Трехмерная (3D) графика / М. Джамбруно. – М.: 
Вильямс, 2002. – 640 с.  

6. Ивнинг, М. Adobe Photoshop для фотографов / М. Ивнинг. – М.: BHV, 
Русская редакция, 2013. – 768 с. 

7. Келби, Скотт. Цифровая фотография. Готовые рецепты / К.Скотт. – М.: 
Вильямс, 2015. – 232 с.: ил. 

8. Корпан, Л. Компьютерная графика и дизайн /Л. Корпан, В. Тозик. – М.: 
Academia, 2014. – 208 с.  

9. Олспач, Тед. Adobe Illustrator CS2. Библия пользователя. – М.: 
Вильямс, 2006. – 656с. 

 
5.3. ДОПОЛНИТЕЛЬНАЯ ЛИТЕРАТУРА 

1. Айсманн, Кэтрин. Ретуширование и обработка изображений.: Пер. с 
англ. – М.: Вильямс, 2007. – 484с. 

2. Бернс, С. Фотомагия Photoshop. Трюки и эффекты / С. Бернс. – М.: 
BHV,  Русская редакция, 2008 . – 448 с.  

3. Домасев, М.В. Цвет, управление цветом, цветовые расчеты и 
измерения: учебный курс / М.В. Домасев, С.П.Гнатюк. – 1-е изд. – СПб.: 
Питер, 2009. – 224 с.  

4. Маргулис, Дэн. Photoshop для профессионалов: классическое 
руководство по цветокоррекции. Пятое издание / Пер. с англ. – М.: 000 
«Интерсофтмарк», 2007. – 656 с: ил. 

5. Маргулис, Дэн. Современная технология цветокоррекции в Photoshop. 
PPW и другие идеи для быстрого улучшения изображений / Дэн Моргулис. 
Пер. с англ. – М.: Погрелый В.Г., 2015. – 496 с: ил. 
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6. Назарова, Ю. Компьютерная графика и Web-дизайн. Практикум по 
информатике / Ю.Назарова, Т. Немцова. – М.: Форум, 2013. – 288 с.  

7. Смит, К. Photoshop для цифровой фотографии. Полноцветное издание 
(+ CD) / К. Смит. – М.: BHV, Русская редакция, 2010. – 448 с. 

8. Тучкевич, Е. И. Самоучитель Adobe Illustrator  /  Е. И. Тучкевич. – СПб. 
: БХВ-Петербург, 2014. – 352 c.  
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